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ABOUT MDGROUP 

mdGroup is an aerial digital twin maker for industrial applications. It operates its digital twin making 

business through its portfolio companies Microdrones and GeoCue.  

 

To learn more about mdGroup, visit www.group-md.com 

ABOUT GEOCUE 

GeoCue is a U.S. based LiDAR data technology company offering software, hardware, training, support 
and consulting services for high accuracy LiDAR and imaging drone mapping to help civil engineering 
and surveying professionals achieve successful data collection, processing, and management. 

With its TrueView drone LiDAR/Imaging sensors and LP360 point cloud data processing software, 
GeoCue is the leader in LiDAR mapping processing in North America.  

To learn more about GeoCue, visit www.geocue.com 

ABOUT MICRODRONES 

Microdrones is an unmanned aerial surveying and mapping technology company that delivers 

industrial-grade survey equipment with a fully integrated geospatial workflow. Transformation of 

collected data into actionable deliverables and their visualization is made possible through the LP360 

Drone data processing software platform. 

ABOUT AGISOFT, LLC. 

Founded in 2006 as an innovative research company with focus on computer vision technology, 

through years of intensive R&D work Agisoft LLC has gained expertise in image processing algorithms, 

with digital photogrammetry techniques setting the direction for development of applied tools. To 

learn more, visit www.agisoft.com.  

ABOUT BAYESMAP SOLUTIONS, LLC. 

BayesMap Solutions was founded in September 2014 and registered in California (Alameda County), to 

provide unique consulting and software development services for the LiDAR industry. Their focus is on 

data processing, providing efficient and accurate solutions to challenging problems. BayesMap 

Solutions also help their clients extract a maximum amount of information from large and complex 

data sets. They are located in Mountain View, CA. To learn more, visit bayesmap.com.  

file:///C:/Users/Francois/AppData/Local/Microsoft/Windows/INetCache/Content.Outlook/D9RDTMGZ/mdGroup
http://www.group-md.com/
http://www.geocue.com/
http://www.geocue.com/
https://www.agisoft.com/
http://bayesmap.com/
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ABOUT SZ DJI TECHNOLOGY CO., LTD. 

Creativity is at the heart of every dream. Every idea, every groundbreaking leap that changes our world 

starts with the vision of talented creators. At DJI, we give these creators the tools they need to bring 

their ideas to life. 

Our platforms empower them to capture images that were once out of reach. Our flying and camera 

stabilization systems redefine camera placement and motion. Amazing photos and video, treasured 

personal memories, and high-end professional imagery are captured every day, in every corner of the 

world using DJI products. 

We do this through an unparalleled commitment to R&D, a culture of constant innovation and curiosity, 

and a focus on transforming complex technology into easy-to-use devices. Building on the ethos of 

ȰÆÏÒÍ ÆÏÌÌÏ×Ó ÆÕÎÃÔÉÏÎȟȱ ÏÕÒ ÐÒÏÄÕÃÔÓ ÃÏÍÂÉÎÅ ÁÄÖÁÎÃÅÄ Ôechnology with dynamic designs. 

(ÅÁÄÑÕÁÒÔÅÒÅÄ ÉÎ 3ÈÅÎÚÈÅÎȟ ×ÉÄÅÌÙ ÃÏÎÓÉÄÅÒÅÄ #ÈÉÎÁȭÓ 3ÉÌÉÃÏÎ 6ÁÌÌÅÙȟ $*) ÂÅÎÅÆÉÔÓ ÆÒÏÍ ÄÉÒÅÃÔ ÁÃÃÅÓÓ ÔÏ 

the suppliers, raw materials, and young, creative talent pool necessary for sustained success. Drawing 

on these resources, we have grown from a single small office in 2006 to a global workforce. Our offices 

can now be found in the United States, Germany, the Netherlands, Japan, South Korea, Beijing, 

Shanghai, and Hong Kong. As a privately owned and operated company, DJI focuses on our own vision, 

supporting creative, commercial, and nonprofit applications of our technology. Today, DJI products are 

redefining industries. Professionals in filmmaking, agriculture, conservation, search and rescue, energy 

infrastructure, and more trust DJI to bring new perspectives to their work and help them accomplish 

feats safer, faster, and with greater efficiency than ever before. To learn more, visit www.dji.com.  

ABOUT CHC NAVIGATION 

Founded in 2003, CHC Navigation (Huace:300627.SZ) creates innovative GNSS navigation and 

positioning solutions to make customers' work more efficient. CHCNAV products and solutions cover 

multiple industries such as geospatial, construction, agriculture and marine. 

With a presence across the globe, distributors in more than 120 countries and more than 1,700 

employees, CHC Navigation is today recognized as one of the fastest growing companies in geomatics 

technologies. To learn more, visit chcnav.com. 

ABOUT WINGTRA AG 

Headquartered in Switzerland, Wingtra is the worldȭs leading VTOL drone producer for mapping, 

survey, and mining industry professionals. Since its market entry in early 2017, Wingtra has partnered 

with more than 70 of the biggest equipment dealers and has been selling mapping drones globally ever 

since. To learn more, visit wingtra.com. 

https://www.dji.com/
https://chcnav.com/
https://wingtra.com/
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ABOUT LP360 DRONE 

LP360 is a 64-bit Windows® desktop application used for many years by the LP360 Geospatial 

community for processing traditional aerial, mobile, and terrestrial tripod laser scanner data. The LP360 

Drone community is the focus of this Users Guide containing the LP360 workflows for processing and 

exploiting TrueView, microdrones®, DJI, Wingtra, and other drone sensor data. Formerly called 

TrueView EVO, LP360 Drone, ÉÓ 'ÅÏ#ÕÅȭÓ LP360 point cloud exploitation product with the addition of a 

collection of tools and workflows for processing drone data. LP360 Drone is the software used to post-

process your raw flight data to generate a 3D LiDAR point cloud in LAS format, colorize the point cloud, 

geotag the images collected, and generate an orthomosaic. LP360 also has many tools for assessing 

and processing point cloud data, such as accuracy assessment, automatic and manual ground 

classification, and contour/ surface generation. LP360 Drone is available in the following licensing 

levels: 

¶ LPViewer ɀ A free viewer level of LP360 for viewing a point cloud. 

¶ LP360 Drone Explorer ɀ A low-cost inspector license equivalent to LP360 Viewer, with Image 
Explorer enabled for viewing True Pose® photos, and Import Cycle for field QC checks. This is 
also the license that should be purchased for delivery with LP360 Explorer Packages provided to 
end users so they can make full use of the TrueView 3DIS point cloud and photos, plus any 
derivative products you generate for them. 

¶ LP360 Drone ɀ Enables PPK processing for systems, such as the DJI P4P RTK, plus TrueView 
2DIS and 3DIS. This is the next generation ASPSuite Advanced and is equivalent to LP360 
Standard with the addition of the sensor workflow tools and tools for ground classification and 
volumetric computations. It is limited to product areas of no more than 10 km2 of LAS data. 
Available as an annual subscription or a perpetual license. 

¶ LP360 Drone+3D Accuracy ɀ Enables the automatic detection of Accuracy Stars and related 
target types. Available as an annual subscription or a perpetual license. 

¶ LP360 Drone+Photo ɀ Enables local Ortho Mapping. Available as an annual subscription or a 
perpetual license. 

¶ LP360 Drone+Photogrammetry with Agisoft ɀ Enables local Agisoft Ortho Mapping, if you 
have a Metashape license, and Cloud based Agisoft Ortho Mapping (using LP360 points). 
Available as an annual subscription or a perpetual license. 

¶ LP360 Drone+Cloud Photo 3000 ɀ Enables both the local Ortho Mapping, local Agisoft Ortho 
Mapping processing if you have your own Metashape license, and Cloud based Agisoft Ortho 
Mapping (includes 3000 photos per month, additional photos may be processed using LP360 
points). Available as an annual subscription license. 

¶ LP360 Drone+Full Photo (formerly Fast Photo) ɀ Legacy license that enables both the local 
Ortho Mapping and local Agisoft Ortho Mapping, if you have a Metashape license, and Cloud 
based Agisoft Ortho Mapping (using LP360 points). 

¶ LP360 Drone+Strip Align ɀ Enables Strip Align and Strip Adjustment tools for adjusting for 
dynamic trajectory errors in the dataset. Available as an annual subscription or a perpetual 
license. 

¶ LP360 Drone+Strip Adjustment ɀ Enables Strip Adjustment for adjusting for dynamic 
trajectory errors, and Calibration tool for boresight calibration of TrueView or microdrones 
datasets. Available as a perpetual license. 

https://support.geocue.com/lp360-feature-matrix-2021-1
https://support.geocue.com/lp360-feature-matrix-2021-1
https://support.geocue.com/lp360-feature-matrix-2020-2/
https://support.geocue.com/aspsuite-user-guide
https://support.geocue.com/lp360-feature-matrix-2020-2/
https://support.geocue.com/lp360-feature-matrix-2020-2/
https://support.geocue.com/lp360-3d-accuracy-accuracy-star-ground-control-points-and-targets/
https://support.geocue.com/lp360-3d-accuracy-accuracy-star-ground-control-points-and-targets/
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¶ LP360 Drone+Business Intelligence Tools ɀ Enables specific point cloud tasks designed for 
extraction of non-ground features, such as rail, power lines, buildings, trees. Available as an 
annual subscription or a perpetual license. 

¶ LP360 Drone+Unlimited ɀ this is the same functionality as LP360 Drone with the size limit 
removed. Available as an annual subscription or a perpetual license. 

¶ LP360 Drone+Experimental ɀ this is the same functionality as LP360 Drone with the addition 
of features classed as experimental. We may occasionally have features that we call 
experimental where we have limited access available only to those organizations specifically 
working with us on those features. Or, at times, a pre-release version being used for training. 

ABOUT LP360 ONLINE 

LP360 Online replaced TrueView Reckon. Both are Amazon Web Services (AWS) hosted platforms that 

are used for a variety of purposes in TrueView (and other) workflows. It provides services such as (items 

marked with a $T are extra cost, paid in Points): 

¶ Project data hosting and visualization ($T) 

¶ Data archival ($T) 

¶ Management and automatic delivery of sensor calibration files 

¶ Automatic sensor health check 

¶ Transfer of sensor Cycle data to GeoCue for technical support 

¶ Management of Points for services that are paid via a metering scheme (marked in this list with 
$T) 

¶ Transaction history of sensor usage 

¶ other related services  

LP360 Online is accessed from within LP360 Drone in various workflows. These workflows might 

require an LP360 Drone user to provide their login credentials. LP360 Online has a web interface for 

data visualization, processing, and account monitoring. 

Every customer is provided an LP360 Online account. Legacy customers may have had a Reckon 

account that has now been transitioned to an LP360 Online account.  

ABOUT LP360 CLOUD 

LP360 Cloud is an ever-growing collection of cloud-based tools and resources that will make it easy for 

you to manage, archive, share and collaborate on geospatial projects.  

LP360 has two LP360 Cloud Addon products that are subscription licenses: 

¶ Storing and sharing data Ÿ requires an LP360 Cloud Access license. 

¶ Power Search, streaming, and cloud data processing Ÿ requires an LP360 Cloud 

Starter license. 

See the LP360 website for the latest that LP360 Cloud has to offer and activate or renew your 

subscription today in the LP360 Store. 

https://cloud.lp360.com/
https://cloud.lp360.com/
https://www.lp360.com/product-line/lp360-cloud-add-ons#:~:text=data%20in%20LP360-,Features,-Login%20to%20Cloud
https://support.geocue.com/introducing-lp360-powersearch-your-personal-assistant-for-data-management
https://www.lp360.com/product-line/lp360-cloud-add-ons/
https://support.geocue.com/lp360-cloud/
https://store.lp360.com/
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A CYCLE 

All TrueView sensors, and microdrones traditional sensors, write their various data streams to a 

ÓÔÁÎÄÁÒÄ ÆÉÌÅ ÆÏÌÄÅÒ ÓÔÒÕÃÔÕÒÅ ÃÁÌÌÅÄ Á Ȱ#ÙÃÌÅȱ on the USB drive or internal memory. The term cycle 

refers to a sensor power cycle because TrueView datasets are started and terminated by the sensor 

power cycles. It is possible to have multiple collections (flights, in the case of a drone) in a single Cycle, 

so it is not necessarily correct to think of Cycle as being synonymous with flight, though it is typically. 

The folder structure requires four basic components to be a valid Cycle for import into LP360 Drone: 

¶ 4ÈÅ ÆÏÌÄÅÒ ÎÁÍÅ ÍÕÓÔ ÈÁÖÅ Ȱ#ÙÃÌÅ;ȱ ÁÔ ÔÈÅ ÂÅÇÉÎÎÉÎÇ ÏÆ ÔÈÅ ÎÁÍÅȢ 
¶ There must be a sub-folder in the CÙÃÌÅ ÆÏÌÄÅÒ ÎÁÍÅÄ Ȱ3ÙÓÔÅÍȱ. 
¶ )Î ÔÈÅ 3ÙÓÔÅÍ ÆÏÌÄÅÒ ÔÈÅÒÅ ÍÕÓÔ ÂÅ Á Ȱ3ÙÓÔÅÍ#ÏÎÆÉÇÕÒÁÔÉÏÎȢÊÓÏÎȱ ÆÉÌÅȢ 
¶ )Î ÔÈÅ 3ÙÓÔÅÍ ÆÏÌÄÅÒ ÔÈÅÒÅ ÍÕÓÔ ÂÅ Á Ȱ#ÙÃÌÅ0ÁÒÁÍÓȢÊÓÏÎȱ ÆÉÌÅȢ 

 
If the user changes the file structure in a way where these conditions are not met, the cycle will not be 
valid for import. 

L: \ Cycle_191212_184916  

|  

+--- System 

|  CycleParams.json  

|  SystemConfiguration.json  

 

Example of proper file structure 

 

ACCESSING AND MANAGING LP360 ONLINE FROM A WEB BROWSER 

LP360 Online, the replacement for TrueView Reckon, is the infrastructure for LP360 Points and online 

data storage via LP360 Cloud. LP360 Online allows your account admin to add users who can use your 

ÁÃÃÏÕÎÔȭÓ LP360 Points and licenses for processing.  

1. If you did not create your online account when making your first subscription license purchase 

then GeoCue will ÃÒÅÁÔÅ ÙÏÕÒ ÁÃÃÏÕÎÔȭÓ LP360 Online account, which you can access at the 

URLs: 

LP360 Store for user, subscription license and LP360 points management: 

https://store.lp360.com/ 

LP360 Cloud for data storage, archiving, sharing, and streaming: 

https://cloud.lp360.com/  

2. GeoCue will assign someone from your account as the point of contact. This person will be the 

store administrator of your LP360 Cloud account and may invite additional users who are 

https://cloud.lp360.com/
https://store.lp360.com/
https://cloud.lp360.com/


LP360 Drone Users Guide 
 

13 LP360 Drone v2024.1.30.0   4/30/2024 

allowed to process. The point of contact will receive an email after purchase which contains the 

invitation to create login credentials.  

3. Additional users may be added at any time by your LP360 Store Admin. 

4. An invitation email is sent to new user(s) by the LP360 Store. 

a. The user selects the Setup Account link in the LP360 Invitation e-mail to confirm the e-

mail and create a password. 

b. The password can be reset by the user by accessing one of the LP360 Online URLs and 

using the ȰForgot Passwordȩȱ link on the login page. Note: The password reset will only 

work if the user has previously confirmed their e-mail address within the specified 

timeframe in the LP360 Invitation e-mail. Contact support to have your invitation e-

mail re-sent. 

https://support.geocue.com/lp360-store-user-management/
https://store.lp360.com/
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LICENSING AND INSTALLATION 

SYSTEM REQUIREMENTS 

Recommended systems for LP360 Drone Processing: 

¶ Windows Version 10, Professional (64-bit) or Windows 11 Professional, or their server 

equivalents. 

¶ i7 or equivalent CPU.  The more cores, the faster the processing. 

¶ 16 GB RAM (32 GB recommended). 

¶ Nvidia Graphics recommended but not required. 

¶ Graphics must support Open GL 4.5. 

¶ Internal Solid State Disk (SSD) with a minimum capacity of 256 GB. 

¶ Secondary storage recommended but not required (e.g., 2 TB spinning disk). 

¶ USB 3.0 Required for data transfer from the TrueView USB Mass Storage (TrueView USB 

memory stick). 

¶ High speed network access required for TrueView Cloud processing (cloud processing of the 

trajectory is the only mode supported for rental systems). 

¶ A minimum 1920 x 1080 resolution display recommended. High resolution, 4k displays, require 

configuring LP360 Drone shortcut ÐÒÏÐÅÒÔÉÅÓ ÐÅÒ -ÉÃÒÏÓÏÆÔȭÓ ÒÅÃÏÍÍÅÎÄÁÔÉÏÎÓ. 

¶ Dual Display is highly recommended for office setups. 

https://support.geocue.com/evo-users-guide
https://msdn.microsoft.com/en-us/library/windows/desktop/ms724832(v=vs.85).aspx
https://msdn.microsoft.com/en-us/library/windows/desktop/ms724832(v=vs.85).aspx
https://support.geocue.com/true-view-ums
https://support.geocue.com/setting-the-screen-resolution-and-scale/
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INSTALLING LP360 DRONE 

When your TrueView system or LP360 Drone is purchased, or a rental or subscription is to begin, your 

ÁÃÃÏÕÎÔȭÓ point of contact will receive an email from support with instructions for downloading the 

latest version of LP360 Drone from the LP360 Store, or from the LP360 Installers page on our 

searchable support knowledge base. For perpetual licenses, a username, password, and link for your 

LP360 Online account should be provided in the email, along with your perpetual License String. For 

subscription licenses and licenses provided with a TrueView rental, the first time your organization 

rents or uses LP360, you will receive an invitation to confirm your e-mail address and create a password 

to access the LP360 Store to download LP360 and to also use as your license credentials.  

PERPETUAL USERS 

Download the latest version of LP360 Drone from the LP360 Store or the LP360 Installers page on our 

searchable support knowledge base and copy to a local drive on your computer. Double-click on the 

installation file to install LP360 Drone. Once installed, use the steps below to activate LP360 Drone 

using the License String provided in your licensing email. 

Note: It is necessary to enable outbound communications to TCP ports 5053, and the customer specific 

port outlined in your licensing email, on any firewalls for the product to communicate with the hosted 

license server. These ports are normally open by default on most firewalls.  

SUBSCRIPTION USERS AND TRUEVIEW RENTALS 

Download the latest version of LP360 Drone from the LP360 Store and save to a local drive on your 

computer. Double-click on the installation file to install LP360 Drone. Once installed, use the steps 

below to activate LP360 Drone using a login and password. 

PERPETUAL LICENSING FOR LP360 DRONE 

1. Open LP360 Drone and select License Manager from the Startup dialog, or File -> License 

Manager 

a. If your version of LP360 Drone is currently unlicensed, you will get an error and be 

prompted to open License Manager when you try to open it. 

2. On the Activation tab, under Credentials, select Perpetual, then copy and paste the License 

String, which includes a password, into the License String field. 

3. Select Ȱ3ÅÔȱ ÔÏ ÓÅÔ ÔÈÅ License String. Once successfully set there is no need to set the License 

String again. 

a. If you encounter an Invalid License String Error message, see the probable resolutions 

on our searchable support knowledge base. 

4. The Available Licenses portion of the license manager should now be highlighted. Select the 

dropdown to select the LP360 Drone license. 

5. Select Check out floating license to use your floating license. An Internet connection must be 

maintained while using a floating license. 

https://store.lp360.com/
https://support.geocue.com/lp360-installers/
https://store.lp360.com/
https://store.lp360.com/
https://support.geocue.com/lp360-installers/
https://store.lp360.com/
https://support.geocue.com/invalid-license-server-string-error/
https://support.geocue.com/invalid-license-server-string-error/
https://support.geocue.com/invalid-license-server-string-error/


LP360 Drone Users Guide 
 

16 LP360 Drone v2024.1.30.0   4/30/2024 

a. If you need to use the license without internet connectivity, check the box to roam the 

license, and then check out the license. A license can be roamed for up to 30 days. 

Other users with access to this license will not be able to use it while the license is 

roamed. 

6. The Current License portion of the dialog should now show the license type with a green 

checkmark (Figure 4) indicating that the license has been activated. 

  

Figure 4 - License Manager 

7. The license is now activated, and LP360 Drone can be used for processing. 

8. If applicable, select additional addon products from the Available Products list and select 

Ȱ#ÈÅÃË /ÕÔ ,ÉÃÅÎÓÅȱ ÔÏ ÅÎÁÂÌÅ ÔÈÅ ÁÄÄÏÎ ÌÉÃÅÎÓÅ ÉÎ ÁÄÄÉÔÉÏÎ ÔÏ ÔÈÅ ÂÁÓÅ ,0ΩάΦ $ÒÏÎÅ ÌÉÃÅÎÓÅȢ 

9. Select Close to close the LP360 Drone License Manager and open LP360 Drone at the desired 

license level. 

10. You can reopen the LP360 Drone License Manager at any time from within LP360 Drone (File -> 

License Manager) to change license levels. 

11. Repeat this process for all desired machines.  

The LP360 Drone license comes standard as a floating license, which means the license can be shared 

easily within your organization. Just install LP360 Drone on all the machines that need to use the 

software, then repeat steps 1-6. Only one machine can use the license for one instance of LP360 Drone 

at a time. The license can be checked in and out as needed if it is not in use by another machine. 

 Feature Level  LP360 for ArcGIS  LP360  LP360 Drone  

Visualization   Viewer (V)  Explorer (X)  

PPK processing    Drone (D) 

Creating Products  Basic (B)  Basic   

Interactive Edit  Standard (S)  Standard   

Automated 
Extraction, 
TrueView 3DIS® 
Post-Processing 
(Drone Only)  

Advanced (A)  Drone (D)1, 
Advanced  

BIT addon 

Removes 10 km2 
size restriction 

  Unlimited addon 

Experimental   Experimental 
addon 
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Table 1 - Licensing Levels of LP360 

1 LP360 Drone is limited to point cloud sized less than 10 km2. Upgrade to LP360 Advanced to remove this 
restriction.  

2 LP360 Drone is limited to point cloud sizes of less than 10 km2. Add an Unlimited addon license to remove this 

restriction.   

SUBSCRIPTION LICENSING FOR LP360 DRONE 

1. Open LP360 Drone and select License Manager from the Startup dialog, or File -> License 

Manager 

a. If your version of LP360 Drone is currently unlicensed, you will get an error and be 

prompted to open License Manager when you try to open it. 

2. On the Activation tab, under Credentials, select Subscription, then enter the same credentials 

you created when completing your invitation to the LP360 Store to access the licenses for your 

organization. 

3. The Available Licenses portion of the license manager should now be highlighted. Select the 

dropdown to select the LP360 Drone license. 

4. Select Check out floating license to use your floating license. An Internet connection must be 

maintained while using a floating license. 

a. If you need to use the license without internet connectivity, check the box to roam the 

license, and then check out the license. A license can be roamed for up to 30 days. 

Other users with access to this license will not be able to use it while the license is 

roamed. 

5. The Current License portion of the dialog should now show the license type with a green 

checkmark (Figure 4) indicating that the license has been activated. 

 

Figure 5 - License Manager 

6. The license is now activated, and LP360 Drone can be used for processing.  

7. If applicable, select additional addon products from the Available Products list and select 

Ȱ#ÈÅÃË /ÕÔ ,ÉÃÅÎÓÅȱ ÔÏ ÅÎÁÂÌÅ ÔÈÅ ÁÄÄÏÎ ÌÉÃÅÎÓÅ ÉÎ ÁÄÄÉÔÉÏÎ ÔÏ ÔÈÅ ÂÁÓÅ ,0ΩάΦ $ÒÏÎÅ ÌÉÃÅÎÓÅȢ 

8. Select Close to close the LP360 Drone License Manager and open LP360 Drone at the desired 

license level. 

9. You can reopen the LP360 Drone License Manager at any time from within LP360 Drone (File -> 

License Manager) to change license levels. 

10. Repeat this process for all desired machines.  

https://store.lp360.com/
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STARTUP DIALOG 

Upon launching LP360 Drone, you will be presented with the LP360 Startup dialog containing the 

frequent starting places. 

 

Figure 6 - Startup dialog 

¶ Add Files to Map ɀ The typical starting place for geospatial users to start a project by adding 

LAS, Raster, Feature files, etc. to the session.  

¶ Open Existing Project ɀ Launches Project Manager and presents the list of previously opened 

projects, defaulting to the last opened project. 

¶ Create a New Project ɀ Opens the Create Project dialog for when you wish to create a new 

project from existing LAS/Raster/Feature/True Pose Photo data instead of a Cycle. Not typical 

for a TrueView workflow as a new project is created when importing the first Cycle into a NEW 

project. 

¶ Import Raw Mission into New Project ɀ Opens the Raw Mission Import Wizard to walk you 

through creating a new project while importing raw mission (Cycle/Flight) data from a 

TrueView, microdrones, other supported sensor, or sensor trajectory and LAS from any sensor 

into LP360. 

¶ Import LP360 Explorer Package ɀ Opens the Import Explorer Package dialog to create a new 

project from an Explorer Package. This is the starting place for the LP360 Explorer license user 

who has received an Explorer Package from a TrueView sensor owner. 

¶ License Manager ɀ Invoke the License Manager dialog to license or change the desired license 

level. Upon closing the License Manager dialog, returns to the Startup dialog. 

Note: Cancelling the Startup dialog will bring you into a blank session of LP360 Drone. 
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LP360 ONLINE LOGIN IN LP360 DRONE 

LP360 Online (formerly TrueView Reckon) is used for a variety of purposes in TrueView workflows. To 

facilitate, the settings use a universal online login in the upper right of the LP360 Drone main frame 

(Figure 7). For perpetual licenses, this login is separate from your license credentials, but are the same 

credentials for subscription users with LP360 Online. Users with LP360 Online licenses are 

automatically logged into LP360 Online and will not see the Online Account Sign in dialog when 

selecting on the [Sign In] button. LP360 Online subscription license users do not have a log out option. 

 

Figure 7 - Unified Online Login 

The login string shows information about the login in the following format:  

email of logged in user (Account) [Point balance]  

To sign in or change online accounts, the user left clicks on the login bar, opening the Online Account 

Sign In dialog (Figure 8).  

For LP360 Online, the user should be automatically signed when using subscription license 

credentials. 

The TrueView Reckon login has been deprecated, please use your LP360 Online account.  

 

Figure 8 ɀ Online Account Sign In dialog 
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Note: It is not necessary to sign into your online account if you are not going to do any online 

related processing, but there are more functions being added to LP360 that utilize LP360 

Online as time goes on. 
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UPDATING TRUEVIEW EVO TO LP360 DRONE 

Users already running TrueView EVO will need to uninstall TrueView EVO before installing LP360 

Drone.  

UPDATING LP360 DRONE 

Users already running LP360 Drone v2022.1.48.0 or later may update LP360 Drone by the prompt they 

will see when starting LP360 Drone, or by selecting Help -> Check for Updates in the LP360 Drone 

dialog. The latest version of LP360 Drone may also be downloaded from the LP360 Store or from the 

LP360 Installers page on our searchable support knowledge base and installed over the older version. 

Release ɀ The default and recommended selection is to automatically download and install the latest 

LP360 Drone release. 

Experimental ɀ Access to the experimental version is granted based on the organization and uses the 

LP360 Online login. We may occasionally have products or features that we call experimental where we 

have a limited version available only to those accounts specifically working with us on those features or 

products. Or, at times, a pre-release version being used for training and available from the TrueView 

Training account. 

 

Figure 9 - Check for Updates 

https://store.lp360.com/
https://support.geocue.com/lp360-installers/


LP360 Drone Users Guide 
 

22 LP360 Drone v2024.1.30.0   4/30/2024 

POSPAC CLOUD VS LOCAL PROCESSING 

LP360 Drone uses a built-in interface that runs the Applanix Corporation POSPac processing solution to 

provide GNSS and inertial corrections for sensor trajectory processing. POSPac can be run in one of two 

locations: Cloud or Local. Cloud processing uploads your data to an Applanix server, corrects the data, 

and downloads the processed results. Local processing runs a locally installed version of POSPac in the 

background on your machine and does not use LP360 Points but is limited to systems that are the 

Classic business model, may only run one instance at a time, and requires the user to manage their 

POSPac installations and licensing. 

CLOUD 

Cloud processing uploads your flight data to an Applanix server which corrects the GNSS signal and 

inertial values stored in the T04 or rover RINEX file. The smoothed best estimate trajectory (SBET) is 

then computed and downloaded back to your local machine. The user is charged LP360 Points based on 

the number of kinematic minutes for the processed files based on their selected business model. This 

trajectory is then used to geocode your LiDAR data. Customers with any system where you wish to 

process the trajectory using SMARTBase or PP-RTX, can only use the cloud processing option. Classic 

systems also have the option of single base processing using the Cloud. Any use of the POSPacCloud 

processing must have enough LP360 Points available to cover the cost of processing regardless of the 

business model for the system. Since LP360 Drone communicates with LP360 Online to manage your 

ÁÃÃÏÕÎÔȭÓ LP360 Point balance during the POSPac Processing Wizard step, you must be logged into your 

LP360 Online account, except for Traditional and Rental systems when processing using single base. 

INSTALLING POSPAC CLOUD 

1. POSPacCloud is installed as part of the installation of LP360 as it is used to support several 

tools. There is nothing to be configured, but POSPacCloud does need to be able to 

communicate through any firewalls. 

FIREWALL REQUIREMENTS FOR POSPAC CLOUD 

POSPacCloud needs to be able to communicate with the following domains (different subdomains): 

*.pospaccloud.com 

*.trimble.com 

*.trimblepaas.com 

 

Ȱ%Program Files%\Applanix\POSPac Cloud\0/30ÁÃ#ÌÏÕÄȢÅØÅȱ ÎÅÅÄÓ ÔÏ ÂÅ ÁÂÌÅ ÔÏ ÃÏÍÍÕÎÉÃÁÔÅ ÂÏÔÈ 

inbound and outbound through your firewall. 

Users who operate their sensor as a vehicle mounted mobile scanner will need a POSPac MMS 

license if the sensor is licensed for local processing. Vehicle mounted mobile scanner 

configurations using a Traditional/DGaaS hardware type will still use POSPac Cloud.  

 

https://www.applanix.com/
https://support.geocue.com/single-base-vs-smartbase-vs-pp-rtx/
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LOCAL 

POSPac local processing is a method available only to those who have purchased their TrueView 

system with a Classic business model and have POSPac UAV or POSPac MMS installed and licensed on 

their machine. A POSPac UAV network license allowing for only single base processing is included with 

each TrueView Classic system purchase. Processing any system using SMARTBase or PP-RTX, must use 

POSPacCloud. TrueView 2DIS and DJI sensors, such as the DJI Phantom 4 RTK, M210 RTK, DJI 

Zenmuse P1 (M300 RTK), Mavic 3 Enterprise (M3E) RTK use either the built-in post processing 

kinematic (PPK) engine for local single base processing, or the real-time trajectory solution, so do not 

require POSPac desktop to be installed. 

LP360 Drone will execute a batch process in the background using the local version of POSPac. Use the 

steps below to configure LP360 Drone for use with a local version of POSPac UAV. 

CONFIGURING LP360 DRONE FOR POSPAC UAV OR POSPAC MMS 

1. Download POSPac UAV 9.1  from the LP360 Store (Download -> POSPac UAV or POSPac 

MMS, if applicable). 

2. Install POSPac UAV 9.1 on your machine and activate your POSPac UAV license. See Appendix 

A: POSPac UAV Network License for more information on activating and using your POSPac 

UAV Network License.   

3. Open LP360 Drone and click File -> Project Settings -> TrueView tab. 

4. Under POSPacBatch.exe Location (LOCAL) (Figure 10), navigate to ȰC:\Program 

Files\Applanix\POSPac UAV 9.1\ȱ or ȰC:\Program Files\Applanix\POSPac MMS 9.1\ȱ and select 

PospacBatch.exe. Then, select Apply when finished to commit the setting.  

 

Figure 10 - TrueView POSPac Settings 

5. LP360 Drone should now be configured to use local POSPac UAV or MMS desktop. A POSPac 

UAV license is included with a 3DIS® purchase. A user must have their own POSPac MMS 

license. 

CONFIGURING LP360 DRONE FOR LOCAL POSPAC QC 

QC processing of any system can be done using POSPacCloud provided the machine is connected to 

the internet and requires no additional installation. POSPac QC local processing is a method available 

for those who wish to be able to run QC processing offline for performing field checks. Offline checks 

ÒÅÑÕÉÒÅ ÔÈÅ ÉÎÓÔÁÌÌÁÔÉÏÎ ÁÎÄ ÃÏÎÆÉÇÕÒÁÔÉÏÎ ÏÆ ÔÈÅ 0/30ÁÃ 5!6 #ÏÍÍÁÎÄ ,ÉÎÅ 1# ÕÔÉÌÉÔÙȟ ×ÈÉÃÈ ÄÏÅÓÎȭÔ 

require a POSPac license on the machine to run.  

https://support.geocue.com/single-base-vs-smartbase-vs-pp-rtx/
https://store.lp360.com/
https://support.geocue.com/pospac-uav-installation-and-licensing/
https://support.geocue.com/true-view-3dis-field-data-checking-methods/
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1. Download POSPac UAV Command Line QC 9.1 from the LP360 Store (Download -> POSPac 

QC). 

2. Install POSPac UAV Command Line QC 9.1 on your machine. 

3. Open LP360 Drone and click File -> Project Settings -> TrueView tab. 

4. Under POSPacBatchQC.exe Location (QC-Only) (Figure 11Ɋȟ ÎÁÖÉÇÁÔÅ ÔÏ ȰC:\Program 

Files\Applanix\POSPac UAV Command Line QC 9.1\ȱ and select PospacBatch.exe. Then, select 

Apply when finished to commit the setting.  

 

Figure 11 - TrueView POSPac QC Settings 

5. LP360 Drone should now be configured to use local POSPac UAV Command Line QC utility to 

enable local POSPac QC processing. 

 

ADDITIONAL LICENSING REQUIREMENTS FOR LP360 DRONE+STRIP ALIGN 

For TrueView 3DIS, microdrones, DJI Zenmuse L1/L2, Wingtra, and ȰOtherȱ point clouds, strip 

alignment may be improved by executing an addon license to LP360 Drone, called Strip Align for 

LP360 Drone. Note: Strip Align for LP360 Drone may only be used with drone data processed in LP360. 

 

ADDITIONAL LICENSING REQUIREMENTS FOR LICENSING LP360 DRONE+DESKTOP 

PHOTO WITH AGISOFT 

For TrueView, microdrones, and DJI sensors, the orthomosaic can be generated and the image 

positions and orientations refined using Agisoft Ortho Mapping, that is an addon license to LP360 

Drone, called Desktop Photo with Agisoft . Desktop Photo with Agisoft consists of a ȰFull Photoȱ (new 

name for the ÌÅÇÁÃÙ Ȱ&ÁÓÔ 0ÈÏÔÏȱ ÌÉÃÅÎÓÅɊ or a Ȱ0ÈÏÔÏgrammetry ×ÉÔÈ !ÇÉÓÏÆÔȱ addon license, plus an 

Agisoft Ortho Mapping license that must be separately activated. Images may also be processed in the 

Cloud version for Agisoft Ortho Mapping using points purchased in the LP360 Store and requires no 

separate Agisoft Ortho Mapping license activation.  

The activation uses standard HTTPS protocol (via default system TCP port). Access 

to activate.agisoft.com  (52.215.115.17) is required. 

 

LP360 Strip Align licensing requires an open HTTPS port (443) to ls65.rlmcloud.com 

[104.245.32.243] to complete the license validation unless an offline activation has been 

provided. 

 

https://store.lp360.com/
https://store.lp360.com/
https://activate.agisoft.com/activate-offline
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True Pose® images may also be processed in other photogrammetric packages, such as PIX4D and 

"ÅÎÔÌÅÙȭÓ #ÏÎÔÅØÔ#ÁÐÔÕÒÅ, using the Export Photo Package tool, but is not tightly integrated like 

Agisoft Ortho Mapping or Ortho Mapping. 

ACTIVATE AGISOFT ORTHO MAPPING LICENSE 

To configure your Agisoft Ortho Mapping license: 

1. Using Agisoft Ortho Mapping requires no separate installation of Metashape, however, if you 

are using a GUI version Metashape Pro license then you will need to separately install 

Metashape Pro v1.7.1, v1.8.x, or v2.0.x and follow the installation and licensing instructions 

provided by Agisoft with your license delivery and not the following instructions. When using a 

separately installed GUI version of Metashape Pro, you will need to configure it to be run by 

LP360 Drone. 

2. Once you have installed and licensed LP360 Drone, open LP360 Drone. 

3. Cancel off the Startup dialog. 

4. Open the Project Settings dialog (File -> Project Settings). 

5. On the EXP tab, in the Agisoft Ortho Mapping section (Figure 12), select Check Activation 

Status. 

 
Figure 12 ɀ Agisoft Ortho Mapping License Setting 

6. You should see an Activation Status message (Figure 13) ÉÎÄÉÃÁÔÉÎÇȟ Ȱ-ÅÔÁÓÈÁÐÅ ÉÓ ./4 

!ÃÔÉÖÅȱȢ 3ÅÌÅÃÔ OK. 

 

Figure 13 ɀ Agisoft Ortho Mapping Activation Status - NOT Activated 

7. Copy/paste your console key, as provided in your initial licensing e-mail, into the Activation 

Key field. 
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8. Select Activate to activate the Agisoft Ortho Mapping license on this machine. 

9. You should see an Activation Success message (Figure 14) ÉÎÄÉÃÁÔÉÎÇȟ Ȱ-ÅÔÁÓÈÁÐÅ ÓÕÃÃÅÓÓÆÕÌÌÙ 

ÁÃÔÉÖÁÔÅÄȱȢ 3ÅÌÅÃÔ OK. 

 

Figure 14 ɀ Agisoft Ortho Mapping Activation Success 

10. Select OK or Apply to close the Project Settings dialog. 

11. Check out a ȰFull Photoȱ ÏÒ Ȱ0ÈÏÔÏgrammetry ×ÉÔÈ !ÇÉÓÏÆÔȱ addon license to the LP360 Drone 

license. 

12. Execute the Agisoft Ortho Mapping tool to generate an orthomosaic and refine the True Pose® 

photo positions and orientations. 

DEACTIVATE AGISOFT ORTHO MAPPING LICENSE 

To deactivate an Agisoft Ortho Mapping license: 

1. Open LP360 Drone. If you previously activated while using elevated permission, then right-click 
on the LP360 Drone icon in the start menu or task bar and ÓÅÌÅÃÔ Ȱ2ÕÎ ÁÓ !ÄÍÉÎÉÓÔÒÁÔÏÒȱ to 
grant elevated permissions for deactivating the license. 

2. Cancel off the Startup dialog. 
3. Open the Project Settings dialog (File -> Project Settings). 
4. On the EXP tab, in the Agisoft Ortho Mapping section, select Check Activation Status. 
5. You should see an Activation Status message (Figure 15) ÉÎÄÉÃÁÔÉÎÇȟ Ȱ-ÅÔÁÓÈÁÐÅ ÉÓ ÁÃÔÉÖÁÔÅÄȱȢ 

Select OK. 

It is necessary to deactivate the Agisoft Ortho Mapping license before re-

installing/installing a new OS or changing hardware components. In addition, the 

license should be deactivated to be transferred to another computer.  

If a machine has ever been licensed for Agisoft Ortho Mapping, the metashape.lic file 

can be found in Ȱ%ProgramData%\LP360\MSPyOrthoȱ ÏÒ 

Ȱ%CommonProgramFiles%\LP360\MSPy38ȱ and should never be deleted. The 

licenses are now stored ÉÎ Ȱ%ProgramData%\Agisoft\Licensing\licensesȱ. 
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Figure 15 ɀ Agisoft Ortho Mapping Activation Status - Activated 

6. Select Deactivate to deactivate this Agisoft Ortho Mapping license from this machine. 
7. You should see a Deactivation Success message (Figure 16) ÉÎÄÉÃÁÔÉÎÇȟ Ȱ-ÅÔÁÓÈÁÐÅ ÓÕÃÃÅÓÓÆÕÌÌÙ 
ÄÅÁÃÔÉÖÁÔÅÄȱȢ 3ÅÌÅÃÔ OK. 

 

Figure 16 ɀ Agisoft Ortho Mapping Deactivation Success 

8. Select OK or Apply to close the Project Settings dialog. Close and restart LP360 Drone without 
elevated permissions. 

OFFLINE ACTIVATE AGISOFT ORTHO MAPPING LICENSE 

In some circumstances you may not be able to reach the Agisoft license activation servers to 

activate/deactivate your license, so you may then need to take the longer route of an offline 

activation/deactivation of your Agisoft Ortho Mapping license. 

LP360 Drone will remember your encrypted Agisoft Ortho Mapping license key to make it 

easier to Activate the license again on the same machine provided it is not activated 

elsewhere. 
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Figure 17 ɀ Agisoft Ortho Mapping Offline Activation/Deactivation  

To configure your Agisoft Ortho Mapping license using the offline activation process, not 

recommended, but required if the machine cannot connect to the Agisoft license servers: 

1. Using Agisoft Ortho Mapping requires no separate installation of Metashape, however, if you 

are using a GUI version Metashape Pro license then you will need to separately install 

Metashape Pro v1.7.1, v1.8.x, or v2.0.x and follow the installation and licensing instructions 

provided by Agisoft with your license delivery and not the following instructions. When using a 

separately installed GUI version of Metashape Pro, you will need to configure it to be run by 

LP360 Drone. 

2. Once you have installed and licensed LP360 Drone, open https://activate.agisoft.com/activate-

offline page from a computer with Internet access, input the Agisoft Ortho Mapping license 

activation key and press Save Activation Parameters button to save the activation parameters 

file, Ȱmetashape-pro.actparamȱ. 

 

Figure 18 ɀ Section 1 on the Agisoft website for offline activation 

3. Transfer the generated activation parameters file to the computer with LP360 Drone where the 

Agisoft Ortho Mapping license should be activated and proceed to next step. 

4. Open LP360 Drone. 

5. Cancel off the Startup dialog. 

6. Open the Project Settings dialog (File -> Project Settings). 

https://activate.agisoft.com/activate-offline
https://activate.agisoft.com/activate-offline
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7. On the EXP tab, in the Agisoft Ortho Mapping section (Figure 12), select Check Activation 

Status. 

8. You should see an Activation Status message (Figure 19) ÉÎÄÉÃÁÔÉÎÇȟ Ȱ-ÅÔÁÓÈÁÐÅ ÉÓ ./4 

ActivatedȱȢ 3ÅÌÅÃÔ OK. 

 

Figure 19 ɀ Agisoft Ortho Mapping Activation Status - NOT Activated 

9. This will activate the Generate Activate Request File option (Figure 17). Selecting this option 

will allow you to create an offline activation request file by browsing for the activation 

parameter fileȟ Ȱmetashape-pro.actparamȱȟ obtained from the Agisoft offline activation 

website and save the activation request fileȟ Ȱmetashape-pro.actreqȱ. You will see the License 

Request Generated confirmation dialog (Figure 20). 

 

Figure 20 - License Request Generated 

10. Transfer the generated activation request file, Ȱmetashape-pro.actreqȱ, (created in the previous 

step) to the computer with Internet access, open https://activate.agisoft.com/activate-

offline, beside Activation request in section 2, select the request fileȟ Ȱmetashape-pro.actreqȱȟ 

and select Save Activation Response button to save the response fileȟ Ȱmetashape-pro.actrespȱ: 

https://activate.agisoft.com/activate-offline
https://activate.agisoft.com/activate-offline
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Figure 21 - Section 2 on the Agisoft website for offline activation 

11. Transfer the activation response fileȟ Ȱmetashape-pro.actrespȱȟ to the computer with LP360 

Drone where the Agisoft Ortho Mapping license should be activated. 

12. Open LP360 Drone. 

13. Cancel off the Startup dialog. 

14. Open the Project Settings dialog (File -> Project Settings). 

15. On the EXP tab, in the Agisoft Ortho Mapping section (Figure 12), select Check Activation 

Status. 

16. You should see an Activation Status message (Figure 19) ÉÎÄÉÃÁÔÉÎÇȟ Ȱ-ÅÔÁÓÈÁÐÅ ÉÓ ./4 

ActivatedȱȢ 3ÅÌÅÃÔ OK. 

17. Select Activate from Response File (Figure 17) and browse for the activation response file, 

Ȱmetashape-pro.actrespȱ to activate this Agisoft Ortho Mapping license on this machine. 

18. You should see the Metashape Offline Activation message (Figure 22) ÉÎÄÉÃÁÔÉÎÇȟ Ȱ-ÅÔÁÓÈÁÐÅ 

should now be ÁÃÔÉÖÁÔÅÄȱȢ 3ÅÌÅÃÔ OK. 

 

Figure 22 - Offline Agisoft Ortho Mapping Activation Success 
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19. Select OK or Apply to close the Project Settings dialog. 

20. Check out a Ȱ&ÕÌÌ 0ÈÏÔÏȱ ÏÒ Ȱ0ÈÏÔÏgrammetry ×ÉÔÈ !ÇÉÓÏÆÔȱ addon license to the LP360 Drone 

license. 

21. Execute the Agisoft Ortho Mapping tool to generate an orthomosaic and refine the True Pose® 

photo positions and orientations. 

OFFLINE DEACTIVATE AGISOFT ORTHO MAPPING LICENSE 

To deactivate your Agisoft Ortho Mapping license using the offline activation process, not 

recommended, but required if the machine cannot connect to the Agisoft license servers: 

1. Open LP360 Drone. 
2. Cancel off the Startup dialog. 
3. Open the Project Settings dialog (File -> Project Settings). 
4. On the EXP tab, in the Agisoft Ortho Mapping section, select Check Activation Status. 
5. You should see an Activation Status message (Figure 23Ɋ ÉÎÄÉÃÁÔÉÎÇȟ Ȱ-ÅÔÁÓÈÁÐÅ ÉÓ ÁÃÔÉÖÁÔÅÄȱȢ 

Select OK. 

 

Figure 23 ɀ Agisoft Ortho Mapping Activation Status - Activated 

This will activate the Generate Deactivate Request File option (Figure 17). Selecting this 

option will allow you to select a folder in which to create the offline deactivate license request 

file(s)ȟ ȰÄÅÁÃÔÉÖÁÔÅ* .actreqȱ. You will get a confirmation dialog with the number of licenses that 

have been deactivated and the location where to find the deactivation request file(s). 

 

Figure 24 - Deactivation Request Complete Confirmation 

It is necessary to deactivate the Agisoft Ortho Mapping license before re-

installing/installing a new OS or changing hardware components. In addition, the 

license should be deactivated to be transferred to another computer.  
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Important!  Once you have generated a deactivate license request file you must complete the 

deactivate step on the website to be able to activate your license key on a new machine. 

 

6. Transfer the generated deactivation request fileɉÓɊȟ ȰÄÅÁÃÔÉÖÁÔÅ*.actreqȱ, from the previous 

step, to the computer with Internet access, open https://activate.agisoft.com/activate-

offline, select this request file in the corresponding Ȱ$Åactivate license on computer with no 

)ÎÔÅÒÎÅÔ ÁÃÃÅÓÓȱ section and select the Deactivate button to complete the license deactivation 

process. You will see an offline license deactivation confirmation page. 

 

Figure 25 ɀ (Top) Deactivate section on the Agisoft website to deactivate licenses offline.  

(Bottom ) Offline license deactivation confirmation.  

7. Close LP360 Drone.  

https://activate.agisoft.com/activate-offline
https://activate.agisoft.com/activate-offline
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CREATING A NEW DRONE PROJECT 

The following steps will guide you through each step of the workflow, importing data to create a drone 

project, generate a LiDAR point cloud, tagging photos, or generating an orthomosaic. Importing a 

Cycle is the first step, post flight, of the Sensor workflow. A Cycle can be imported into LP360 Drone to 

form a new project or, if a project already exists, to add a Cycle to that project.  

1. Open LP360 Drone and check out your license if necessary. See the Licensing LP360 Drone 

section in this document. 

2. Insert the USB drive, which contains your Cycles/Flights (raw flight data), into your computer. 

 

Figure 26 - Enabling Single Cycle Mode will only display layers relevant to Active Cycle 

  

Figure 27 ɀ TrueView Workflow and Utilities on the Sensor tab 

3. Select Cycle Import  on the Sensor tab (Figure 27) to open the Raw Mission Import Wizard. If 

the wizard is run outside of an existing LP360 project, then it will create a new project. If you run 

the wizard from within an existing project, the occurrences of ȰNEWȱ in Figure 29 are replaced 

×ÉÔÈ Ȱ#522%.4ȱ. 

Note: If the Cycle Import button is greyed out, then you do not have a valid LP360 Drone Explorer or 

higher level LP360 Drone (recommended) license checked out. See the Licensing LP360 Drone 

section in this document. 
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Figure 28 ɀ Import Cycle 

If any of your Cycles utilized Á ȰCompanionȱ ÃÁÍÅÒÁ, you must manually copy the photos 

into the Cycle prior to importing the Cycle into LP360. Then, refer to the Companion 

Camera(s) EO File Generation section for more information on the workflow. 
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RAW MISSION IMPORT WIZARD 

Selecting Cycle Import   on the Sensor tab brings up the first page of the Raw Mission Import wizard 

(Figure 29). 

 

Figure 29 - First page of Import Cycle Wizard for a NEW Project 

IMPORT MODE 

The import mode options allow you to import a Cycle from a disk-based file (typically the USB memory 

stick from the TrueView or ȰOtherȱ named sensor), and/or from a TrueView Archive.   

¶ Import Flights into NEW/CURRENT Project (Not Recommended!) ɀ this option imports a 
Cycle into an existing or new project. We recommend against this because you will not have a 
ÂÁÃËÕÐ ÏÆ ÔÈÅ #ÙÃÌÅ ÉÎ ÔÈÅ ÎÁÔÉÖÅ Ȱ#ÙÃÌÅ &ÏÒÍÁÔȢȱ   

¶ Import and Archive Flights into NEW/CURRENT Project ɀ this option adds the Cycle to an 
Archive and creates/adds to an LP360 project (Recommended ɀ See Best Practice). 

¶ Archive Flights ɀ this option imports a Cycle from a USB/File and adds it to an Archive. This 
option does not run the same checks on the data as the previous step would do. We 
recommend against using this option because you will not have performed any checks on the 
data being put into the archive. 

SENSOR 

LP360 Drone has the capability to import data from TrueView sensors, as well as systems such as the 

DJI Zenmuse L1 or L2, Wingtra LiDAR, DJI Phantom 4 RTK, M210 RTK, DJI Zenmuse P1 (M300 RTK), 

and DJI Mavic 3 Enterprise (M3E) for both real-time kinematic (RTK) and post processing kinematic 

(PPK) workflows, and image processing to an orthomosaic and generated point cloud. Additional 

sensors may be added upon request. Other supports any point cloud with a sensor trajectory file. 

3ÅÌÅÃÔ ÔÈÅ ȰImport Flights into NEW/CURRENT Projectȱ ÒÁÄÉÏ ÂÕÔÔÏÎ ÁÎÄ ÔÈÅ ÄÅÓÉÒÅÄ Sensor type 

from the Raw Mission Import Wizard (Figure 29). Then, press the Next > button at the bottom of the 

dialog to take you to the specific Input Folder Page, as described below. 
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¶ TrueView / Microdrones 

¶ Wingtra LIDAR 

¶ DJI 

o L1/L2 

o P1 

o M3E 

o Phantom 4 Pro RTK 

o M210 RTK 

¶ Other 

After selecting the import mode and the desired sensor, press the Next > button at the bottom of the 

dialog to take you to the applicable input Cycle, flights, or missions page as described in the following 

subsections. 

 

Best Practice 

Import and archive the Cycle/Flight to an Archive. Add all files that you want 
bundled with the Archive. When the archived Cycle/Flight is complete, LP360 will 
import from the Archive to update or create a project. 

Note: Archiving is currently only available for TrueView and microdrones sensors. 

INPUT TRUEVIEW CYCLES/FLIGHTS 

The next step of the import process as depicted in Figure 33 is to add Cycle/Flight folders or archived 

Cycles/Flights to the Input Flights page and fill in the optional fields as desired. 

Add a TrueView Cycle/Flight from: 

 Folder ɀ Add one or more TrueView Cycle/Flight by selecting the Cycle folder(s) found on the 

USB. Select option and browse to the desired Cycle folder(s). 

  Archive Zip File ɀ If you or a pilot in the field has previously archived TrueView Cycles/Flights 

to an LP360 Cloud Cycle-Archive and shared that archived Cycle for download, use this button to add 

archived Cycles to the queue for import into the project without them needing to reside in a configured 

TrueView Archive. 

For high-density scanner Cycles, such as the TV680 or TV720, the laser data is on a 

secondary media retrieved from the laser scanner. When loading these Cycles, LP360 

prompts the user to specify the path to the laser data (rxp files). After the path to the laser 

data is selected, the files will be copied to the correct location in the raw Cycle data for 

importing into the project and creating the archived Cycle. 
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  Archive ɀ If you or a pilot in the field has previously archived TrueView Cycles/Flights to an 

Archive use this button to add archived Cycles to the queue for import into the project. 

IMPORTING FROM AN ARCHIVE 

Choosing to add Cycles from an Archive will bring up a dialog that lists your current Archives as 

shown in Figure 30. Available Archives are listed in the top panel of the dialog (an Archive is 

simply a directory reachable by a Universal Naming Convention (UNC) path where you store 

Cycles). TrueView Archives must be added in the TrueView Archive Manager prior to running 

the Raw Mission Import Wizard. Use the Compute Size button to see how much disk space is 

currently being used by that archive. 

 

Figure 30 - Archive and Cycle Selection Page 

Selecting one of the Archives by left-clicking a row in the Available Archives section will show a 

list in the lower pane of the Cycles stored in that Archive (Figure 31). 

 

Figure 31 - Selecting an Archive shows the available Cycles 

Select the Cycle(s) in the lower pane of Figure 31 and press OK.  You will receive a confirmation 

dialog (Figure 32). Press OK to proceed with adding the archived Cycles to the flights to be 

imported queue. The Cycle is in a compressed format and will be decompressed into a 

temporary file for import into the Project. This may take a bit of time so be patient.  

 

Figure 32 - Import from Archive confirmation dialog 
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Figure 33 ɀ Input TrueView Flights page 

Note: Columns with a pencil  indicate user editable fields. Multi select and right-click to set the same 

value for all selected rows. Right-click on a populated field to use that as the default value for the 

selected rows. 

¶ Cycle/Flight Name - Any alphanumeric string. The default is the name given to the Cycle by the 
TrueView Sensor. It is generally a good idea to keep this name since it is the same name used in 
the Cycle directory structure. 

¶ Sensor Type ɀ The TrueView sensor model. 

¶ Area (Site) name ɀ This is an optional label that can be added when you are segregating a 
0ÒÏÊÅÃÔ ɉÅȢÇȢȟ Ȱ0ÅÁÂÏÄÙ -ÉÎÅ έέȱɊ ÉÎÔÏ ÍÕÌÔÉÐÌÅ ÁÒÅÁÓ ÓÕÃÈ ÁÓ Ȱ0ÉÔ !ÒÅÁȱ ÁÎÄ Ȱ3ÔÏÃËÐÉÌÅ 9ÁÒÄȢȱ  

¶ Ancillary Files ɀ This section of the dialog allows you to add any files you would like that are 

relevant to this project. For example, you could add a Check Point file, pdf description files, 

project reports and so forth. Note that these ancillary files will be associated with the Cycle, not 

the Project (that is, added to the Cycle file structure). If you are simultaneously archiving this 

project, these ancillary files will be included in the compressed archive.  

The first time you add Ancillary files to a project, an Ancillary Files folder is created within the 

Cycle folder structure and within your LP360 project. Copies of these files are then placed in 

these folders.   

Best Practice 

Add your checkpoint file to the Ancillary files section of this dialog. This will 
package the checkpoints for future use with this Cycle. Make sure to include the 
Coordinate Reference System of the Check Points if they are not the same as the 
Project.   

If you have used a positioning service such as OPUS to establish the base station 
location, add the OPUS report to the ancillary files as well.   

¶ Archive Description ɀ An optional description that can be viewed when viewing the archived 

Cycle in the TrueView Archive Manager. Only visible when one of the import options that 

archives is selected. 

¶ Photos ɀ The number of photos found in the Cycle/Flight. 
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¶ Cameras ɀ The number of cameras for this Cycle/Flight. 

¶ Camera Paths ɀ If the images were added to the Cycle folder during wind-down (or 

alternatively manually added prior to running this wizard), their paths will already be populated 

in the dialog after having selected the Cycle. If the images have not been previously added to 

the Cycle folder, browse for the folders containing the Starboard and Port Images by double-

clicking in the applicable image path column. Note that it is not necessary to know which 

camera is port or starboard; LP360 Drone will sort this out. Other times the camera paths are 

not auto detected usually indicate potential issues with the folder structure, content, or 

CycleParams file that need to be resolved before importing the Cycle/Flight. Contact 

support@geocue.com for assistance. 

¶ Temp Decompressed Cycle Path ɀ populated only if the Cycle/Flight was added from an 

Archive. 

After selecting the input flights, press the Next > button at the bottom of the dialog to take you to the 

Base Observation Files page. 

INPUT WINGTRA LIDAR  

LP360 Drone has the capability to import data from the Wingtra LiDAR. For a Wingtra LiDAR, the raw 

data must first be processed through the Wingtra LiDAR Application. The resulting LAS and trajectory 

files (TXT or SBET) from can then be imported into LP360 Drone for post-processing which allows for 

modifications to the already geocoded data. 

To import into LP360, manually select the LAS files and Trajectory Files (Figure 34) produced by the 

Wingtra LiDAR Application. If present in the selected files or known due to the file formats, the 

Coordinate Reference System (CRS) information will auto populate the dropdowns (Figure 34) on the 

Raw Mission Import Wizard ɀ Wingtra page for the selected LAS File(s) and sensor Trajectory File(s). 

The sensor trajectory files (.TXT or SBET.OUT) will always be in a geographic coordinate system and 

therefore may not match the CRS of the LAS file exactly, depending on whether the LAS files are in a 

projected or geographic coordinate system. There does not have to be a correlation of one LAS per 

sensor trajectory file, there could also be one LAS for many SBETs, one LAS to one SBET, or many LAS 

to one SBET, so long as there is coverage in time for the sensor trajectory file(s) for every point in the 

LAS file(s). The only currently supported sensor trajectory ASCII text format (.TXT) is a tab delimited 

text file with nine columns in the order of: Week, GPSTime, UTCTime, Longitude, Latitude, H-Ell, 

Heading, Pitch, and Roll, where H-Ell are ellipsoidal heights. 

mailto:support@geocue.com
https://knowledge.wingtra.com/en/processing-data-in-wingtra-lidar-app
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Figure 34 - Import Wizard - Input Wingtra Page 

Add Mission ɀ Select to add one or more missions to be imported into LP360 Drone.  

Remove Missionɀ Select row(s) from the grid to enable this button to remove one or more flights that 

you no longer wish to import. 

Once a mission has been added, the grid will display a summary of the desired files for each flight. 

Note: Columns with a pencil  indicate user editable fields. Multi select and right-click to set the same 

value for all selected rows. Right-click on a populated field to use that as the default value for the 

selected rows. 

Area (Mission) name ɀ This is an optional label that can be added when you are segregating a 
0ÒÏÊÅÃÔ ɉÅȢÇȢȟ Ȱ0ÅÁÂÏÄÙ -ÉÎÅ έέȱɊ ÉÎÔÏ ÍÕÌÔÉÐÌÅ ÁÒÅÁÓ ÓÕÃÈ ÁÓ Ȱ0ÉÔ !ÒÅÁȱ ÁÎÄ Ȱ3ÔÏÃËÐÉÌÅ 9ÁÒÄȢȱ  
 

Ancillary Files ɀ This section of the dialog allows you to add any files you would like that are 

relevant to this project. For example, you could add a Check Point file, pdf description files, 

project reports and so forth. Note that these ancillary files will be associated with the Cycle, not 

the Project (that is, added to the Cycle file structure). If you are simultaneously archiving this 

project, these ancillary files will be included in the compressed archive.  

The first time you add Ancillary files to a project, an Ancillary Files folder is created within the 

Cycle folder structure and within your LP360 project. Copies of these files are then placed in 

these folders.   

Then, press the Next > button at the bottom of the dialog to take you to the Setting Output TrueView 

Project page when importing to a NEW project. Select Finish to begin importing the queued flights. 

Upon successful completion of the Wingtra LIDAR import queue, proceed with examining the imported 

files. 
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INPUT DJI ZENMUSE L1/L2 

For a DJI Zenmuse L1/L2, the data expected from the system for processing in LP360 Drone is a 

combination of the raw flight folder(s) from the sensor and some of the DJI Terra processed folders. 

Previously individual flights with an L1/L2 project would need to be processed as individual missions in 

Terra, now all flights for a single project can be processed in one Terra mission, then the mission folder 

can be imported into LP360. 

 

Figure 35 - Import Wizard - Input DJI L1/L2 Folder Page 

Add DJI Terra Mission Folder ɀ Select to add one or more folders that were processed in DJI Terra and 

must contain the lidars subfolder containing one or more sbet.out and smrmsg.out files, and 

lidar\terra_las subfolder containing LAS files. 

Remove DJI Mission Folder ɀ Select row(s) from the grid to enable this button to remove one or more 

missions that you no longer wish to import. 

Once a mission folder has been added the grid will display a summary of the detected files for each 

flight.  

Note: Columns with a pencil  indicate user editable fields. Multi select and right-click to set the same 

value for all selected rows. Right-click on a populated field to use that as the default value for the 

selected rows. 

Mission name ɀ This is an optional label that can be added when you are segregating a Project 
ɉÅȢÇȢȟ Ȱ0ÅÁÂÏÄÙ -ÉÎÅ έέȱɊ ÉÎÔÏ ÍÕÌÔÉÐÌÅ ÁÒÅÁÓ ÓÕÃÈ ÁÓ Ȱ0ÉÔ !ÒÅÁȱ ÁÎÄ Ȱ3ÔÏÃËÐÉÌÅ 9ÁÒÄȢȱ It is 
automatically named the same as your DJI Terra mission folder. 
 

Ancillary Files ɀ This section of the dialog allows you to add any files you would like that are 

relevant to this project. For example, you could add a Check Point file, pdf description files, 

project reports and so forth. Note that these ancillary files will be associated with the Cycle, not 

the Project (that is, added to the Cycle file structure). If you are simultaneously archiving this 

project, these ancillary files will be included in the compressed archive.  
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The first time you add Ancillary files to a project, an Ancillary Files folder is created within the 

Cycle folder structure and within your LP360 project. Copies of these files are then placed in 

these folders.   

Best Practice 

Add your checkpoint file to the Ancillary files section of this dialog. This will 
package the checkpoints for future use with this Cycle. Make sure to include the 
Coordinate Reference System of the Check Points if they are not the same as the 
Project.   

If you have used a positioning service such as OPUS to establish the base station 
location, add the OPUS report to the ancillary files as well.   

 

DJI L1/L2 Flight Folders ɀ These folders come straight off the sensor from acquisition and must 

contain the acquired photos (.JPG) and usually contains the .IMU, .CLC, .CLI, .LDR, .RTK, .RTL, 

.RTS files from the flight. If DJI Terra was processed on the same machine doing the import into 

LP360, then the DJI Mission file will typically include the correct folders, otherwise, LP360 will 

prompt you to browse for the raw flight folders that correspond with the missions being 

imported. The sub dialog will display the number of photos for each raw flight folder. 

DJI L1/L2 Terra Processed Folders - These are outputs from the DJI Terra processing. There will be 

many files, but a few are key for continuing the processing in LP360 Drone: 

DJI L1/L2 Terra SBET Folder - Typically the 'lidars' folder found beneath the DJI Terra 

processed output folder and containing one or more sbet.out and smrmsg.out files. 

DJI L1/L2 Terra LAS Folder - Typically the Ȱlidars\terra_lasȱ folder found beneath the DJI Terra 

processed output folder, containing the LAS file(s). Hover over this field to display the tooltip 

with the CRS of the DJI LAS file to ensure the project CRS is selected to match. 

DJI L1/L2 Terra Report Folder - (Optional) Typically the Ȱlidars\reportȱ folder found beneath 

the DJI Terra processed output folder, containing the html or md report files. 

Add to Map ɀ (Not recommended) Select to add the DJI Terra generated LAS as a LAS Layer in 

the project. Note: the LAS data, as created within DJI Terra, is in the v1.2 LAS format and is one 

continuous stream of data. Adding this data may cause confusion later in the workflow. 

Then, press the Next > button at the bottom of the dialog to take you to the Setting Output TrueView 

Project page when importing to a NEW project, or for DJI L1/L2 flights only, the Input DJI L1/L2 Fights 

page with an enabled Finish button, when importing to the CURRENT project. Select Finish to begin 

importing the queued flights. Upon successful completion of the DJI L1/L2 import queue, proceed with 

examining the imported files. 
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INPUT DJI PHANTOM 4 PRO RTK / DJI P1 / M210 RTK / M3E 

If you are unfamiliar, for a P4P-RTK, the data expected from the system for processing in LP360 Drone 

is explained in the Phantom 4 RTK: Downloading Data for PPK Processing in LP360 Drone - GeoCue 

Group post on our searchable support knowledge base.  

Data from the M210 RTK cameras, X4s or X7, and DJI Zenmuse P1 (M300 RTK) are similar to the P4RTK 

but may utilize the PPKRAW.bin and LP360 Drone will generate the OBS file during import of the flight, 

or may directly use the OBS file if it was generated by the system firmware. 

 

Figure 36 - Import Wizard - Input P4P-RTK Flights Page 

 

Figure 37 - Import Wizard - Input DJI P1 Folder Page 

Add DJI Flight Folder ɀ Select to add one or more folders that come straight off the sensor from 

acquisition and must contain the acquired photos (.JPG), observation file (.OBS/.BIN) and timestamp 

(.MRK) files from the flight. 

Remove Flight Folder ɀ Select row(s) from the grid to enable this button to remove one or more flights 

that you no longer wish to import. 

Once a flight folder has been added the grid will display a summary of the detected files for each flight. 

Note: Columns with a pencil  indicate user editable fields. Multi select and right-click to set the same 

https://support.geocue.com/phantom-4-rtk-data-processing-evo/
https://support.geocue.com/phantom-4-rtk-data-processing-evo/
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value for all selected rows. Right-click on a populated field to use that as the default value for the 

selected rows. 

 DJI Observation File ɀ Raw GNSS observation file found in the flight folder. 

 Timestamp (.MRK) File ɀ The timestamp file found in the flight folder. 

Area (Site) name ɀ This is an optional label that can be added when you are segregating a 
0ÒÏÊÅÃÔ ɉÅȢÇȢȟ Ȱ0ÅÁÂÏÄÙ -ÉÎÅ έέȱɊ ÉÎÔÏ ÍÕÌÔÉÐÌÅ ÁÒÅÁÓ ÓÕÃÈ ÁÓ Ȱ0ÉÔ !ÒÅÁȱ ÁÎÄ Ȱ3ÔÏÃËÐÉÌÅ 9ÁÒÄȢȱ  
 

Ancillary Files ɀ This section of the dialog allows you to add any files you would like that are 

relevant to this project. For example, you could add a Check Point file, pdf description files, 

project reports and so forth. Note that these ancillary files will be associated with the Cycle, not 

the Project (that is, added to the Cycle file structure). If you are simultaneously archiving this 

project, these ancillary files will be included in the compressed archive.  

The first time you add Ancillary files to a project, an Ancillary Files folder is created within the 

Cycle folder structure and within your LP360 project. Copies of these files are then placed in 

these folders.   

Best Practice 

Add your checkpoint file to the Ancillary files section of this dialog. This will 
package the checkpoints for future use with this Cycle. Make sure to include the 
Coordinate Reference System of the Check Points if they are not the same as the 
Project.   

If you have used a positioning service such as OPUS to establish the base station 
location, add the OPUS report to the ancillary files as well.   

Then, press the Next > button at the bottom of the dialog to take you to the Base Observation Files 

page. 

INPUT OTHER 

The Other sensor type in the Raw Mission Import Wizard allows for the import of point clouds from 

other sensors that are not specifically listed in the Raw Mission Import Wizard. For Other sensors, the 

ÒÁ× ÄÁÔÁ ÍÕÓÔ ÆÉÒÓÔ ÂÅ ÐÒÏÃÅÓÓÅÄ ÔÈÒÏÕÇÈ ÔÈÅ ÍÁÎÕÆÁÃÔÕÒÅÒȭÓ software to produce LAS files of the point 

cloud and the sensor trajectory solution in one of the supported formats. The resulting LAS and 

trajectory files (.posT, TXT, or SBET) can then be imported into LP360 Drone for post-processing which 

allows for modifications to the already geocoded data. 

To import into LP360, manually select the LAS files and Trajectory Files (Figure 38) produced by the 

ÓÅÎÓÏÒ ÍÁÎÕÆÁÃÔÕÒÅÒȭÓ ÓÏÆÔ×ÁÒÅ. If present in the selected files or known due to the file formats, the 

Coordinate Reference System (CRS) information will auto populate the dropdowns (Figure 38) on the 

Raw Mission Import Wizard ɀ Input Other Mission Flight page for the selected LAS File(s) and sensor 

Trajectory File(s). The sensor trajectory files (.posT and SBET.OUT) will always be in a geographic 

coordinate system and therefore may not match the CRS of the LAS file exactly, depending on whether 
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the LAS files are in a projected or geographic coordinate system. An ASCII text file (.TXT) may either be 

projected or geographic. There does not have to be a correlation of one LAS per sensor trajectory file, 

there could also be one LAS for many SBETs, one LAS to one SBET, or many LAS to one SBET, so long 

as there is coverage in time for the sensor trajectory file(s) for every point in the LAS file(s). The only 

currently supported sensor trajectory ASCII text format (.TXT) is a tab delimited text file with nine 

columns in the order of: Week, GPSTime, UTCTime, Longitude, Latitude, H-Ell, Heading, Pitch, and 

Roll, where H-Ell are ellipsoidal heights. 

 

Figure 38 ɀ Import Wizard - Input Other Sensor Dialog 

Add Mission ɀ Select to add one or more missions to be imported into LP360 Drone.  

Remove Missionɀ Select row(s) from the grid to enable this button to remove one or more flights that 

you no longer wish to import. 

Once a mission has been added, the grid will display a summary of the desired files for each flight. 

Note: Columns with a pencil  indicate user editable fields. Multi select and right-click to set the same 

value for all selected rows. Right-click on a populated field to use that as the default value for the 

selected rows. 

Area (Mission) name ɀ This is an optional label that can be added when you are segregating a 
0ÒÏÊÅÃÔ ɉÅȢÇȢȟ Ȱ0ÅÁÂÏÄÙ -ÉÎÅ έέȱɊ ÉÎÔÏ ÍÕÌÔÉÐÌÅ ÁÒÅÁÓ ÓÕÃÈ ÁÓ Ȱ0ÉÔ !ÒÅÁȱ ÁÎÄ Ȱ3ÔÏÃËÐÉÌÅ 9ÁÒÄȢȱ  
 

Ancillary Files ɀ This section of the dialog allows you to add any files you would like that are 

relevant to this project. For example, you could add a Check Point file, pdf description files, 

project reports and so forth. Note that these ancillary files will be associated with the Cycle, not 
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the Project (that is, added to the Cycle file structure). If you are simultaneously archiving this 

project, these ancillary files will be included in the compressed archive.  

The first time you add Ancillary files to a project, an Ancillary Files folder is created within the 

Cycle folder structure and within your LP360 project. Copies of these files are then placed in 

these folders.   

Then, press the Next > button at the bottom of the dialog to take you to the Setting Output TrueView 

Project page when importing to a NEW project. Select Finish to begin importing the queued flights. 

Upon successful completion of the Other Sensor import queue, proceed with examining the imported 

files. 

ADDING BASE STATION OBSERVATION FILES 

The next page of the dialog allows for the optional input of Base Station Observation files. Note:  If you 

are not using a Single Base strategy (RTK, smartBase or PP-RTX) or wish to add the base observation 

files later during trajectory processing, you can skip this page. 

 

Figure 39 - Base Observation Files Page 

If using a single base strategy and have previously added the Observation files to the Cycle\System 

folder, these files will appear in the dialog. If you have not previously loaded this file (or files), press the 

ÇÒÅÅÎ Ȱ+ȱ ËÅÙ ÔÏ ÁÄÄ ÔÈÅ ÒÅÑÕÉÒÅÄ ÆÉÌÅÓȢ )Æ ÙÏÕ ÉÎÁÄÖÅÒÔÅÎÔÌÙ ÁÄÄ Á ÆÉÌÅ ÔÈÁÔ ÉÓ ÎÏÔ ÐÁÒÔ ÏÆ ÔÈÅ #ÙÃÌÅȾ&ÌÉÇÈÔÓ 

ÂÅÉÎÇ ÉÍÐÏÒÔÅÄȟ ÓÅÌÅÃÔ ÉÔ ÉÎ ÔÈÅ ÆÉÌÅ ÌÉÓÔ ÁÎÄ ÐÒÅÓÓ ÔÈÅ ÒÅÄ Ȱ-ȱ ÂÕÔÔÏÎ ÔÏ ÒÅÍÏÖÅ ÉÔ ÆÒÏÍ ÃÏÎÓÉÄÅÒÁÔÉÏÎȢ 

Note the file will not be deleted from the source; it will simply be removed from this list. LP360 will auto 

correlate the base observation files with the applicable flights and remove the rest before presenting 

the Flight/Base Positioning page. 
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 Note: RINEX observations, v2.10 to 3.05, are supported. Version 3.05 is recommended. Trimble T02 

files are supported for POSPac processing workflows and the DJI PPK Utility. 

Base Antenna Calibration File  

During GNSS processing the antenna type must be known for the processing software to apply the 

proper antenna phase center (APC) to antenna reference point (ARP) offsets. LP360 Drone will 

automatically read the antenna model, if present, from the base RINEX file and display it black in the 

dialog if the antenna is a known type for which it has the antennae calibration. If the antenna model is 

unknown or not stipulated in the RINEX file, or no antenna calibration exists for the specified model 

then the antenna model will display in red (Figure 40). Hovering over the antenna model will provide a 

ÔÏÏÌÔÉÐ ×ÉÔÈ ÔÈÅ ÅØÐÌÁÎÁÔÉÏÎȟ Ȱ7ÁÒÎÉÎÇȡ .'3 ÃÁÌÉÂÒÁÔÉÏÎ ÆÏÒ ÁÎÔÅÎÎÁ ÍÏÄÅÌ ɉ5ÎËÎÏ×ÎɊ ÎÏÔ ÆÏÕÎÄȢ 

Verify the correct antenna model is listed in the base observation file. If you have a newer model 

antenna it mÁÙ ÎÅÅÄ ÔÏ ÂÅ ÁÄÄÅÄ ÔÏ ÏÕÒ ÄÁÔÁÂÁÓÅȟ ÃÏÎÔÁÃÔ ȬÓÕÐÐÏÒÔΆÇÅÏÃÕÅȢÃÏÍȭȢ 0ÒÏÃÅÅÄÉÎÇ ×ÉÔÈ 

processing as is will result in no APC to ARP offsets applied, which is not normally desired, however, is 

ÁÃÃÅÐÔÁÂÌÅ ÉÎ ÓÏÍÅ ÃÉÒÃÕÍÓÔÁÎÃÅÓȢȱ 

Proceeding without a recognized antenna model will prompt for a confirmation when processing the 

trajectory solution. An example of when it may be okay to proceed with an unknown antenna model or 

missing antenna calibration would be if the reference mark was processed to the antenna phase center 

(APC) instead of an antenna reference point (ARP). 

 

Figure 40 - NGS Antenna Calibration Not Found 

Then, press the Next > button at the bottom of the dialog to take you to the LP360 Drone Project Page 

when importing to a NEW project, or the Flight/Base Positioning Page, when importing to the 

CURRENT project. 

SETTING TRUEVIEW PROJECT, COORDINATE REFERENCE SYSTEM AND EPOCH 

If creating a new TrueView Project during the import (i.e., you are not running this wizard from within 

an existing TrueView Project), you will be presented the dialog of Figure 41. Browse to the top-level 

folder where you would like the TrueView Project folder to be created. There is a Default Projects Root 

Folder setting on the File -> Project Settings -> Project tab if you would always like your projects 

Best Practice 

Put your base station RINEX files to the Cycle\System folder on the USB so it will be 

automatically detected by the Import Cycle Wizard. 
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ÃÒÅÁÔÅÄ ÉÎ ÔÈÅ ÓÁÍÅ ÌÏÃÁÔÉÏÎ ɉÒÅÃÏÍÍÅÎÄÅÄɊȢ 5ÎÄÅÒ ÔÈÅ Ȱ4ÒÕÅ6ÉÅ× /ÕÔÐÕÔ 0ÒÏÊÅÃÔ .ÁÍÅȱȟ ÔÙÐÅ ÉÎ ÔÈÅ 

name of your new project. You will receive an error message if a Project of that name already exists in 

the selected project folder. If this occurs, choose a different project name (or location). 

 

Figure 41 ɀ Output TrueView Project Information (Left: 3DIS, Right: DJI L1/L2) 

If running the Wizard from within an existing TrueView Project, the Cycle being imported will be added 

to this project (which, of course, is already named), hence the import Wizard will skip this step. 

In the lower section of the dialog, set the Coordinate Reference System (CRS) that will be used for the 

project by selecting from the Recent Coordinate Reference System list or by selecting the  to 

open the Select Project Coordinate Reference System dialog (Figure 42). Remove an item from the 

Most Recent Used list by selecting the item to delete and pressing the  tool. The suggested UTM 

zone is provided to assist users processing to UTM, but unsure of in which zone the data resides. 

Note:  If you are adding a Cycle/Flight to an existing project, this section of the dialog will show the 

current project CRS but will not allow you to change it (you can change a project CRS via other 

LP360 tools). 
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Figure 42 - Select Project Coordinate Reference System 

The project epoch is set when the project CRS is selected if one is known for the datum of the selected 

project CRS. It can be verified (File -> Project Settings -> Project -> Project Epoch) and modified after 

Import Cycle has completed. Use the decimal year of the Cycle Date for coordinate reference systems 

using variable ellipsoid and variable epoch, such as the WGS84 datum, otherwise select enter the 

applicable epoch for the datum of your coordinate reference system. For example, NAD83(2011) has a 

fixed ellipsoid and variable epoch date of 2010.0. Typically, the epoch date for your project datum 

should be selected by default. 

DJI Terra Processed L1/L2 Data ɀ This section appears for projects being created by importing a DJI 

L1/L2 Cycle to allow the user to specify how the DJI Terra processing was performed. 

L1/L2 Coordinate Reference System (CRS) ɀ LP360 needs to know the CRS that was selected 

when processing in DJI Terra and provides one of two options: 

Same as Project CRS ɀ If ÙÏÕȭÒÅ happy with the way DJI Terra is positioning the data in 

your desired CRS, then select this option and select the matching CRS for your project, 

both horizontal and vertical, as you selected for processing in DJI Terra. 

ITRF2014 (EPSG:9000), ellipsoidal heights ɀ Coordinate systems vary greatly in how 

one program or another implements them. To best support the wide variety of CRS 

around the world, we recommend that users select EPSG:9000 with ellipsoidal heights 

for processing in DJI Terra, then allow LP360ȭÓ #23 ÈÁÎÄÌÅÒ ÔÏ ÈÁÎÄÌÅ ÔÈÅ ÄÁÔÕÍ ÁÎÄ 

ÅÐÏÃÈ ÔÒÁÎÓÆÏÒÍÁÔÉÏÎÓ ÁÎÄ ÒÅÐÒÏÊÅÃÔÉÏÎ ÔÏ ÔÈÅ ÕÓÅÒȭÓ ÄÅÓÉÒÅÄ ÐÒÏÊÅÃÔ CRS. 

The L1/L2 epoch needs to be set when EPSG:9000 is selected for the L1/L2 CRS. 

The epoch must correspond with the epoch of the position used for the base 

station when using PPK or of the RTK correction network. 

For example, if you used OPUS and the ITRF coordinate, then use the decimal 

year of the Cycle Date or mean Cycle Dates if all were flown in a fairly short 
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period of time. If you used an ETRS89 coordinate, then the epoch is 1989.0, or if 

you used NAD83(2011) it would be 2010.0, or if you used GDA2020, then epoch 

2020.0, or if your base coordinate is GDA94, then epoch 1994.0. 

When you have finished, press the Next > button to be taken to the Output Archive Folder page if one 

of the import options that archives was selected, or the Flight/Base Positioning page otherwise. If the 

import data is DJI L1/L2, press the Next > button to be taken to the Input DJI L1/L2 Fights page with an 

enabled Finish button which can be used to begin the import of the queued flights. 

SETTING THE ARCHIVE LOCATION 

If you chose one of the import options that archives, the next page of the dialog is used to select the 

Archive location where you would like to store a compressed copy of this Cycle. To select the Archive 

where you would like a compressed copy of this Cycle stored, select a row in the Available Archives list 

(Figure 43). TrueView Archives must be added in the TrueView Archive Manager prior to running the 

Import Wizard or you will not have any archives from which to choose. Use the Compute Size button to 

see how much disk space is currently being used by each archive. 

 

Figure 43 - Selecting an Archive 

After selecting the Archive, the Next > button at the bottom of the dialog will enable and take you to 

the Flight / Base Positioning page.   

SETTING THE FLIGHT/BASE POSITIONING 

The Flight / Base Positioning page of the multi-Cycle Import Wizard will display a grid of the flights 

queued to be imported and the base observation files that have been autocorrelated with them. Review 

the information and set the reference mark to be used later with the post processing wizard, if 

applicable for your workflow. This can also be skipped at this stage and set later during the post 

processing wizard. 
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Note: Columns with a pencil  indicate user editable fields. Multi select and right-click to set the same 

value for all selected rows. Right-click on a populated field to use that as the default value for the 

selected rows. See Set base station reference mark for multiple Cycles for an example. 

 

Figure 44 ɀ Flight / Base Positioning 

Import Message ɀ Will provide information on the status of the Cycle/Flight import. The column to its 

left will indicate the import status with an icon for queued, processing, complete or error once the 

import processing has begun. 

REFERENCE MARK/BASE STATION LOCATION 

This column allows you to set the reference mark/survey nail for the Base Station location during 

import or skip this assignment and set it later during the post process wizard. Select the name of an 

existing survey nail from the list or select [Survey Nail] to open the Survey Nail Manager and add a new 

Survey Nail. Once selected from the list or from the Survey Nail Manager, the Base Station 

Location/Frame/Epoch/Ellipsoid information will appear in the applicable columns of the dialog for the 

applicable row. The dropdown list is sorted by distance from the average position found in the base 

station RINEX file. 

Base Antenna Height 

The base antenna height will be populated automatically if present and can be ready from the base 

observation file. Make sure to review and modify if necessary to set the applicable base station antenna 

height or skip at this time and set it later during the post process wizard. The antenna height is the 

height in meters from the monument to the antenna reference point (ARP). Phase center offsets should 

not be added to the antenna height unless the base antenna model was not written to the header and 

recognized on the Base Station Observation Files page. 

A red Survey Nail in this column indicates the distance from the Survey Nail to the 

approximate location found in the base observation file is greater than 10 meters, and you 

should verify the information as displayed in the Location is correct. Over 50m will typically 

fail when processing the sensor trajectory. Values in between are okay if you have verified 

the survey nail location to be correct.  

https://support.geocue.com/true-view-base-station-reference-mark
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The Finish button at the bottom of the dialog will enable. Press this to begin the import process for the 

queue Cycles/Flights. The first column and the message column will indicate the import status with an 

icon for queued, processing, complete or error once the import processing has begun. Upon successful 

completion of the import queue, proceed with examining the imported files.  
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EXAMINING IMPORTED FILES 

After the import is complete, the flight files will be displayed in the map view of LP360 Drone. A 

WMS layer will be displayed behind the data so the user can see approximately where flight path 

occurred (Figure 45). The white box on the left side of Figure 45 is the Table of Contents (TOC), the 

map area on the right is referred to as the Map View. Each layer in the TOC is named after the Cycle 

date and time, with a name appended to the end that represents the type of information contained 

in the layer and prepended by the Area Name (Area_Name_Cycle_Flight). A layer can be selected 

by left clicking on the desired layer until it is highlighted. Once selected, right-click the layer and 

select Feature Analyst to open the Feature Analyst dialog (Figure 46) to review the attributes of 

features on the layer. 

 

Figure 45 ɀ TOC and Map View 

a) Photos Layer ɀ This layer contains information about each photo and photos can be 

viewed in Feature Analyst. The icons in the Map View represent the location each photo 

was taken, using the navigation grade solution (real-time) of the TrueView Position and 

Orientation System (POS). If your sensor has multiple cameras, you will see an icon for 

each photo from each camera. Thus, if you zoom in on the display, you will usually see 

photo icons close together. This occurs because TrueView sensors with multiple 

cameras usually fire the cameras at approximately the same time. You can quickly 

inspect information about any feature ÉÎ ,0ΩάΦ ÂÙ ÓÅÌÅÃÔÉÎÇ ÔÈÅ )ÎÆÏ ÔÏÏÌ ɉÔÈÅ Ȱ)ȱ ÉÃÏÎ ÏÎ 

the main toolbar), left clicking the item you wish to inspect and viewing the attribute 

data in the Info pane of the TOC. This is illustrated for a photo in Figure 47.  

b) Trajectory Points Layer ɀ TrueView and microdrones sensors collect a location point 

every second based on the real-time navigation position information from the Position 

and Orientation System. You can select a Trajectory Point with the info tool to show 

metadata such as location and height in the info pane of the TOC. These points can be 

used to Manually Create Flight Lines.  

c) Log Points Layer ɀ TrueView and microdrones Sensors collect information about the 

status of operations throughout the flight. This log file is a simple text file stored within 

the Cycle directory. You can examine the entire log by right clicking the LogPoints layer 

in the table of contents and selecting Feature Analyst. Like all data in Feature Analyst, 
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you can drive the log to a specific entry by selecting a point in the Map View. Each entry 

within this file has a time tag. During import of a Cycle, the log file is correlated with the 

Trajectory Points data and spatially displayed as a layer in the TOC. The log file can 

provide valuable insight into sensor operations (voltages, temperatures) as well as 

diagnostics when something goes wrong. This layer will not be created for DJI and 

Other systems. The Log Points layer is turned off by default for performance reasons as 

they typically have a very large number of features on them. 

d) Trajectory Line Layer ɀ Shows the real-time trajectory from the beginning to the end 

of the Cycle.  

e) WMS Layer ɀ A WMS backdrop layer, such as Google Hybrid or Bing Aerial with Labels, 

allows the user to check the flight for coverage and rough location. 

f) Layer toggle On/Off ɀ Each layer can be toggled on/off and viewed independently by 

toggling the checkbox next to the layer.  

g) Layer in Map ɀ Each layer is plotted on the map view as shown in (Figure 45) in the 

order they are listed, from top to bottom, in the TOC. 

 

Figure 46 ɀ Feature Analyst 

 

Figure 47 - Inspecting a Feature 
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Repeat the TrueView Import Wizard to add more flights to the same project. After the data has been 

imported and the files have been examined, follow the applicable workflow for your data type(s): 

¶ TrueView 3DIS® Processing Workflow 

¶ Wingtra LiDAR and Other Workflow 

¶ DJI Zenmuse L1/L2 Processing Workflow 

¶ TrueView 2DIS and DJI-RTK Processing Workflow 

 

SINGLE CYCLE MODE 

Enabling Single Cycle Mode  (Figure 26) will display layers relevant to the Active Cycle making for 

efficient review of the layers for each imported Cycle/Mission. The Single Cycle Mode is a shortcut 

configuration for the standard Use mode in Project Manager where, layers are live and you can 

modify the display by changing the layers listed in the Table of Contents. Members of the active Cycle 

display group are configured automatically during Cycle Import but may be modified by using the 

Groups -> Build mode (Figure 48) on the Groups/Layers tab of Project Manager . The build mode 

allows one to set up new groups, edit existing groups, and delete groups you no longer need. You can 

also automatically create groups based on unique cycle or temporal data. Use the Refresh button to 

update the Table of Contents to see any changes you have made. In build mode, select the group to 

modify on the left, then layers can be configured as Visible, Member, Base, and/or ImageExplorer. 

Visible ɀ The layer is enabled in the TOC and visible in the map view when the view group is 

selected when in the Use mode. 

Member ɀ The layer is part of the selected group and displayed on the TOC when the view 

group is selected when in the Use mode. 

Base ɀ Denotes the layer is a base layer, such as a WMS layer. 

Image Explorer ɀ Denotes the layer is suitable for use by Image Explorer. LP360 disables the 

photo layer when it creates the Retained Photos layer to remove the photos in turns and 

takeoff and landing from being displayed in Image Explorer. 

 

Figure 48 - Build Mode in the Groups/Layers tab of Project Manager 

https://support.geocue.com/LP360WebHelp/index.htm#t=Contents%2FProject_Manager.htm
https://support.geocue.com/LP360WebHelp/index.htm#t=Contents%2FProject_Manager.htm
https://support.geocue.com/LP360WebHelp/index.htm#t=Contents%2FImage_Viewer.htm
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PILOT LOGS 

LP360 has the capability to view the Pilot Log from imported TrueView Cycles. These logs can be 

created by the pilot in the field using the TrueView Web UI. The Pilot Log is stored in the System folder 

of the raw Cycle. As the pilot log is a text file, it can also be created manually after importing the Cycle 

ÉÎÔÏ ,0ΩάΦȢ 4ÈÅ ÆÉÌÅ ÍÕÓÔ ÈÁÖÅ Ȱ0ÉÌÏÔ,ÏÇȱ ÉÎ ÔÈÅ ÎÁÍÅ ÁÎÄ ÓÔÏÒÅÄ ÉÎ ÔÈÅ 0ÒÏÊÅÃÔ\Area\Cycle\System 

folder for it to be recognized by LP360.   

 

Figure 49 - Pilot Log View Tool 

https://support.geocue.com/trueview-web-ui/
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TRUEVIEW 3DIS® PROCESSING WORKFLOW 

This section provides a step-by-step guide to processing TrueView 3D Imaging System (3DIS®) data 

from the point of project creation to a colorized point cloud, exporting a photo package for 

downstream processing, or generating an orthomosaic. For dual purpose 3DIS, considerations for 

mobile Cycles are generally noted in textboxes where applicable. 

For the new TrueView 540 by CHCNAV LiDAR payload, there is no USB, so the Cycle data must be 

copied from the payload to your local drive using the TV540 Data Copy tool  found in the Utilities 

group on the Sensor tab of the ribbon.  

To import TrueView and supported microdrones Cycle data from the USB mounted in the system 

during acquisition into a new or current project, open the Raw Mission Import Wizard  and select 

TrueView/Microdrones as the sensor.  

TV540 DATA COPY 

For the new TrueView 540 by CHCNAV LiDAR payload, there is no USB, so the Cycle data must be 

copied from the payload to your local drive using the TV540 Data Copy tool  found in the Utilities 

group on the Sensor tab of the ribbon. The TV540 Data Copy tool is used to retrieve data as well as 

format the sensor storage. To download data, the sensor must be connected to a workstation using the 

provided USB-C to USB-A cable. 

1. Connect the sensor to a workstation using the USB-C to USB-A cable.  
2. Open LP360 with elevated permissions by using right-click and ȰRun as AdministratorȱȢ  

Note: This is a current requirement to run the DataCopy tool . All other functions may be 
run with LP360 launch normally. We are working to remove this impediment as soon as 
possible. 

3. Go to the Sensor Ÿ Utilities Ÿ TV540 Data Copy .  
4. Follow the steps and save the Cycles in a local HD.  
5. Organize the Cycles (flights) in a single folder.  
6. Add the base station file (RINEX format) and the coordinates of the base station in 

WGS84/ITRF2014 Latitude, Longitude and Ellipsoidal height.  

5. Now the data is ready to be delivered to GeoCue using the Upload to Support  tool found 
on the Support tab in LP360. 

3. Open LP360.  
4. Support Ÿ Upload to support Ÿ Select the folder containing all the Cycles for a project 
area and upload it.  
5. Wait for the upload to finish (you will receive an email notification).  
6. 3ÅÎÄ ÁÎ ÅÍÁÉÌ ÔÏ ȰÓÕÐÐÏÒÔΆÇÅÏÃÕÅȢÃÏmȱ, include in the email if photogrammetry is 
needed (orthomosaic), and if required, please specify the Coordinate Reference System 
(CRS) for the LAS and orthomosaic.   

Then, the trajectory processing and initial point cloud generation from the raw data is performed by 

GeoCue as a pre-processing step before beginning the workflow in LP360 Drone until LP360 v2024.2 is 

available for users. Coming soon! 

https://geocue.com/sensors/drone-lidar/trueview-540/
https://geocue.com/sensors/drone-lidar/trueview-540/
https://support.geocue.com/new-upload-to-support-feature-for-quickly-sharing-files/
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TRAJECTORY PROCESSING WIZARD 

After the data has been imported and the files have been examined, the next step is to correct and fuse 

the GNSS and inertial data by running the tightly integrated Applanix POSPacCloud (Cloud), or POSPac 

UAV (local). The sensor Trajectory Processing tool will launch the applicable processing wizard, to walk 

you through the inputs needed to create the sensor trajectory, a single text file with the corrected 

position and orientation of the entire flight, along with a QC Report. 

1. On the Sensor tab (Figure 50), make active the Cycle/Flight combination to be processed. 

 

2. Open the POSPac Processing Wizard dialog by selecting the sensor Trajectory Processing  

button on the Sensor tab (Figure 50). 

 

Figure 50 ɀ POSPac Processing Wizard 

PROCESSING SETTINGS SELECTION 

3. The POSPac Processing Wizard dialog (Figure 51) should now be opened to the first page, 

which is where the user will select the file to be processed, and how it will be processed. The 

first time you open this page for a Cycle it may take a moment as LP360 Drone analyses the raw 

position file. The bullets below explain the settings for the POSPac Processing Wizard dialog 

(Figure 51). 

Enabling Single Cycle Mode  (Figure 26) displays layers relevant to the Active 

Cycle making for efficient viewing of the layers for the Active Cycle. 
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Figure 51 ɀ Input Settings Page 

a) Cycle Name ɀ The Active Cycle for which to process the trajectory. 

b) Raw Position File ɀ This shows the path to the T04 file contained in the cycle that was 

selected in step A. Each cycle will have a different T04 file. 

c) Override APX Mounting Parameters File ɀ The default antenna offsets (lever arms) 

and orientation for the APX are loaded into the APX firmware during 

manufacturing. These can also be manually changed in the field via a process where 

one logs into the APX via Wi-Fi as described in the hardware users guide for your 

TrueView model. This field on the POSPac processing wizard allows a user to 

browse to a JSON file that defines one or both of these 3-tuples to override the APX 

values when processing. 
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The format of the JSON file is:  
{  
"IMUMountingAngles": {  
"Override": "false",  
"RefToIMUMountingAnglX": "0.0",  
"RefToIMUMountingAnglY": "0.0",  
"RefToIMUMountingAnglZ": "0.0"  
},  
"LeverArm": {  
"Override": "false",  
"PriGNSSLeverX": "0.0",  
"PriGNSSLeverY": "0.0",  
"PriGNSSLeverZ": "0.0"  
 },  
"VehicleToRef": {  
"Override": "false",  
"VehicleToRefAnglX": "0.0",  
"VehicleToRefAnglY": "0.0",  
"VehicleToRefAnglZ": "0.0"  
 }  

} 

NOTE ɀ This should only be used when there is a configuration error with the APX. 

For TrueView 620, 640, 660, 680 or 720 use ȰRefToRemoteIMUMountingAngl*ȱ 

instead of ȰRefToIMUMountingAnglɕȱ. 3ÅÔ ÔÈÅ ÏÖÅÒÒÉÄÅ ÔÏ ȰÔÒÕÅȱ ÆÏÒ ÔÈÅ ÄÅÓÉÒÅÄ 

section(s). 

d) Processing Range - Override Range ɀ Enable Override Range to manually set the 

start/end processing times in GPS week seconds instead of using those which were 

automatically determined from the kinematic motion of the sensor trajectory. Override 

Range is useful when there are data gaps around the time of takeoff. Generate a real-

time POSPac QC report to see the full trajectory information and determine alternate 

start and end times. 

e) POSPac Processing Mode ɀ Choose the processing method to be used to correct your 

GNSS and inertial data.  

i. QC Only (Realtime) ɀ A no charge means to generate a QC Report PDF and 

realtime sensor trajectory for the rover for infield QC checks of your data. 

ii. Single Base ($) ɀ Uses the RINEX file recorded from a single base station. No 

cost for Traditional or rental business models. 

iii. Smart Base ($$) ɀ Uses the SmartBase network from Applanix. 

iv. PP-RTX ($$$) ɀ Uses the PP-RTX solution from Applanix. This is the least 

accurate option and should be used only if single base and SmartBase cannot 

be used. 

https://support.geocue.com/true-view-3dis-field-data-checking-methods/#:~:text=Process%20your%20QC%2DOnly%20(realtime)%20sensor%20trajectory%20with%20the%20POSPac%20CLI%20QC%20Utility%20or%20post%20process%20your%20sensor%20trajectory
https://support.geocue.com/true-view-3dis-field-data-checking-methods/#:~:text=Process%20your%20QC%2DOnly%20(realtime)%20sensor%20trajectory%20with%20the%20POSPac%20CLI%20QC%20Utility%20or%20post%20process%20your%20sensor%20trajectory
https://support.geocue.com/single-base-vs-smartbase-vs-pp-rtx/
https://support.geocue.com/true-view-3dis-field-data-checking-methods
https://support.geocue.com/applanix-smartbase/
https://support.geocue.com/applanix-pp-rtx/
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f) POSPac Run Location ɀ Select to process Local or Cloud by selecting the applicable 

radio button next to the option. If the POSPac Processing Mode is set to SmartBase or 

PP-RTX, then Cloud is the only option that can be used. 

g) GNSS Settings ɀ Normally set to process using all available constellations but can be 

toggled to process using GPS only if one of the other constellations is causing noise in 

the solution. 

h) Cycle Summary ɀ Contains information about the sensor and the Cycle start/end time. 

The TrueView account balance will be displayed, if enabled, along with the estimated 

cost to process this cycle using the selected method. Ȱ$ÕÐÌÉÃÁÔÅ 4ÁÓËȱ ×ÉÌÌ ÂÅ ÓÈÏ×Î ÉÆ 

the process has already been run successfully on this data before using the same 

method and indicates no additional points will be charged. Ȱ.Ï #ÏÓÔȱ ×ÉÌÌ ÂÅ ÓÈÏ×Î ÉÆ 

the process is included in your business model, no points will be charged. 

 

4. Select Next to move to the next page of the dialog. If using single base as the processing mode, 

the next page will be the base station input page (Figure 52). If using Smart base or PP-RTX, the 

next page will be the Trajectory Output Settings. 

BASE STATION SETTINGS 

5. The Base Station Input  page only appears when processing using the single base option. The 

bullets below correspond to Figure 52. 

Base Station Observation File(s) ɀ This field should be populated automatically if the base station 

RINEX file(s) was imported during the TrueView multi-Cycle Import wizard step. If not, it can be 

imported here by selecting  to the right of the grid. If the Antenna type was written to the RINEX 

header, it will automatically be recognized and displayed in this box. If not present, the RINEX file 

should be edited to include the information and added anew. 

An online account login is only applicable if the POSPac Run location is set to Cloud 

since LP360 Drone communicates with LP360 Online ÔÏ ÍÁÎÁÇÅ ÙÏÕÒ ÁÃÃÏÕÎÔȭÓ 0ÏÉÎÔ 

balance. During the sensor Trajectory Processing step, you must be logged into your 

online account to process using POSPac with the run location, Cloud. 
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Figure 52 ɀ Base Station Settings 

a) Base Antenna Calibration File ɀ During GNSS processing, whether local in LP360 

Drone for 2DIS, in POSPac desktop, or using POSPacCloud, the antenna type must be 

known for the software to apply the proper antenna phase center (APC) to antenna 

reference point (ARP) offsets. LP360 Drone will automatically read the antenna model, 

if present, from the base RINEX file and display it black in the dialog if the antenna is a 

known type for which it has the antennae calibration. If the antenna model is unknown 

or not stipulated in the RINEX file, or no antenna calibration exists for the specified 

model then the antenna model will display in red (Figure 53). Hovering over the antenna 

ÍÏÄÅÌ ×ÉÌÌ ÐÒÏÖÉÄÅ Á ÔÏÏÌÔÉÐ ×ÉÔÈ ÔÈÅ ÅØÐÌÁÎÁÔÉÏÎȟ Ȱ7ÁÒÎÉÎÇȡ .'3 ÃÁÌÉÂÒÁÔÉÏÎ ÆÏÒ 

antenna model (Unknown) not found. Verify the correct antenna model is listed in the 

base observation file. If you have a newer model antenna it may need to be added to 

ÏÕÒ ÄÁÔÁÂÁÓÅȟ ÃÏÎÔÁÃÔ ȬÓÕÐÐÏÒÔΆÇÅÏÃÕÅȢÃÏÍȭȢ 0ÒÏÃÅÅÄÉÎÇ ×ÉÔÈ ÐÒÏÃÅÓÓÉÎÇ ÁÓ ÉÓ ×ÉÌÌ 

result in no APC to ARP offsets applied, which is not normally desired, however, is 

ÁÃÃÅÐÔÁÂÌÅ ÉÎ ÓÏÍÅ ÃÉÒÃÕÍÓÔÁÎÃÅÓȢȱ 

Proceeding without a recognized antenna model will prompt for a confirmation when 

processing the trajectory solution. An example of when it may be okay to proceed with 

an unknown antenna model or missing antenna calibration would be if the reference 

mark was processed to the antenna phase center (APC) instead of the antenna 

reference point (ARP). 
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Figure 53 - NGS Antenna Calibration Not Found 

b) Base Station Location 

i. Location from ɀ The base station location may be preset if the base station was 

setup over a known survey nail / reference mark or can be computed during 

POSPac processing using Trimble CenterPoint RTX. 

1. Trimble CenterPoint RTX ɀ Selecting this option will disable the 

location and frame portions of the dialog as those will be determined 

using the Trimble CenterPoint RTX post-processing service. Trimble 

RTX© is a global GNSS technology that provides centimeter-level 

positioning, worldwide, at any time. The CenterPoint RTX post-

processing service supports dual frequency GNSS receivers. Antennas 

must be on the Supported Antennas list. The post-processing service 

will not process unsupported antennas. See also: Supported Antennas 

Base Station Observation files must meet the following requirements: 

¶ Data formats accepted include Trimble proprietary data 

formats (e.g., DAT, T01, T02, T04, Quark) and the standard 

RINEX 2 and RINEX 3 data formats. 

¶ For optimal processing results, it is recommended to provide at 

least 60 minutes of observations. 

¶ Data files cannot exceed 24 hours in length. 

¶ Data files must be static only. 

¶ Data files must contain dual frequency pseudorange and carrier 

phase observations (L1 and L2). 

¶ Data must have been collected after 14 May 2011. 

 

2.  Survey Nail/Reference Mark ɀ If properly selected during the Cycle 

Import Wizard this information will already be set. Otherwise, select 

the name of an existing survey nail from the list or select the nail icon 

 to open the Survey Nail Manager, and add a new Survey Nail. Note: 

The dropdown list is sorted by distance from the average position 

found in the base station RINEX file. 

https://trimblertx.com/Home.aspx
https://trimblertx.com/SupportedDevices.aspx
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Figure 54 - Base Station Location Warning 

 

c) Settings: Antenna Height - Enter the base antenna height from the measured mark to 

the Antenna Reference Point (ARP). Phase center offsets should not be added to the 

antenna height unless the base antenna model was not written to the header and 

recognized in Base Station Observation section (Figure 53). 

d) Location ɀ Once a survey nail is selected from the list or from the Survey Nail Manager, 

the Base Station Location information will appear in the dialog.  

e) Frame ɀ Once selected from the list or from the Survey Nail Manager, the Base Station 

Frame, epoch, and ellipsoid will appear in the dialog.  

i. Settings: Use Plate Model Velocity ɀ Plate Model Velocity calculations can be 

omitted by unchecking the box, if desired. If selected, POSPac uses the 

ITRF2008 plate velocity model for user provided single base and PP-RTX 

processing, or HTDP for stations from the Applanix database - only used in 

LP360 Drone for smartBase processing. When used, a 14-parameter model is 

used to go between the user defined frame and ITRF00, in which POSPac does 

all the trajectory processing. Use plate model velocity to transform  between 

epochs. 

f) Select Next > to move to the Processing Confirmation page. 

PROCESSING CONFIRMATION 

6. The Processing Confirmation page contains information about the sensor and processing 

times. The bullets below correspond to Figure 55. 

a) Review Current Settings ɀ Contains information about the hardware, software, and 

cost estimates. 

b) Results ɀ After trajectory processing is completed successfully, contains information 

about the results of the processing, including the actual cost, if applicable.  

A message appears on the page to indicate the distance from the Survey Nail to the 

approximate location found in the base observation file header. If this distance is greater 

than 10 meters, the message shows in red, and you should verify the information as displayed 

in the Location is correct. Over 50m will typically fail when processing the sensor trajectory. 

Values in between are okay if you have verified the survey nail location to be correct.  



LP360 Drone Users Guide 
 

65 LP360 Drone v2024.1.30.0   4/30/2024 

 

Figure 55 ɀ Processing Confirmation 

7. Select Submit when ready to submit the data for processing.  

8. If during the validation for submittal check, the antenna model is unknown or was not 

stipulated in the RINEX file, or no antenna calibration exists for the specified model, the user 

will be prompted to acknowledge the missing antenna calibration before continuing with the 

task submission to ensure she desires to proceed with this information missing. 

 

Figure 56 - Missing Antenna Calibration Confirmation 

9. You will then be prompted with a message asking you to confirm the submission. Click Ok.  

 

Figure 57 - Run POSPac Confirmation 

10. A successfully submitted job notification will appear confirming the job submission (Figure 58). 
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Figure 58 - Post Process Trajectory Job Submitted 

11. The Post Process Trajectory (PPT) job progress may be monitored using Job Manager .  

12. Upon completion of the PPT job by the Job Manager : 

a) Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   

b) The job will need to be post-processed to view the resulting POSPac report and/or log 

file. 

13. If desired, or for troubleshooting, in Job Manager , select the applicable PPT job, then select 

View Log to review the PPT processing log for POSPac Troubleshooting.  

14. In Job Manager , select the applicable PPT job, then select Open Project to open the 

applicable project for the job, if not currently open. 

15. Then, select Post-Process to review the POSPac Report. 

16. When desired, in Job Manager , select the applicable PPT job, then select Delete Job to 

clean up the temporary files generated while processing the job. 

POSPAC REPORT REVIEW 

1. When prompted to view the POSPac report, select Yes to view the report, or No to move to the 

next step. You may reopen the POSPac report at any time by selecting  on the Sensor tab. 

There are several plots that one should review to ensure a viable trajectory solution before 

moving on to additional processing steps: 

o Rover Data Summary 

Á Start/End time meets expectations. 

Á Start of fine alignment is within a minute or two of takeoff. 

o Rover Data QC 

Á Primary Observables & Satellite Data 

¶ GPS/GLONASS L2 Satellite Lock/Elevation 

o Review this plot to ensure ephemeris information is available 

for all satellites for the entire length of the Cycle.  

o Review this plot to ensure there are not many Cycle slips or 

data gaps throughout the Cycle. 

¶ GPS L2 SNR 

o Review this plot for gaps or less than four satellites above 30. 
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¶ GLONASS L2 SNR 

o Review this plot for gaps or less than four satellites above 30. 

o Smoothed Trajectory Information 

Á Top View 

¶ Review the top down path of the trajectory solution and compare to the 

flight plan and the Cycle position feature files created during the 

TrueView Cycle Import. 

Á Altitude  

¶ Review the profile path of the trajectory solution and compare to 

expectations. 

o Base Station Information 

Á Ensure the base antenna manufacturer and model is properly read from the 

RINEX file. Fix in the RINEX file if it says Unknown. 

Á Verify the correct antenna height was used. 

Á Verify the correct base station coordinate was used. 

Á The Frame, Epoch and Ellipsoid should match that of the survey nail. For 

instance, a point from an OPUS solution should be Frame: NAD83_2011, Epoch: 

2010, Ellipsoid: GRS_1980 

o GNSS QC 

Á GNSS QC Statistics 

¶ Look for a 100% fixed solution, minimum four satellites (preferably 

many more) and a maximum PDOP less than 3. 

Á Forward/Reverse Separation 

¶ Ideal 1-2cm in Easting/Northing and less than 5cm in down for single 

base processing. 

Á PDOP 

¶ Ideally well less than three across the board 

o GNSS-Inertial Processor Configuration 

Á Verify the correct GNSS lever arm and mounting angles were used for your 

3DIS® and drone configuration. 

o Smoothed Performance Metrics 

Á Position Error RMS (m) 

¶ Ideal 1-2cm in Easting/Northing and less than 5cm in down for single 

base processing. 

o Forward Processed Solution Status 

Á Processing Mode 

¶ Should be zero (Fixed NL) across the board. May have some portion at 

the very beginning/end that loses lock for forward and/or reverse. 

Á Baseline Length 

¶ Shows the 3D distance between the base station and the TrueView 

throughout the Cycle. Ensure it falls within expectation. Review the 

Base Station Location used for processing if it does not. 

o Export Summary 
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Á Output Units (Coordinate) should be in the units of your project. 

Á Height option, Grid, Zone, Datum, Ellipsoid and Target Epoch must match that 

of your LP360 Drone project CRS. 

 

Figure 59 - POSPac Processing Offset 

2. The results of this process will be corrected position and orientation, which will be saved in an 

SBET file located in the POS folder under the LP360 project and Cycle folder. 
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POSPAC TROUBLESHOOTING 

When POSPac is not successful in producing the trajectory, a user may encounter a few generic error 

messages indicating the failure. 

TRUEVIEW ERROR: UPLOAD_FAILED 

 

Figure 60 - TrueView Error: Upload_Failed 

POSPacCloud.exe is experiencing problems packaging and uploading the POS data to the 

POSPacCloud. Verify your internet connection is stable and try again. Otherwise, see the probable 

resolutions on our searchable support knowledge base. 

TRUEVIEW ERROR: EXECUTION_FAILED 

 

Figure 61 ɀ LP360 Error: Execution_Failed 

This generic error message occurs whenever POSPacCloud fails to produce a smoothed GNSS-Inertial 

solution. Open the \Project\Area\Cycle\POS\POSPac_YYMMDD_HHMMSS\YYMMDD_HHMMSS.log 

file corresponding to the attempted execution in POSPacCloud and review the contents for the 

messages in the reason section. 3ÅÌÅÃÔÉÎÇ Ȱ9ÅÓȱ ÏÎ ÔÈÅ ÅÒÒÏÒ ÄÉÁÌÏÇ ×ÉÌÌ ÏÐÅÎ ÔÈÅ 

\Project\Area\Cycle\POS\POSPac_YYMMDD_HHMMSS\CYYMMDD_HHMMSS folder corresponding to 

the attempted execution in POSPacCloud so you may review the log files for additional information. 

Refer to the probable resolutions on our searchable support knowledge base. 

https://support.geocue.com/upload_failed/
https://support.geocue.com/upload_failed/
https://support.geocue.com/execution_failed/


LP360 Drone Users Guide 
 

70 LP360 Drone v2024.1.30.0   4/30/2024 

TRUEVIEW ERROR: AN UNEXPECTED ERROR OCCURRED RUNNING POSPACBATCH.EXE 

 

Figure 62 ɀ LP360 Error: An Unexpected Error Occurred Running POSPac UAV 

This generic error message occurs whenever POSPac UAV (local) fails to produce a smoothed GNSS-

Inertial solution. The error message contains the overall processing log. The top reasons for this error 

are: 

¶ No license available, open the Applanix Software License Utility and verify the machine being 

used to process can see the licenses being served by the Applanix license server machine on 

your network. 

¶ If this is the first time running POSPac on the machine, open the POSPac UAV desktop 

application and ensure it opens without error to ensure the installation occurred without any 

issues. 

¶ Incorrect base station location, datum, or epoch. 

¶ Project path length exceeds 200 characters, this error will be reported in the posbat file towards 

the end. 

¶ A user still has the POSPac Processing Offset (File -> Project Settings -> EXP -> True View 

Experimental Settings) set to a large number (Default = 30s). The large offset number was 

necessary for v8.4-8.5 but is no longer needed with v8.6 or later. 

¶ A user has installed POSPac v9.0 hotfix or later but is running a deprecated version of LP360 

Drone/True View EVO. 

¶ A user has installed POSPac v9.1 but has not yet upgraded their POSPac licenses to v9.1. 

¶ A user has installed POSPac MMS instead of the POSPac UAV for which their licenses are valid. 

6ÅÒÉÆÙ ÔÈÅ 0/30Á"ÁÔÃÈȢÅØÅ ,ÏÃÁÔÉÏÎ ɉ,/#!,Ɋ ÉÓ ÐÏÉÎÔÉÎÇ ÔÏ ÔÈÅ 0/3ÐÁÃ"ÁÔÃÈȢÅØÅ ÉÎ Á Ȱ0/30ÁÃ 

UAV 9.1ȱ ÆÏÌÄÅÒ ÁÎÄ ÎÏÔ Á Ȱ0/30ÁÃ --3 9.1ȱ ÆÏÌÄÅÒȢ 

Open the \Project\Area\Cycle\POS\POSPac_YYMMDD_HHMMSS\YYMMDD_HHMMSS.log file and 

review at which stage the processing failed. Refer to the probable resolutions on our searchable support 

knowledge base. 

https://support.geocue.com/updating-local-pospac-uav-installation
https://support.geocue.com/updating-local-pospac-uav-installation
https://support.geocue.com/unexpected-error-occurred-running-pospacbatch-exe/
https://support.geocue.com/unexpected-error-occurred-running-pospacbatch-exe/


LP360 Drone Users Guide 
 

71 LP360 Drone v2024.1.30.0   4/30/2024 

CREATING FLIGHT LINES AND TRUEVIEW TRAJECTORIES 

The steps to this point have allowed us to create a single file with the corrected sensor trajectory for the 

entire Cycle. Sections of each flight in the Cycle are not useful to us, such as the IMU heading alignment 

maneuver and flight line transitions, so we clip these sections out by defining which portions of the 

flight to keep. Usually only the data collected along the flight lines are retained, so we will use the Auto 

Create Flight Lines tool   (Figure 63) and the Create Flight Lines from Selected Trajectory Points 

 (Figure 64) from the Sensor tab for the next step. Flight lines are created using the time in the 

ÔÒÁÊÅÃÔÏÒÙ ÐÏÉÎÔÓ ÌÁÙÅÒȟ ÔÈÅÎ Á ÎÅ× ÌÁÙÅÒ ÉÓ ÃÒÅÁÔÅÄ ÎÁÍÅÄ ȰArea_99--$$;((--33;&ÌÉÇÈÔ ÌÉÎÅÓȱȢ 

The steps below describe how to create flight lines automatically and manually. The best approach is to 

create flight lines automatically, then add or delete flight lines manually to get the exact flight lines we 

want. 

 

 

Figure 63 ɀ Auto Create Flight Lines 

 

Figure 64 - Create Flight Lines from Selected Trajectory Points 

 

For legacy microdrones payloads, the flight lines are automatically generated during import 

based on the mdCockPit flight plan. These flight lines are not editable. 

For mobile datasets, the Auto Create Flight Lines tool will likely be inadequate for creating 

usable flight lines. It is currently advised to create these manually to clip to the desired data. 
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AUTO CREATE FLIGHT LINES 

1. If not already done, make active the Cycle/Flight combination to be processed. 

 

2. Select the Auto-Create Flight Lines tool on the Sensor tab (Figure 63) to open the Auto Create 

Flight Lines dialog (Figure 65). 

a) Flight Line Layer - The name of the layer that will be created and requires no input 

from the user. 

b) Min. Length ɀ No linear set of points shorter than this value will be considered for the 

calculation of a flight line. This number should usually be set to the shortest flight line 

length. Use the Measure tool  on the main LP360 toolbar to measure the shortest 

desired flight line. 

c) Turn Radius ɀ The radius, in map units, to allow at turns. The smaller the number, the 

closer the flight lines will be cut to the turns. The greater the radius, the larger the gap. 

d) Max Deviation ɀ The deviation parameter that tells the software when to break a line 

segment into two. The smaller this number, the more linear the flight lines but the 

ÍÏÒÅ ÆÌÉÇÈÔ ÌÉÎÅÓ ÔÈÁÔ ×ÉÌÌ ÂÅ ÃÒÅÁÔÅÄȢ 4ÈÅ ÌÁÒÇÅÒ ÔÈÉÓ ÖÁÌÕÅȟ ÔÈÅ ÍÏÒÅ ȰÂÅÎÄȱ ×ÉÌÌ ÂÅ 

allowed in a relatively straight segment without splitting. Hence, increase this value 

significantly if you have curved flight lines. 

 

Figure 65 ɀ Auto Create Flight Lines 

3. Once you have entered the desired parameters, select Compute Flight Lines. 

4. The flight line layer should be created, and the flight lines displayed in blue in the map view. 

a) Results can be changed by changing the parameters and selecting Compute Flight Lines 

again. The existing lines will be replaced with the results from the new settings. 

5. Flight lines can be deleted if necessary, by selecting the layer with the Select/ Edit Features button 

on the left end of the Feature Edit tab (Figure 66Ɋ ÁÎÄ ÃÌÉÃËÉÎÇ ÔÈÅ ÒÅÄ Ȱ8ȱ ÏÎ ÔÈÅ ÒÉÇÈÔ ÅÎÄ ÏÆ ÔÈÅ 

Feature Edit tab (Figure 66).  

a) Select the Select/ Edit Features tool   on the LP360 Feature Edit tab (Figure 66). 

b) Select the flight line you wish to delete, and the line will be highlighted (Figure 67). 

Enabling Single Cycle Mode  (Figure 26) displays layers relevant to the Active 

Cycle making for efficient viewing of the layers for the Active Cycle. 
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i. If multiple feature layers are selected, you will be prompted to choose a layer. 

Choose the flight line layer. 

ii. Hold control while selecting to select multiple flight lines. Or drag to select 

multiple flight lines. 

c) Select the Delete Selected Features  button on the LP360 Feature Edit tab (Figure 

66) and the selected feature(s) will be deleted. 

d) Delete all unnecessary flight lines. Undo  and Redo  may be used if you 

accidentally remove the wrong flight line. 

e) Select the Save Feature Edits  icon on the LP360 Feature Edit tab (Figure 66) to 

save the edits.  

 

 

 

Figure 67 ɀ Editing Flight Lines 

MANUALLY CREATE FLIGHT LINES 

1. Flight lines can be added manually by selecting trajectory points (red points) at the beginning 

and end of each line. 

a) Select the Select/ Edit Features tool   on the LP360 Feature Edit tab (Figure 66). 

Figure 66 - LP360 Feature Edit Tab 



LP360 Drone Users Guide 
 

74 LP360 Drone v2024.1.30.0   4/30/2024 

b) Select a trajectory point at the beginning of the desired flight line. The point will be 

highlighted when selected.  

c) Hold control, then select a trajectory point at the end of the flight line. Both trajectory 

points should now be highlighted (Figure 68).  

 

Figure 68 ɀ Manually Creating Flight Lines 

d) Select Create Flight Lines from Selected Trajectory Points  on the Sensor tab 

(Figure 64) and a new flight line should be created.  

e) Select the Save Feature Edits  icon on the LP360 Feature Edit tab (Figure 66)  to 

save the edits.  

Note: If you select Trajectory Point patterns that do not form the required base for creating a 

flight line, you will receive an error message that explains the issue (Figure 69).   
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Figure 69 - A pattern of Trajectory Points not compatible with forming a flight line 

CREATE TRUEVIEW TRAJECTORIES  

1. If not already done, make active the Cycle/Flight combination to be processed. 

2. Once flight lines have been created, and the edits saved, select Create TV Trajectories   

from the Sensor tab (Figure 70). The purpose of this step is to use the flight line layer to create a 

reduced trajectory file from the PostProcessedTraj.txt file for each flight line. Optionally and 

recommended, you may also update the image EXIF tags at the same time. 

 

Figure 70 - Create TrueView Trajectories 
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Figure 71 - Create TrueView Trajectories dialog 

3. These fields of this dialog are usually auto populated if the post process trajectory solution was 

successful. 

a) Flight Line Layer - Select the flight line layer from which to generate TrueView 

trajectories if multiple Cycles are being processed.  

b) Post Processed Trajectory File ɀ The trajectory file generated by POSPac. A post 

processed trajectory file may also be imported here if have one from a previous 

processing session with the same data. 

c) Calibration file ɀ The TrueView sensor calibration is critical to get accurate LiDAR and 

imagery data for all supported system types. Select the option for the calibration file 

you wish to use: 

i. Use Latest Available Calibration File on TrueView Reckon (Recommended) ɀ 

The latest calibration file for each sensor is stored on TrueView Reckon, the 

sensor management backend. When this option is selected, LP360 Drone will 

use the latest calibration file found on TrueView Reckon to process the data. 

This is the recommended option as some smarts exist on Reckon and in LP360 

Drone to help ensure the correct calibration file for the system and Cycle. If 

your system does not have a calibration file on Reckon, please contact 

support@geocue.com for assistance. 

ii. Diagnostic Only: Users should never normally use either of these options, 

except for: DJI Zenmuse L1/L2 processing, where it should not be modified 

from the default; Imagery only sensors, such as the P4RTK or P1, where the 

user does not have a camera calibration on Reckon and is therefore following a 

more arduous workflow involving measuring control rather than a more 

automated Ortho Mapping processing with only check points for validation 

(Image Explorer will also not be usable without a camera calibration). 

mailto:support@geocue.com
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Otherwise, iÆ ÔÈÅ Ȱ,ÁÔÅÓÔ #ÁÌÉÂÒÁÔÉÏÎȱ ÏÐÔÉÏÎ ÁÂÏÖÅ ÉÓ ÇÒÅÙÅÄ ÏÕÔȟ ÐÌÅÁÓÅ 

contact support@geocue.com for further assistance. for further assistance. 

1. Use Cycle-resident Calibration File ɀ If this option is selected, the 

calibration file in the system folder of Cycle being processed will be 

used to process the data. This may not be the latest calibration file if 

updates to your calibration have been made and those updates were 

not copied to the USB prior to acquisition. 

2. Manually Select Calibration File ɀ This choice will invoke a dialog that 

allows you to select a file from all available calibration files for this 

sensor from Reckon. If you select this choice, the Calibration File Picker 

dialog (Figure 72) will be displayed when you press the Create 

Trajectories button at the bottom of the Create TrueView Trajectories 

dialog. You can pick the calibration file you desire using the dropdown 

picker.   

 

Figure 72 - Calibration File Picker 

d) Retained Photos Layer Settings ɀ Allows the user to specify the photos to be kept for 

geotagging and export to photogrammetric software packages using Export Photo 

Package  or for processing in Agisoft Ortho Mapping , or for processing in Ortho 

Mapping . TÈÅ ÎÏÔÉÏÎ ÏÆ Ȱ2ÅÔÁÉÎÅÄ 0ÈÏÔÏsȱ ÃÒÅÁÔÅÓ Á ÌÁÙÅÒ ÏÆ the retained photos on 

Á ÎÅ× ÌÁÙÅÒ ÃÁÌÌÅÄ Ȱ2ÅÔÁÉÎÅÄ0ÈÏÔÏÓȢȱ 

i. Retain Photos within Flight Lines ɀ This option retains only the photos that 

occur between the start and end of each flight line (flight lines were defined in 

the prior Create Flight Lines step). This option eliminates photos in turns. 

(Recommended). Selecting ÔÈÅ ÏÐÔÉÏÎ ÔÏ Ȱ2ÅÔÁÉÎ Photos ×ÉÔÈÉÎ &ÌÉÇÈÔ ,ÉÎÅÓȢȱ 

creates a new layer in the Table of Contents (TOC) called ȰRetainedPhotosȱ. 

The resultant layer is shown in Figure 73. Note that only photos that are 

between the beginning and end of each flight line are retained. 

mailto:support@airgon.com
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Figure 73 - Retain Photos only within Flight Lines 

ii. Retain Photos within Flights Lines and Interior Turns ɀ This option retains all 

photos from the start of the first flight line (start as defined by GPS time) and 

the end of the last flight line. Thus, all ferry line photos are retained.  

iii. Retain All Photos ɀ All project photos are retained. In Figure 74, all photos 

retained. 

 

Figure 74 - All Project Camera Photos 
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e) Target Epoch ɀ Select Cycle Date for coordinate reference systems using the WGS84 

datum, otherwise select Custom Date and enter the applicable epoch for the datum of 

your coordinate reference system. For example, NAD83(2011) has an epoch date of 

2010.0. Typically, the epoch date for your project datum should be selected by default. 

You will be prompted after selecting OK if the project epoch differs from the value 

entered on this dialog. The project epoch is set when the project CRS is selected but 

can be modified in File -> Project Settings -> Project -> Project Epoch. 

f) Processing Settings 

i. Update Photo EXIF Tags with True Pose® Information ɀ Performs the 

operations of the Update EXIF Tags for Photogrammetric Software tool. 

Recommended to have this checked to avoid needing to separately run the 

Update EXIF Tags for Photogrammetric Software tool. 

ii. Starting Flight Line Number (Point Source ID) ɀ When there are multiple 

Cycles or flights in a project it is important to assign unique point source IDs, or 

flight line numbers to each line. Selecting a unique starting ID allows the user to 

determine the best values between 1 and 65535 to use for each line. For multi-

Cycle projects it is suggested to use a nomenclature, such as CCCFF, where CCC 

is the Cycles flown for the project, 1-645, and FF is the flight line per Cycle, 1-99, 

to keep the point source IDs unique within the project. 

4. Select Create TV Trajectories to create TrueView trajectories for the selected Flight Line layer. 

Once trajectories for a flight line are created the flight line will change from blue to magenta. 

Close the dialog when finished. 

You can delete additional photos on the RetainedPhotos layer using the Feature Edit delete tool. 

Only photos associated with this layer will be geocoded and exported as an export package, which 

greatly eases the setup of downstream tools.  

Note also that the RetainedPhotos layer behaves as a normal Photos layer. This means that the 

image view panes appear if you open this layer in Feature Analyst. 

If you cannot remember if you have run the Create TV Trajectories step, there is no harm in running 

it multiple times. The FlightLines layer symbology turns magenta when this step has been run. If 

you want to confirm creation of the flight line trajectories, you can inspect the Flight Line attributes 

using the LP360 Feature Analyst tool. Right-click the Flight Line layer in the TOC and then left-click 

Ȱ&ÅÁÔÕÒÅ !ÎÁÌÙÓÔ ȣȱ ɉÓÅÅ Figure 75). 
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Figure 75 - Opening Feature Analyst on the Flight Line layer 

/ÂÓÅÒÖÅ ÔÈÅ Ȱ464ÒÁÊ&)ÌÅȱ ÃÏÌÕÍÎ ÉÎ ÔÈÅ &ÅÁÔÕÒÅ ÔÁÂÌÅ ÏÆ &ÅÁÔÕÒÅ !ÎÁÌÙÓÔ (Figure 76). If this column 

is blank, flight line trajectories have not yet been created.   

 

Figure 76 - TrueView Flight Lines prior to assigning Trajectories 

Figure 77 shows the feature table after creation of the TrueView Flight Line trajectories. Note a file 

location is now populated in the TVTrajFile attribute column.   

 

Figure 77 - TrueView Flight Lines after assigning Trajectories 

Note: The Flight Line Trajectory files created in LP360 Drone for 3D Imaging Sensors (3DIS®) are in 

the Terrasolid trajectory format. These trajectories can be directly used in products such as 

TerraScan, TerraMatch and TerraPhoto.   
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GEOCODE LIDAR 

The Geocode LiDAR step is where the raw data in the laser file is geocoded, creating a spatially 

accurate 3D point cloud. The steps below explain the functions of the Geocode LiDAR dialog. TrueView 

trajectories must have been generated before the Geocode LiDAR tool will be active. 

1. If not already done, make active the Cycle/Flight combination to be processed. 

2. Select the Geocode LiDAR button  on the Sensor tab (Figure 78) to open the Geocode 

LiDAR dialog (Figure 79). 

 

Figure 78 ɀ Geocode LiDAR 

3. The Geocode LiDAR dialog (Figure 79) is where the user will select the calibration file, and 

LiDAR clipping settings. A 3D point cloud, LAS files, will be generated after completing this 

step. 

a) Flight Line Layer ɀ The layer that will be used to geocode and set by the active 

Cycle/Flight. 

 

Figure 79 - Geocode LiDAR dialog 

b) LiDAR Clipping: 

i. Clip Angle ɀ Enter the processing angle in degrees. This number represents the 

half angle off Nadir of the scanner. If 40 is entered, LiDAR data will be 

geocoded if it falls between +40° and -40° creating a total field of view (FOV) of 

80°. 

ii. Clip Range ɀ Enter the minimum and maximum range to be geocoded. No 

points with a range less than and/or greater than these values, respectively, will 

be geocoded. Useful when no Clip Angle is used to pick up features beside the 

system. 

iii. Enable True Track® ɀ True Track® is our term for software-enabled roll 

compensation of the sensor.  The roll attitude of the sensor (due to roll of the 
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drone carrying the sensor) is constantly reset to the nadir position and clipping 

(if set) applied at this point.  The effect is flight lines with straight rather than 

wavy edges.   

You should always enable True Track.  For a given clipping angle, it will produce 

more accurate as well as better aligned data.  Figure 80 shows a LiDAR swath 

clipped to 20° but with True Track disabled.  Notice the waviness in the sides of 

the track. 

 

Figure 80: LiDAR Strip without True Track 

Figure 81 shows the same swath, again clipped to 20°, with True Track enabled.  

Notice how the edges of the swath are now relatively straight. 

 

Figure 81: LiDAR Strip with True Track enabled 

c) Colorize Point Cloud after Geocoding ɀ At the completion of geocoding the LiDAR 

data, automatically kick-off the Colorize Point Cloud step of the TrueView Workflow in 

the Sensor tab (Figure 55) to use the photos to colorize each point in the point cloud for 

this Cycle/Flight. Selecting the option here allows one to skip running the Colorize Point 

Cloud step.  

 

d) Noise Filter (Riegl sensors only) ɀ Enabled by default when processing Riegl laser 

scanner data, this option will help automatically filter noise points from being 

geocoded. A user would not normally disable this option but may wish to do so when 

the density of the point cloud is more important than the accuracy of the points. 

e) Process with RiUNITE (TV680/TV720 Riegl sensors only) ɀ Available only when 

processing TV680 or TV720 Riegl laser scanner data and requires an applicable scanner 

specific Riegl license installed on the machine. The option supports MTA zones during 

Support for colorizing mobile datasets in LP360 using ray tracing is currently in 

development. If you need to colorize the mobile point clouds this needs to be 

performed with Rigel RiProcess or using LP360ȭÓ Color by Image Point Cloud Task 

(PCT) using an orthomosaic. 
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geocoding, adding a significant amount of extra processing time, so a user would 

normally disable this option when the Cycle was flown lower than the first transition 

zone but may wish to enable when close due to slant ranges. Failing to use this option 

when needed may result in an abnormal amount of noise in the dataset. 

4. Geocode LiDAR ɀ LiDAR data will be geocoded when this button is selected, creating the LAS 

layer for the selected Cycle. 
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POST PROCESSING TOOL 

The Post Processing tool can be used for all sensor types imported in LP360. The purpose of this tool is 

to prepare the datasets for post processing tools. The main need is to use the flight line layer to create a 

trajectory file for each flight line from the sensor trajectory file(s) and cut the LAS data into files 

corresponding to those flight lines, plus, apply any additional user desired filtering while performing 

this operation. This tool is helpful when processing large datasets as one can geocode everything, and 

later cut and filter as desired without needing to geocode again. 

1. On the Sensor tab (Figure 50), make active the Cycle/Flight combination to be processed. 

2. Open the Post Processing dialog by selecting the sensor Post Processing  button on the 

Sensor tab (Figure 82) to open the Post Processing dialog (Figure 83). 

 

Figure 82 - Post Processing tool on the Sensor Ribbon 

 

Figure 83 - Post-Processing Dialog 

a) LiDAR Processing: 

i. Clip Angle ɀ Enter the processing angle in degrees. This number represents the 

half angle off Nadir of the scanner. If 40 is entered, LiDAR data will be 

geocoded if it falls between +40° and -40° creating a total field of view (FOV) of 

80°. 
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ii. Clip Range ɀ Enter the minimum and maximum range to be geocoded. No 

points with a range less than and/or greater than these values, respectively, will 

be geocoded. Useful when no Clip Angle is used to pick up features beside the 

system. 

iii. Promote LAS to Version 1.4 ɀ Default is checked. This ensures the output LAS 

file format will be 1.4.  

iv. Starting Flight Line Number (Point Source ID) ɀ When there are multiple 

Cycles or flights in a project it is important to assign unique point source IDs, or 

flight line numbers to each line. Selecting a unique starting ID allows the user to 

determine the best values between 1 and 65535 to use for each line. For multi-

Cycle projects it is suggested to use a nomenclature, such as CCCFF, where CCC 

is the Cycles flown for the project, 1-645, and FF is the flight line per Cycle, 1-99, 

to keep the point source IDs unique within the project. 

b) Retained Photos Layer Settings ɀ This section will only become available when a 

photo layer is detected. Allows the user to specify the photos to be kept for geotagging 

and export to photogrammetric software packages using Export Photo Package  or 

for processing in Agisoft Ortho Mapping , or for processing in Ortho Mapping . 

TÈÅ ÎÏÔÉÏÎ ÏÆ Ȱ2ÅÔÁÉÎÅÄ 0ÈÏÔÏsȱ ÃÒÅÁÔÅÓ Á ÌÁÙÅÒ ÏÆ the retained photos on a new layer 

ÃÁÌÌÅÄ Ȱ2ÅÔÁÉÎÅÄ0ÈÏÔÏÓȢȱ 

i. Retain Photos within Flight Lines ɀ This option retains only the photos that 

occur between the start and end of each flight line (flight lines were defined in 

the prior Create Flight Lines step). This option eliminates photos in turns. 

(Recommended). Selecting ÔÈÅ ÏÐÔÉÏÎ ÔÏ Ȱ2ÅÔÁÉÎ Photos ×ÉÔÈÉÎ &ÌÉÇÈÔ ,ÉÎÅÓȢȱ 

creates a new layer in the Table of Contents (TOC) called ȰRetained0ÈÏÔÏÓȱ. 

The resultant layer is shown in Figure 84. Note that only photos that are 

between the beginning and end of each flight line are retained. 

 

Figure 84 - Retain Photos only within Flight Lines 
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ii. Retain Photos within Flights Lines and Interior Turns ɀ This option retains all 

photos from the start of the first flight line (start as defined by GPS time) and 

the end of the last flight line. Thus, all ferry line photos are retained.  

iii. Retain All Photos ɀ All project photos are retained. In Figure 85Figure 74, all 

photos retained. 

 

Figure 85 - All Project Camera Photos 

4. A Confirmation page will appear to confirm the execution of the tool (Figure 86). 

 

Figure 86 - Post Processing Confirmation Page 
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STRIP ADJUSTMENT 

For a TrueView 3DIS and microdrones payloads, strip alignment may be improved by executing an 

addon license to LP360 Drone, called Strip Adjustment  . Refer to the method and context behind 

Strip Adjustment. For boresite calibration, use the Boresite Calibration utility found on the Sensor tab. 

 

Figure 87 - Strip Adjustment  on the Sensor tab 

Strip Adjustment requires a Ȱ3ÔÒÉÐ !ÄÊÕÓÔÍÅÎÔȱ ÏÒ Á Ȱ3ÔÒÉÐ !ÌÉÇÎȱ ÁÄÄÏÎ ÌÉÃÅÎÓÅ ÂÅ ÃÈÅÃËÅÄ ÏÕÔ ÉÎ 

addition to the LP360 Drone license.  Note: LP360 Drone+Strip Adjustment may only be used with 

TrueView 3DIS® or microdrones data. 

1. The active Cycle on the Sensor tab is not used by this utility, so it does not matter what is 

selected. 

2. Select Strip Adjustment   on the Sensor tab (Figure 87) to open the Strip Adjustment dialog 

(Figure 88). Note: To enable this tool requires a ȰStrip Adjustmentȱ or a ȰStrip Alignȱ addon 

license be checked out in addition to the ȰLP360 Droneȱ license. 

A good way to assess the need for using LP360 Strip Adjustment on your dataset is to inspect the 

data using profiles to review the interline fit and generate dz image(s) using the LP360 Export 

Wizard. 

https://support.geocue.com/strip-adjustment-method/
https://support.geocue.com/strip-adjustment-method/
https://support.geocue.com/display-elevation-difference-tool-dz-deltaz
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Figure 88 - Strip Adjustment dialog 

a) Input Settings 

i. Available Cycles ɀ Lists all Cycles in the currently open project. 

ii. Use ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ5ÓÅȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ Á Cycle to determine 

corrections for that Cycle. The Cycle must have a processed sensor trajectory in 

the typical file structure when following the TrueView workflow. 

b) Geocode Options 

i. The Geocode LiDAR options are listed here as the Strip Alignment process will 

geocode a new point cloud from the raw data using a corrected sensor 

trajectory. Use the same options you would for Geocode LiDAR. 

c) Processing Settings 

i. Update EXIF tags with strip adjustment corrected Pose ɀ As the Strip 

Adjustment computes a corrected sensor trajectory, the same corrections apply 

to the photos so update the image EXIF tags at this time to refine the True Pose 

information on the photos. Recommended enabled. 

ii. Colorize Point Cloud after strip adjustment ɀ As the Strip Alignment process 

will geocode a new point cloud from the raw data using a corrected sensor 

trajectory it will need to be colorized at this time if colorization is desired. At 

the completion of geocoding the LiDAR data, automatically kick-off the 

Colorize Point Cloud step of the Sensor tab to use the photos to colorize each 

point in the point cloud for the selected Cycles/Flights. Selecting the option 

here allows one to skip running the Colorize Point Cloud step. Recommended 

enabled. 
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d) Output Settings 

i. LAS Layer Name ɀ Type in a unique name for the destination layer on which to 

ÇÅÎÅÒÁÔÅ ÔÈÅ ÃÏÒÒÅÃÔÅÄ ,!3 ÆÉÌÅÓ ÆÒÏÍ ÔÈÅ Ȱ5ÓÅȱ ÌÁÙÅÒÓȢ 4ÈÉÓ ÉÓ ÔÈÅ ÔÙÐÉÃÁÌ ÆÉÒÓÔ ÏÒ 

only run option. $ÅÆÁÕÌÔ ÎÁÍÅ ÉÓ Ȱ,!3;3ÔÒÉÐ!ÄÊÕÓÔÅÄ;99--$$;ÈÈÍÍÓÓȟ 

where the date/time stamp is when the Strip Adjustment tool was invoked. 

ii. Append to Existing LAS Layer ɀ Select from the Available LAS Layer the 

previously created layer name on which to append the additional Cycle(s). Not 

typical. 

e) Submit StripAdjustment  Job ɀ Submits the Strip Adjustment processing to the Job 

Manager queue for processing.  

3. A successfully submitted job notification will appear confirming the job submission (Figure 

104). 

 

 

 

Figure 89 - Strip Adjustment  Job Submission Confirmations 

4. An empty e-mail will be sent when the processing begins to the e-mail configured in the LP360 

E-mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification 

Settings). 

5. The Strip Adjustment job progress may be monitored using Job Manager .  

6. Upon completion of the Strip Adjustment job by the Job Manager : 
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a) Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   

b) An empty completion e-mail notification will be sent to the e-mail configured in the 

LP360 E-mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail 

Notification Settings) 

c) The job will need to be post-processed to add the resulting LAS layer and/or LAS files to 

the open project. 

7. In Job Manager , select the applicable Strip Adjustment job, then select View Log to review 

the Strip Adjustment processing log.  

a) Review the STDERR section for any reported errors. 

8. In Job Manager , select the applicable Strip Adjustment job, then select Open Project to 

open the applicable project for the job, if not currently open. 

9. Then, select Post-Process to add the new LAS Layer and/or LAS file(s) to the currently open 

project based on the settings at the time the job was submitted. 

10. Review the adjusted LAS data vs the original to determine suitability of the correction. Cut 

profiles and generate a dz image for comparison to those done before the adjustment. 

11. When desired, in Job Manager , select the applicable Strip Adjustment job, then select 

Delete Job to clean up the temporary files generated while processing the job. 
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STRIP ADJUSTMENT ADVANCED SETTINGS 

The most commonly configurable Strip Adjustment settings are configured on the Strip Adjustment 

Advanced Settings dialog (Figure 90). The defaults are the recommended settings, though users may 

wish to modify for some datasets. 

 

Figure 90 - Strip Adjustment Advanced Settings 

¶ Input Reference Files 

o Reference Cycles ɀ This list is populated with the Cycles in the project that were not 

selected in the Input Settings. 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ ȰUseȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ Á Cycle 

to hold that Cycle ÆÉØÅÄ ÁÎÄ ÕÓÅ ÁÓ ÒÅÆÅÒÅÎÃÅ ÆÏÒ ÔÈÅ Ȱ5ÓÅȱ ÌÁÙÅÒÓ of the Input Settings -> 

Available Cycles list. The Cycle must have a processed sensor trajectory in the typical 

file structure when following the TrueView workflow. 

o Reference LAS ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ ȰUseȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ Á ,!3 ÌÁÙÅÒ ÔÏ ÈÏÌÄ 

ÔÈÁÔ ÌÁÙÅÒ ÆÉØÅÄ ÁÎÄ ÕÓÅ ÁÓ ÒÅÆÅÒÅÎÃÅ ÆÏÒ ÔÈÅ Ȱ5ÓÅȱ ÌÁÙÅÒÓ of the Input Settings -> 

Available Cycles list. Trajectories are neither required, nor used for reference LAS 

layers. 

¶ Advanced Parameters 

This is dedicated to advanced users, so non-advanced users should not modify this section. 

Changing these settings will change how Strip Adjustment results are generated and may 

also affect the processing time. 
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o Tie Points Mode ɀ To estimate the trajectory correction, only a portion of data is 

considered. The considered portion is constituted of points, which we refer to as Tie 

points. Tie points should be representative enough of the sensor trajectory errors. This 

is realized by subsampling the data. There are two implemented subsampling methods. 

This parameter enables to define the one used: 

Á Uniform: Recommended mode. Tie points are uniformly distributed through 

the terrain. This option should be used for non-flat terrains. It is also 

recommended for high dynamic trajectory errors. 

Á Normal: Tie points are equally distributed on each inch of the terrain with a 

different orientation. This option should be used for terrains with a 

predominant direction where the variation of the orientation is relatively small. 

It is also recommended for low dynamic trajectory errors. 

o Time Frame (seconds) ɀ defines the frequency of the estimated temporal correction of 

the trajectory. The smaller the value, the higher the frequency of the correction. The 

higher the frequency of correction, the more time consuming is the processing. 

Minimum value High dynamic error Low dynamic error Maximum value 

5 secs 15 secs 25 secs (default) 
N/A - depends on the 

flight line length 

Table 2 - Time Frame Recommendations 

¶ Reset ɀ Resets the Strip Adjustment advanced settings back to their default values. 
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COLORIZE POINT CLOUD 

Colorize Point Cloud  on the Sensor tab (Figure 91) uses the photos to colorize each point in the 

point cloud. The colorization of the point cloud will depend on the quality of the photos. If colorization 

is critical to the project, it is recommended to check the photo quality in the field prior to leaving the 

site. This step may be skipped if already run by selecting the Colorize Point Cloud after Geocoding 

checkbox on the Geocode LiDAR dialog. 

1. If not already done, make active the Cycle/Flight combination to be processed. 

2. Select Colorize Point Cloud  on the Sensor tab (Figure 91) and the colorize point cloud dialog 

(Figure 92) will open. 

 

Figure 91 ɀ Colorize Point Cloud 

 

Figure 92 ɀ Colorize Point Cloud dialog 

3. The photo layer that will be used to colorize the point cloud is auto selected for the active 

Cycle/Flight. 

4. Select Colorize Point Cloud on the dialog and the point cloud for the active Cycle/Flight will be 

colorized. The display mode is changed to Display by RGB Values .  

5. Close when finished. 

Colorizing the point cloud is a more time-consuming process than Geocoding. Processing status will 

be displayed in the lower left section of the LP360 main window frame and swaths will be loaded in 

the Map View, with Display by Color enabled, as they complete processing. An example of a 

colorized point cloud from a TrueView 516 3DIS® is shown in Figure 93. An example of a colorized 

point cloud from a TrueView 615 3DIS® is shown in Figure 94. 
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Figure 93:  A colorized TrueView 516 Point Cloud 

 

Figure 94 - A colorized TrueView 615 Point Cloud 
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UPDATE EXIF TAGS FOR PHOTOGRAMMETRIC SOFTWARE 

Update EXIF Tags   on the Sensor tab (Figure 95) will geotag each photo with the corrected position 

and accuracy value. Photos that were taken outside of the corrected trajectory file, such as photos on 

the ground before takeoff, will be removed. This utility  must be run to use the images in Metashape, 

Pix4D and other photogrammetric packages with similar workflows.  This step may be skipped if 

already run by selecting the Update Photo EXIF Tags with True Pose® Information checkbox on the 

Create TrueView Trajectories dialog. When completed, the Export Photo Package tool will be enabled. 

 

Figure 95 ɀ Update EXIF Tags 

1. If not already done, make active the Cycle/Flight combination to be processed. 

2. Select Update EXIF Tags  on the Sensor tab (Figure 95) to open the Update EXIF tags dialog 

(Figure 96).  

 

Figure 96 - Update EXIF Tags dialog 

3. The photo layer that will be used to update the EXIF tags is selected based on the active 

Cycle/Flight combination on the Sensor tab. 

4. Select Update EXIF Tags to tag the images.  

5. A confirmation dialog (Figure 97) will appear showing the number of images that will be 

removed. This is a result of those images being outside of the corrected trajectory time frame 

and normal for the tagging process. Select yes to continue. 

 

Figure 97 - EXIF Tagging Confirmation 

6. When the process is complete, select OK on the confirmation dialog. 

0 
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7. The images from both cameras are now tagged. Proceed to the Export Photo Package tool to 

export the photos on the Retained layer and associated camera calibration files for downstream 

processing in photogrammetric processing software. 

8. To review the updated EXIF information in LP360 Drone: 

A) Select and right-click on the Photo or Stations layer in the Table of Contents (TOC) and 

select Feature Analyst.  

B) Select a photo or station from the Features list in Feature Analyst. 

C) Right-click on the desired image displayed in the lower section of Feature Analyst and 

select EXIF Information from the menu. 

 

Figure 98 - Image EXIF Viewer 

9. For troubleshooting purposes, the following information is left in this user guide but is 

superfluous when using the Export Photo Package tool. 

a) Tagged images, suitable for Metashape, are in the project folder, in the Port and 

Starboard folders (Figure 99) (Project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ 

YYMMDD_HHMMSS\) 

 

Figure 99 ɀ Example Location of Tagged Images 
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b) Two CSV files with the image positions are created in the System folder in the same 

location (Project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ 

YYMMDD_HHMMSS\System) 

i. 4ÈÅ #36 ÆÉÌÅ ÎÁÍÅÄ Ȱ)ÍÁÇÅ;ÇÅÏ;ÅÏȢÃÓÖȱ (Figure 100) contains the image 

positions in geographic coordinates, height in meters. The orientation angles 

are yaw, pitch and roll in degrees. 

ii. 4ÈÅ #36 ÆÉÌÅ ÎÁÍÅÄ Ȱ)ÍÁÇÅ;ÐÒÏÊ;ÅÏȢÃÓÖȱ (Figure 100) contains the image 

positions in projected coordinates, height in project units. The orientation 

angles are yaw, pitch and roll in degrees. 

iii. 4ÈÅ #36 ÆÉÌÅ ÎÁÍÅÄ ȰÉÍÁÇÅ;ÇÅÏ;ÏÐËȢÃÓÖȱ ÃÏÎÔÁÉÎÓ ÔÈÅ ÉÍÁÇÅ ÐÏÓÉÔÉÏÎ ÆÉÌÅ ÉÎ 

geographic coordinates, height in meters, with the orientation angles 

represented as omega, phi, kappa in degrees. This file is configured to be used 

in Pix4D. 

 

Figure 100 ɀ Example Location of Image Position Files 

c) Camera calibration files are also created for each camera in 

Project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ YYMMDD_HHMMSS\System folder 

(Figure 101). 

i. The xml files named Port.xml and Starboard.xml can be directly imported into 

Metashape. 

ii. The text files named PortP4D.txt and StarboardP4D.txt can be used in Pix4D. 

 

Figure 101 ɀ Example Location of Camera Calibration Files 
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LP360 STRIP ALIGN (FKA STRIPALIGN FOR EVO(SAFE)) 

For a TrueView 3DIS, microdrones, and DJI Zenmuse L1/L2, strip alignment may be improved by 

executing an addon license to LP360 Drone, called Strip Align .  

 

Figure 102 - Strip Align on the Sensor tab 

LP360 Strip Align requires a Ȱ3ÔÒÉÐ !ÌÉÇÎȱ addon license be checked out in addition to the LP360 Drone 

license.  Note: LP360 Drone+Strip Align may only be used with TrueView 3DIS®, microdrones, or DJI 

Zenmuse L1/L2 data. 

1. The active Cycle on the Sensor tab is not used by this utility, so it does not matter what is 

selected. 

2. Select Strip Align  on the Sensor tab (Figure 102) to open the Strip Align dialog (Figure 103). 

Note: To enable this tool requires a Strip Align addon license to be checked out in addition to 

the LP360 Drone license. 

 

Figure 103 ɀ Strip Align dialog 

A good way to assess the need for using LP360 Strip Align on your dataset is to inspect the data 

using profiles to review the interline fit and generate dz image(s) using the LP360 Export Wizard. 

bƻǘŜΥ ¢ƘŜǊŜ ŀǊŜ ƴƻ άǘǳƴƛƴƎέ ǇŀǊŀƳŜǘŜǊǎ ŦƻǊ LP360 Strip Align; it is fully automated. 

https://support.geocue.com/display-elevation-difference-tool-dz-deltaz
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a) Input Settings 

i. Available LAS Layers ɀ Will list all LAS layers in the currently open project. 

ii. Use ɀ Select the checkbox in the Ȱ5ÓÅȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ Á ,!3 ÌÁÙÅÒ ÔÏ ÄÅÔÅÒÍÉÎÅ 

corrections for that layer. The layer must have trajectories located in the same 

folder as the LAS, or in a Trajectories folder at the same level as the LAS data as 

is the typical file structure when following the TrueView workflow. 

iii. Fixed ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ&ÉØÅÄȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ Á ,!3 ÌÁÙÅÒ ÔÏ ÈÏÌÄ 

that layer fixed and use as reference ÆÏÒ ÔÈÅ Ȱ5ÓÅȱ ÌÁÙÅÒÓȢ Trajectories are 

neither required, nor used for fixed layers. 

iv. There are no Ȱtuningȱ parameters for Strip Align, it is fully automated. 

b) Output Settings 

i. LAS Layer Name ɀ Type in a unique name for the destination layer on which to 

generate the corrected LAS files ÆÒÏÍ ÔÈÅ Ȱ5ÓÅȱ ÌÁÙÅÒÓȢ This is the typical first or 

only run option. 

ii. Append to Existing LAS Layer ɀ Select from the Available LAS Layer the 

previously created layer name on which to append the additional Cycle(s). 

c) Submit StripAlign Job ɀ Submits the Strip Align processing to the Job Manager queue 

for processing.  

3. A successfully submitted job notification will appear confirming the job submission (Figure 

104).  

 

Figure 104 - Strip Align Job Submission Confirmation 

4. An empty e-mail will be sent when the processing begins to the e-mail configured in the LP360 

E-mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification 

Settings). 

5. The Strip Align job progress may be monitored using Job Manager .  

6. Upon completion of the Strip Align job by the Job Manager : 

a) Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   

b) An empty completion e-mail notification will be sent to the e-mail configured in the 

LP360 E-mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail 

Notification Settings) 

c) The job will need to be post-processed to add the resulting LAS layer and/or LAS files to 

the open project. 
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7. In Job Manager , select the applicable Strip Align job, then select View Log to review the 

Strip Align processing log.  

a) Review the STDOUT section ÆÏÒ ȰXYZ-displacements RMSȱ statistics before the 

correction and ȰResidual RMSȱ after the correction. 

b) Review the STDERR section for any reported errors aside from the expected benign 

warnings. 

8. In Job Manager , select the applicable Strip Align job, then select Open Project to open the 

applicable project for the job, if not currently open. 

9. Then, select Post-Process to add the new LAS Layer and/or LAS file(s) to the currently open 

project based on the settings at the time the job was submitted. 

10. Review the adjusted LAS data vs the original to determine suitability of the correction. Cut 

profiles and generate a dz image for comparison to those done before the adjustment. 

11. When desired, in Job Manager , select the applicable Strip Align job, then select Delete Job 

to clean up the temporary files generated while processing the job. 

STDERR: 

======= 

WARNING: Uncertainty vector image: z multiplied by 10 

WARNING: no mount file specified, using BODY/IMU rot=0 and Bore=0 
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ORTHO MAPPING 

For TrueView, microdrones, and DJI image sensors, the orthomosaic can be generated and the image 

positions and orientations refined using Ortho Mapping , that is included in an addon license to 

LP360 Drone, called Photo. A Ȱ0ÈÏÔÏΩΦΦΦȱ ÏÒ ÌÅÇÁÃÙ Ȱ&ÕÌÌ 0ÈÏÔÏȱ ÁÄÄÏÎ ÌÉÃÅÎÓÅ may also enable this 

tool. 

 

Figure 105 ɀ Ortho Mapping on the Sensor tab 

1. The active Cycle/Flight combination on the Sensor tab is not used by this utility, so it does not 

matter what is selected. 

2. Select Ortho Mapping  on the Sensor tab (Figure 105) to open the Ortho Mapping dialog 

(Figure 106). Note: 4Ï ÅÎÁÂÌÅ ÔÈÉÓ ÔÏÏÌ ÒÅÑÕÉÒÅÓ Á Ȱ0ÈÏÔÏȱ, ÏÒ Ȱ0ÈÏÔÏΩΦΦΦȱ, or legacy Ȱ&ÕÌÌ 

0ÈÏÔÏȱ addon license be checked out in addition to the LP360 Drone license. 

 

Figure 106 ɀ Ortho Mapping dialog with Input Layer Type: Point Cloud (LAS Layers) 

a) Input Layer Type:  

The two modes available for the Ortho Mapping tool are predicated on the selection of the 

Input Layer Type. 

Ortho Mapping from Images (Photo Layers) requires a very recent version of your graphics driver 

that supports CuDA 12.0. Typically, that means manually downloading and installing a driver from 

the manufacturer that has been released since December 2022.  
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i. Point Cloud (LAS Layers) ɀ Recommended for with TrueView 3DIS and 

microdrones, since the heavy lifting has already been done by the point cloud 

colorization, the user may select to use the colorized point cloud LAS Layer 

from which to quickly generate an orthomosaic in a fraction of the time it would 

take to use the photos. Select the desired colorized point cloud LAS layer(s) 

from which to generate the orthophoto.  

ii. Images (Photo Layers) ɀ For TrueView, microdrones, and DJI image sensors, 

the orthomosaic can be generated from the photos, and the image positions 

and orientations refined by selecting the images on the Photo layer(s) as the 

input. 

INPUT LAYER TYPE: POINT CLOUD (LAS LAYERS) 

3. With the input layer type selected to be Point Cloud the Ortho Mapping dialog looks like Figure 

106.  

a) Input Settings 

i. Available LAS Layers ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ5ÓÅȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ ÁÌÌ 

desired colorized LAS layers that you wish to use as source points for the 

orthomosaic generation. This would typically include LAS layers for every Cycle 

in the project that covers the desired area.  

b) Generate Orthophoto From 

i. Color (RGB) - This option will generate an RGB orthophoto using the RGB 

attributes from the selected Source Points. 

ii. Intensity  ɀ This option will generate a greyscale orthophoto using the intensity 

attributes from the selected Source Points. 

iii. Source Points ɀ Selecting will open Live View to allow filtering the points to be 

used from the input LAS Layers based on the available criteria. 

c) Output Orthophoto Cell Size ɀ Specify the ground sample distance (GSD) of the 

orthophoto to be generated in the project map units. 

i. Auto-Compute Cell Size ɀ Not Recommended ɀ will disable the other options 

in this group box and compute the cell size to use during processing. 

ii. Cell Size ɀ Key in your desired cell size. 

1. Estimate Cell Size ɀ when pressed, will sample the input LAS layers to 

populate the Point Density and Recommended Cell Size and populate 

the Cell Size with that same recommended value. It is recommended to 

manually modify the value in the Cell Size to increase it slightly and 

make it a round number. For example, if the Recommended Cell Size is 

0.082 meters, then modify the Cell Size field to be 0.1 meters. 

d) Triangulation Filter ɀ The selected attributes from the input LAS Layers will be 

triangulated and then sampled to produce the orthophoto. Use these settings to filter 

triangles based on their attributes to minimize the inclusion of long triangles that may 

span areas of void data to help clean up your orthophoto. 

i. Max Triangle Area 

ii. Max Triangle Length 

https://support.geocue.com/lp360-live-view
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e) Output  Settings ɀ Specify the Output Layer Basename for the orthophoto(s) to be 

generated on.  

f) Area Selection ɀ Define the extents for the orthophoto. 

i. Use Basic Extent 

1. Extent Method 

a. Extent of Selected LAS Layer(s) 

b. Custom Extent ɀ manually enter the Output Orthophoto 

Extents. 

c. Current Map Extent ɀ uses the current map view extents to 

define the Output Orthophoto Extents. 

d. Layer Extent ɀ Enables the layer selection dropdown to select 

which layers extents to use to define the Output Orthophoto 

Extent. 

e. Draw Window in Map ɀ Select Draw then draw a rectangle in 

the map view to define the Output Orthophoto Extent. 

2. Output Orthophoto Extent ɀ changes with the Extent Method 

selected to describe the rectangular bounding box in map coordinates. 

3. Apply Buffer ɀ enable and enter the buffer value to increase the size of 

the triangulated surface to some buffered distance around the Output 

Orthophoto Extent. 

ii. Cookie Cut by Polygons 

1. Polygon Layers ɀ select the layer from which to use the polygon 

features to generate one orthophoto for each polygon. 

a. Use Selected ɀ enable to only generate a single orthophoto for 

the polygon which has been selected from the selected polygon 

layer. 

2. Name Field ɀ choose which field to use to uniquely name the 

generated orthophoto files for each polygon. 

3. Apply Buffer ɀ enable and enter the buffer value to increase the size of 

the triangulated surface to some buffered distance around each 

polygon. 

g) Create Orthophoto ɀ Executes the Export Wizard to generate the orthophoto(s). s the 

process is relatively quick, a progress bar appears during processing and there is no job 

submitted to the Job Manager. 
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INPUT LAYER TYPE: IMAGES (PHOTO LAYERS) 

3. After selecting the input layer type to be Images the Ortho Mapping dialog will change to look 

like Figure 107. 

 

Figure 107 ɀ Ortho Mapping dialog with Input Layer Type: Images (Photo Layers) 

a. Input Settings 

i. Available True Pose® Photo Layers ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ5ÓÅȱ ÃÏÌÕÍÎ 

beside all desired True Pose® layers that you wish to use as source photos for 

the orthomosaic generation. This would typically include all RetainedPhotos 

layers for every Cycle in the project that covers the desired area. A True Pose® 

image means their full metadata, including camera calibration, is stored in 

ÓÐÅÃÉÁÌ 'ÅÏ#ÕÅ ÔÁÇÓ ×ÉÔÈÉÎ ÅÁÃÈ ÐÈÏÔÏȭÓ %8)& ÔÁÇÓȢ 

b. Output Settings 

i. Generate Point Cloud / Ortho from Images - This option will generate a Dense 

Image Matching (DIM) point cloud. 

1. Generate Point Cloud (LAS) - generate and retain the Dense Image 

Matching (DIM) point cloud to add to the project during the post-

process step. 

2. Generate Ortho - generate and retain the orthomosaic to add to the 

project during the post-process step. 

ii. Bundle Block Adjustment (BBA) Only ɀ Useful for troubleshooting, or to 

improve the True Pose® information for use with Image Explorer when not 

generating an orthomosaic. 

c. Output Point Cloud ɀ Only use this option for 2DIS (image only systems). 

i. Create New LAS Layer - LAS Layer Name ɀ Type in a unique name for the 

destination layer on which to generate the DIM LAS files from the Ortho 

Mapping run. 
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ii. Append to Existing LAS Layer ɀ Select from the Available LAS Layer the 

previously created layer name on which to append the additional DIM LAS files. 

d. Output Ortho  

i. Create New Ortho Layer ɀ Ortho Layer Name ɀ Type in a unique name for the 

destination layer on which to generate the orthomosaic raster resulting from 

this Ortho Mapping run. 

ii. Append to Existing Ortho Layer ɀ Select from the Available Ortho Layers a 

previously created layer name on which to add the orthomosaic raster resulting 

from this Ortho Mapping run. 

e. Advanced Settings ɀ Opens the Ortho Mapping Advanced Settings dialog (Figure 

109Figure 113) 

f. Process ɀ Submits the Ortho Mapping processing to the Job Manager queue for 

processing. 

4. A successfully submitted job notification will appear confirming the job submission (Figure 112). 

 

Figure 108 ɀ Ortho Mapping job submission confirmation 

5. An e-mail will be sent when the processing begins to the e-mail configured in the LP360 E-mail 

Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification Settings). 

6. The Ortho Mapping job progress may be monitored using Job Manager .  

7. Upon completion of the Ortho Mapping job by the Job Manager : 

a. Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   

b. A completion e-mail notification will be sent to the e-mail configured in the LP360 E-

mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification 

Settings) 

c. The job will need to be post-processed to add the resulting Orthomosaic layer and/or 

raster, as well as the optional LAS layer and/or LAS files to the open project. 

8. If desired, or for troubleshooting, in Job Manager , select the applicable Ortho Mapping job, 

then select View Log to review the Ortho Mapping processing log.  

9. In Job Manager , select the applicable Ortho Mapping job, then select Open Project to open 

the applicable project for the job, if not currently open. 

10. Then, select Post-Process to add the new Ortho Layer and/or raster file, and for 2DIS the new 

LAS Layer and/or LAS file(s) to the currently open project based on the settings at the time the 

job was submitted. 
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11. Review the generated Orthomosaic and for 2DIS, LAS data. 

12. When desired, in Job Manager , select the applicable Ortho Mapping job, then select Delete 

Job to clean up the temporary files generated while processing the job. 

13. Optional: Use the Reproject Raster PCT providing it your deliverable project boundary, or 

boundaries if you would like to tile the ortho, as input geometry, leave the reproject unchecked 

so as not to reproject the raster, and it will quickly create you a clipped orthomosaic. This PCT is 

also useful for converting the Ortho Mapping generated orthomosaic from the default BigTIFF 

ÆÏÒÍÁÔ ÔÏ Á ÒÅÇÕÌÁÒ 4)&& ÆÏÒ ÕÓÉÎÇ ÔÈÅ ÒÁÓÔÅÒ ÉÎ !ÕÔÏÄÅÓËȭÓ #ÉÖÉÌΩ$ȟ ×ÈÉÃÈ ÃÁÎÎÏÔ ÒÅÁÄ "ÉÇ4)&&ÓȢ 

Unless, of course, your orthomosaic is around 4GB or larger, thus requiring to be a BigTIFF, 

unless you use the Reproject Raster PCT to cut the orthomosaic into an index of your own or 

one created using the Grid Generator PCT.  

ORTHO MAPPING ADVANCED SETTINGS 

The most commonly configurable Ortho Mapping settings are configured on the Ortho Mapping 

Advanced Settings dialog (Figure 109). The defaults are the recommended settings, though users may 

wish to modify for their personal preferences. 

 

Figure 109 - Ortho Mapping Advanced Settings dialog 
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¶ Alignment Settings 

o Alignment Accuracy ɀ Selects the input photo resolution that will be used in the 

Bundle Block Adjustment (BBA) step. The higher the resolution, the more accurate the 

BBA, but at the expense of increased processing time. Select from: 

Highest  2:1  

High  1:1 High is recommended. 

Medium  1:2 

Low  1:4 

Lowest  1:8 

o Camera Calibration ɀ This radio button choice allows you to use a prior camera 

calibration or Update Calibration to calibrate the camera as part of the BBA process. 

For pre-calibrated sensors (usually the case with GeoCue workflows, but not the case 

for DJI L1/L2), select Use Sensor Fixed Calibration to use the camera calibrations for 

your system that are stored on Reckon. You should always use this option. Note: You 

ÃÁÎÎÏÔ ÐÅÒÆÏÒÍ Ȱ'#0-&ÒÅÅȱ ÇÅÏÐÏÓÉÔÉÏÎÉÎÇ ÉÆ ÙÏÕ ÄÏ ÎÏÔ ÈÁÖÅ Á ÐÒÅ-calibrated camera. 

¶ Point Cloud Settings 

o Dense Cloud Quality ɀ This sets the resolution of the input photos during the dense 

cloud formation part of the processing. As with BBA, a higher setting provides higher 

quality but at the expense of increased processing time. Each level is approximately 

four times the processing time of the level below it. Select from: 

Á Ultra High 1:1 

Á High  1:2 High is recommended for CUDA cores. 

Á Medium 1:4 Medium is recommended when no CUDA cores. 

Á Low  1:8 

Á Lowest  1:16 

Á Precise Value (1-16) 

¶ Ortho Settings 

o Ortho Compression Method ɀ Select from No compression, JPEG, or LZW. JPEG 

recommended.  

o JPG Quality ɀ If a JPEG compression method is used, specify the desired quality, with 1 

being the lowest and 100, the highest. Recommended to use 90 for a good quality to 

compression ratio. 

o Optimal GSD from Images ɀ Allow Ortho Mapping to determine the optimal ground 

sample distance for the orthomosaic from the input photos. i.e., Full resolution. Not 

Recommended! 

o Factor of Input Images GSD ɀ Allows the tool to automatically determine the Optimal 

GSD from Images, then multiply it by the factor to set the desired Precise GSD. For 

optimal results, recommended to generate the orthomosaic a factor of four times 

the optimal GSD from Images. 

o Precise GSD (Ground Units) ɀ The user may deselect the Optimal GSD from Images 

option and enter a desired GSD in the project units. 

 



LP360 Drone Users Guide 
 

108 LP360 Drone v2024.1.30.0   4/30/2024 

AGISOFT ORTHO MAPPING (FKA METASHAPE FOR EVO(MFE)) 

For TrueView and DJI image sensors, the orthomosaic can be generated and the image positions and 

orientations refined using Agisoft Ortho Mapping , that is included in an addon license to LP360 

Drone, called Photo with Agisoft . Images may also be processed in the Cloud version for Ortho 

Mapping using LP360 points purchased in the LP360 Store. 

The Agisoft Ortho Mapping license is a separate key from the LP360 Drone+Photo with Agisoft 

licenses. See Licensing LP360 Drone+Desktop Photo with Agisoft for more information on 

activating/deactivating your Agisoft Ortho Mapping license. It is not necessary to install Metashape 

Pro to use this tool, however, Agisoft Ortho Mapping may also drive the GUI version of Metashape Pro 

(v1.7.1 through 2.0.x) if you have such licenses or desire to purchase a node-locked or floating license.  

 

Figure 110 ɀ Agisoft Ortho Mapping on the Sensor tab 

 

1. The active Cycle/Flight combination on the Sensor tab is not used by this utility, so it does not 

matter what is selected. 

2. Select Agisoft Ortho Mapping  on the Sensor tab (Figure 110) to open the Agisoft Ortho 

Mapping dialog (Figure 111). Note: To enable this tool requires a ȰFull Photoȱ, Ȱ0ÈÏÔÏ ×ÉÔÈ 

!ÇÉÓÏÆÔȱ, or ȰPhoto3000ȱ addon license be checked out in addition to the LP360 Drone license. 

When using a 3DIS, it is recommended that you run a ground classification on your dataset and 

additionally classify any building roofs or bridge decks to achieve optimal and efficient results when 

running Agisoft Ortho Mapping to generate your orthomosaic. 

https://store.lp360.com/
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Figure 111 ɀ Agisoft Ortho Mapping dialog 

a) Input Settings 

i. Available True Pose® Photo Layers ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ5ÓÅȱ ÃÏÌÕÍÎ 

beside all desired True Pose® layers that you wish to use as source photos for 

the orthomosaic generation. This would typically include all RetainedPhotos 

layers for every Cycle in the project that covers the desired area. A True Pose® 

image means their full metadata, including camera calibration, is stored in 

ÓÐÅÃÉÁÌ 'ÅÏ#ÕÅ ÔÁÇÓ ×ÉÔÈÉÎ ÅÁÃÈ ÐÈÏÔÏȭÓ %8)& ÔÁÇÓȢ 

b) Processing Location ɀ Select to process Local or Cloud by selecting the applicable 

radio button next to the option. 

c) Metered Ortho Mapping ɀ When Cloud is selected, this section will detail the number 

of photos, available LP360 Points, and the total cost for generating the orthomosaic 

using Ortho Mapping Cloud. 

d) Output Settings 

i. Apply a priori EO if BBA Fails (Only available if Orientation Quality >= INS) ɀ 

(Recommended for 3DIS®) Always defaulted on for True Pose® photo layers 

from a TrueView 3DIS®. This option is not available for DJI and other sensors. 

When selected, two Metashape projects are generated as LP360 Drone 

identifies those images for which Metashape failed to align, for instance, those 

in vegetation, and updates the alignments for those in the new project. This 

second project is then used to generate the orthomosaic so that the holes one 

would normally have from a standard Metashape processing are minimized, if 

not eliminated.  

i. Generate Ortho from DEM (Highly recommended for 3DIS®) 

1. Input DEM Layer 
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a. Remove any high and low noise from the dataset. Often best 

accomplished using the Clip Range option in Geocode LiDAR, 

Low/Isolated PCT, and/or a Basic Filter PCT that uses elevation 

clipping. See Noise Removal Options for more details. 

b. Run a ground classification (Adaptive TIN Ground PCT) against 

the dataset using appropriate settings for a good, generalized 

ground surface. It is not important to have a perfect surface as 

there is some leeway in the orthomosaic process, however, if 

you have features such as retaining walls then you may need 

breaklines to properly hold those types of features. 

c. Optional - Manually cleanup the gross blunders in the ground 

surface (Class 2) using the manual classification tools found on 

the Classification tab and Profile toolbar, and/or the Ground 

Cleanup Filter PCT.  

d. Optional - Manually classify building roofs to class 6, and bridge 

decks to class 17 to create a better looking orthomosaic. 

e. Optional ɀ To create the cleanest edge lines along buildings and 

bridges, polygonate the building and bridge deck classes, then 

set those to the ground and upper surface elevations by 

following these steps to create two polygon sets, one set being 

the buffered footprints and one set the headprints: 

i. Use the Point Group Tracing and Squaring PCT with 

appropriate parameters for your dataset to polygonate 

the desired non-ground features, normally roofs and 

bridge decks, but could be other features desired for a 

Ȱ4ÒÕÅ /ÒÔÈÏȱ. To run this PCT with high density 

TrueView data you will first need to thin the dataset to 

roughly 8 points/m2 using the Classify by Statistics PCT. 

ii. Use the Conflate PCT to pure drape a copy of each non-

ground feature to the ground class to create the 

footprints. This holds the edge clean to the existing 

ground surface. 

iii. Use the Conflate PCT to conflate to the closest 

elevation of the building or bridge deck points found 

therein, a copy of each footprint polygon to create the 

headprints.  

iv. We need to buffer the footprint polygons slightly, say 

2.5cm, using the Buffer Geometry tool found on the 

Feature Edit tab, since in a TIN you cannot have two 

points at the same planimetric location with differing 

elevations. 

https://support.geocue.com/lp360-noise-removal-options


LP360 Drone Users Guide 
 

111 LP360 Drone v2024.1.30.0   4/30/2024 

v. Use the Classify by Feature PCT to mark any ground 

points found within the buffered footprint polygons so 

as not to use them in your resulting DEM. 

vi. If you perform these steps to generate a set of buffered 

footprint polygons (buffered and ground conflated 

polygons) and headprint (closest elevation conflated) 

polygons for your desired non-ground features, then 

skip the Classify by Statistics PCT in the next step since 

you will not have conflicting surfaces over the same 

cell. Furthermore, use Breakline Enforcement, using 

the polygons generated by the preceding steps to help 

hold the edge of your features, when in the export DEM 

step. 

f. Export a DEM using the Export Wizard to quickly create a DEM 

from the LiDAR data and generate the orthomosaic much 

faster than Metashape generating a DEM from the images. 

i. Run Classify by Statistics PCT ɀ For best results, it is 

recommended to perform some initial classification as 

described above before exporting a DEM. Run the 

Classify by Statistics PCT with the following 

recommended settings to help in areas where there are 

two surfaces in the same location, such as when the 

roof overhangs and the LiDAR sees the ground 

beneath: 

1. Feature Geometry ɀ Tool Geometry 

2. Units ɀ Set to project units. 

3. Input LAS Layer ɀ Active LAS Layer 

4. Source Points - Classes 2, 6, and 17. Flags 

ignored. 

5. Cell Size ɀ 0.05m - 'ÅÎÔÌÙ ÒÏÌÌÉÎÇ ÔÅÒÒÁÉÎ ÄÏÅÓÎȭÔ 

need as high a resolution DEM as an area with 

sharper features. 

6. Samples ɀ Max 

7. Destination Class ɀ Flags Only ɀ Synthetic ɀ Set 

8. Quartile Classification ɀ Leave blank. 

9. Generate Cell Output Shape file ɀ Leave 

unchecked. 

10. Run by project. 

ii. Recommended Export LiDAR Data DEM settings: 

1. Source Points:  

a. If the Classify by Statistics in the 

previous section was performed, use 

Synthetic Flag Set 

https://support.geocue.com/exporting-final-product


LP360 Drone Users Guide 
 

112 LP360 Drone v2024.1.30.0   4/30/2024 

b. If the optional non-ground polygons 

were created and the Classify by 

Statistics PCT skipped, then use classes 

2, 6, and 17 ignoring the synthetic flag. 

c. or use all points for a quick ortho. 

2. Export Type - Surface 

3. Surface Method - Triangulation 

4. Pixel size: 0.05m to 0.25m. Gently rolling 

terrain does not need as high a resolution DEM 

as an area with sharper features. 

5. Surface Attribute to export ɀ Elevation 

6. Export Format ɀ GeoTIFF 

7. Raster Information ɀ Pixel Size: 0.05 to 0.25m. 

'ÅÎÔÌÙ ÒÏÌÌÉÎÇ ÔÅÒÒÁÉÎ ÄÏÅÓÎȭÔ ÎÅÅÄ ÁÓ ÈÉÇÈ Á 

resolution DEM as an area with sharper 

features. 

ii. Generate Point Cloud / Ortho from Images - Typically only use this option for 

2DIS (image only systems). This option will take much longer and will generate 

a Dense Image Matching (DIM) point cloud. 

1. Generate Point Cloud (LAS) - generate and retain the Dense Image 

Matching (DIM) point cloud to add to the project during the post-

process step. 

2. Generate Ortho - generate and retain the orthomosaic to add to the 

project during the post-process step. 

iii. Bundle Block Adjustment (BBA) Only ɀ Useful for troubleshooting, or to 

improve the True Pose® information for use with Image Explorer when not 

generating an orthomosaic. 

e) Output Point Cloud ɀ Only use this option for 2DIS (image only systems). 

i. Create New LAS Layer - LAS Layer Name ɀ Type in a unique name for the 

destination layer on which to generate the DIM LAS files from the Ortho 

Mapping run. 

ii. Append to Existing LAS Layer ɀ Select from the Available LAS Layer the 

previously created layer name on which to append the additional DIM LAS files. 

f) Output Ortho  

i. Create New Ortho Layer ɀ Ortho Layer Name ɀ Type in a unique name for the 

destination layer on which to generate the orthomosaic raster resulting from 

this Ortho Mapping run. 

ii. Append to Existing Ortho Layer ɀ Select from the Available Ortho Layers a 

previously created layer name on which to add the orthomosaic raster resulting 

from this Ortho Mapping run. 

g) Advanced Settings ɀ Opens the Agisoft Ortho Mapping Advanced Settings dialog 

(Figure 113) 
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h) Submit Ortho Mapping Job ɀ Submits the Agisoft Ortho Mapping processing to the 

Job Manager queue for processing. 

3. A successfully submitted job notification will appear confirming the job submission (Figure 112). 

 

Figure 112 ɀ Agisoft Ortho Mapping job submission confirmation 

4. An e-mail will be sent when the processing begins to the e-mail configured in the LP360 E-mail 

Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification Settings). 

5. The Agisoft Ortho Mapping job progress may be monitored using Job Manager .  

6. Upon completion of the Agisoft Ortho Mapping job by the Job Manager : 

a) Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   

b) A completion e-mail notification will be sent to the e-mail configured in the LP360 E-

mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification 

Settings) 

c) The job will need to be post-processed to add the resulting Orthomosaic layer and/or 

raster, as well as the optional LAS layer and/or LAS files to the open project. Plus, 

update the EXIFs on each photo to the bundle block adjusted values. 

7. In Job Manager , select the applicable Agisoft Ortho Mapping job, then select View Report 

to review the Agisoft Ortho Mapping processing report. Review for position and orientation 

average corrections to be within tolerances for your ÓÙÓÔÅÍȭÓ 0/3Ȣ  

8. If desired, or for troubleshooting, in Job Manager , select the applicable Agisoft Ortho 

Mapping job, then select View Log to review the Agisoft Ortho Mapping processing log.  

9. In Job Manager , select the applicable Agisoft Ortho Mapping job, then select Open Project 

to open the applicable project for the job, if not currently open. 

10. Then, select Post-Process to add the new Ortho Layer and/or raster file, and for 2DIS the new 

LAS Layer and/or LAS file(s) to the currently open project based on the settings at the time the 

job was submitted. Plus, update the EXIFs on each photo to the bundle block adjusted values. 

a) If the run location selected was Cloud, you will be asked to browse for the 7z file you 

downloaded from the link in the job completion e-mail. 

11. Review the generated Orthomosaic and for 2DIS, LAS data. 

12. When desired, in Job Manager , select the applicable Agisoft Ortho Mapping job, then select 

Delete Job to clean up the temporary files generated while processing the job. 
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13. Optional: Use the Reproject Raster PCT providing it your deliverable project boundary, or 

boundaries if you would like to tile the ortho, as input geometry, leave the reproject unchecked 

so as not to reproject the raster, and it will quickly create you a clipped orthomosaic. This PCT is 

also useful for converting the Ortho Mapping generated orthomosaic from the default BigTIFF 

format to a regular TIFF for using the raster in !ÕÔÏÄÅÓËȭÓ Civil3D, which cannot read BigTIFFs. 

Unless, of course, your orthomosaic is around 4GB or larger, thus requiring to be a BigTIFF, 

unless you use the Reproject Raster PCT to cut the orthomosaic into an index of your own or 

one created using the Grid Generator PCT.  

AGISOFT ORTHO MAPPING ADVANCED SETTINGS 

The most commonly configurable Agisoft Ortho Mapping settings are configured on the Agisoft Ortho 

Mapping Advanced Settings dialog (Figure 113). The defaults are the recommended settings, though 

users may wish to modify for their personal preferences. 

 

Figure 113 - Agisoft Ortho Mapping Advanced Settings dialog 

¶ Alignment Settings 

o Alignment Accuracy ɀ Selects the input photo resolution that will be used in the 

Bundle Block Adjustment (BBA) step. The higher the resolution, the more accurate the 

BBA, but at the expense of increased processing time. Select from: 

Highest  2:1  

High  1:1 High is recommended. 

Medium  1:2 

Low  1:4 

Lowest  1:8 



LP360 Drone Users Guide 
 

115 LP360 Drone v2024.1.30.0   4/30/2024 

o Camera Calibration ɀ This radio button choice allows you to use a prior camera 

calibration or Update Calibration to calibrate the camera as part of the BBA process. 

For pre-calibrated sensors (usually the case with GeoCue workflows, but not the case 

for DJI L1/L2), select Use Sensor Fixed Calibration to use the camera calibrations for 

your system that are stored on Reckon. You should always use this option. Note: You 

ÃÁÎÎÏÔ ÐÅÒÆÏÒÍ Ȱ'#0-&ÒÅÅȱ ÇÅÏÐÏÓÉÔÉÏÎÉÎÇ ÉÆ ÙÏÕ ÄÏ ÎÏÔ ÈÁÖÅ Á ÐÒÅ-calibrated camera. 

¶ Point Cloud Settings 

o Dense Cloud Quality ɀ This sets the resolution of the input photos during the dense 

cloud formation part of the processing. As with BBA, a higher setting provides higher 

quality but at the expense of increased processing time. Each level is approximately 

four times the processing time of the level below it. Select from: 

Á Ultra High 1:1 

Á High  1:2 

Á Medium 1:4 Medium is recommended. 

Á Low  1:8 

Á Lowest  1:16. 

o Dense Cloud Filtering ɀ Adjusts the aggressiveness of the smoothing filter applied 

after the point cloud formation. Select from: 

Á Disabled 

Á Mild  Mild is recommended. 

Á Moderate 

Á Aggressive 

o Tile Point Cloud using Dense Cloud Tile Size ɀ This setting will form the resultant 

point cloud into a set of tiled LAS files. LP360 prefers smaller file sizes, so it is better to 

tile when generating a point cloud, such that each LAS is less than 256MB. 

o Add Point Confidence Extra Bytes to LAS File ɀ The Agisoft confidence, or reliability 

extra byte, can be an additional attribute useful when determining the suitability of a 

DIM point for ground classification. The value represents the number of depth maps 

used for the given point generation. The noisy areas of the dense cloud will have lower 

confidence and you can use the extra byte filter options in the Source Points/Live View 

dialog to exclude the noisy points from point cloud processing or views. 

¶ Ortho Settings 

o Ortho Compression Method ɀ Select from No compression, JPEG, LZW, Packbits, or 

Deflate. JPEG recommended.  

o JPG Quality ɀ If a JPEG compression method is used, specify the desired quality, with 1 

being the lowest and 100, the highest. Recommended to use 90 for a good quality to 

compression ratio. 

o Ortho Background Color ɀ Select a black or white background color for the void pixels 

in the image. 

o Optimal GSD from Images ɀ Allow Metashape to determine the optimal ground 

sample distance for the orthomosaic from the input photos. i.e., Full resolution. 

o Ortho Ground Sample Distance (GSD) ɀ The user may deselect the Optimal GSD from 

Images option and enter a desired GSD in the project units. 
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o Include Alpha Channel ɀ The alpha channel is a special channel on the image that 

handles transparency. Typically included, but users of older CAD programs, such as 

MicroStation v8i, need to uncheck this option if the program cannot handle images 

with an alpha channel included. 
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Agisoft Ortho Mapping also uses a settings file, MSConfig.yml to set some less commonly 

configurable settings for the resulting orthomosaic that are not displayed on this dialog. The 

defaults are the recommended settings for best practice. To modify these, you can do so directly in 

the MSConfig file. Select the appropriate one depending on whether you wish the settings change 

to affect a single execution of Agisoft Ortho Mapping, a single LP360 project, or any project run on 

the machine. 

For a single Agisoft Ortho Mapping job: 

The MSConfig file used for an Agisoft Ortho Mapping job is found in <project 

folder>/Jobs/<yymmdd_hhmmss>_MFE. It is based on the union of the Agisoft Ortho Mapping 

Advanced Settings dialog configured for a job and the MSConfig file found in the project folder. 

For a single project: 

The MSConfig file found in the project folder is created from the MSConfig found in 

%PROGRAMDATA%/LP360/MSPyOrtho, the first time Agisoft Ortho Mapping is run on a project.  

For all projects on a machine: 

The MSConfig found in %PROGRAMDATA%/LP360/MSPyOrtho is copied from the 

%COMMONPROGRAMFILES%/LP360/MSPy38 folder the first time Agisoft Ortho Mapping is run 

on a machine. 

Example settings only found in MSConfig.yml: 

BuildOrthomosaic: refine_seamlines ɀ default is False. Recommended: True. Use smart algorithm 

to identify photo seamlines where they will least distort. 

BuildOrthomosaic: ghosting_filter  ɀ Default is False. True enables the Metashape ghosting filter, 

which is useful to improve the texture if the quality of the dataset is not very good (for example, 

there can be moving objects, patches of reflected light, unwanted objects in the foreground, etc.). 

Useful when generating the DEM from the photos, but it increases processing time. 

BuildOrthomosaic: calibrate_colors ɀ useful to even the brightness and white balance of the 

images over the data set. Please note that for large data sets the Calibrate colors procedure can 

turn out to be quite time consuming. 

cal_colors_whte_balance ɀ ignored if calibrate_colors is False. Additional option to be 

switched on if white balance should be evened as well. 

cal_colors_use_tie_points ɀ if false, uses DEM if available, else Model. If false, uses DEM if 

available, else uses the Model. Defines what data should be taken as the basis for 

overlapping areas estimation. It is preferable to select the source data type according to the 

surface on which you plan to project the orthomosaic.  
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EXECUTING AGISOFT ORTHO MAPPING ON ANOTHER MACHINE 

The recommended workflow should you wish to process your Cycles to a colorized point cloud on one 

machine, but generate your orthomosaic on a different machine, is to process all Cycles for your project 

on machine A. Then,  

1. Export an Explorer Package from machine A containing all the desired RetainedPhotos layers 

and a single DEM layer (for 3DIS®) to be used for generating the orthomosaic.  

2. Copy the Explorer Package to machine B. 

3. On machine B, open the Explorer Package to create a new project. 

4. Run Agisoft Ortho Mapping on machine B to generate your orthomosaic, and the optional 

point cloud (for 2DIS). 

5. Post Process the Agisoft Ortho Mapping run to add the orthomosaic, and optional point cloud 

(for 2DIS) to the project on machine B. 

6. On machine A, import the following from their folder locations on machine B into your existing 

project: 

1. Orthomosaic ɀ UNC path as specified in the Agisoft Ortho Mapping completion e-mail. 

2. The updated True Pose® photos from the RetainedPhotos layer(s) ɀ Right-click on the 

layer in the project on machine B, select Open Location in Explorer to determine the 

path to photos. They are in subfolders of the parent folder to the feature file. Recall 

only the retained photos were copied to machine B so you can import all photos found 

here. 

3. optional point cloud (for 2DIS) ɀ UNC path as specified in the Agisoft Ortho Mapping 

completion e-mail. 

7. Use the new True Pose® photos layer as the drive for Image Explorer by deselecting any other 

layers IE column in project manager and only enabling the new layer. 

CONFIGURING LP360 DRONE TO RUN METASHAPE PRO 

The recommended method of running Agisoft Ortho Mapping is to use the integrated version installed 

with LP360 Drone, however, LP360 Drone may also drive the GUI version of Metashape Pro if you have 

such licenses. To configure a user installed version of Metashape Pro (v1.7.1 to v2.0.x) to be run by the 

Agisoft Ortho Mapping:  

1. )ÎÓÔÁÌÌ ÔÈÅ ÎÅÃÅÓÓÁÒÙ ÃÏÍÐÏÎÅÎÔÓ ÂÙ ÒÕÎÎÉÎÇ ÔÈÅ Ȱ)ÎÓÔÁÌÌ0Ù9!-,ȢÂÁÔȱ ÂÁÔÃÈ ÆÉÌÅ ÆÏÕÎÄ ÉÎ 

Ȱ%CommonProgramFiles%\LP360\MSPyΩήȱ ɉ-ÅÔÁÓÈÁÐÅ ÖΧȢέȢØ to v2.0.x).  

a) Open an elevated command prompt by right-clicking on the Command Prompt in the 

3ÔÁÒÔ ÍÅÎÕ ÁÎÄ ÓÅÌÅÃÔÉÎÇ Ȱ2ÕÎ ÁÓ !ÄÍÉÎÉÓÔÒÁÔÏÒȱȢ 

b) Change directory to the appropriate MSPy ÆÏÌÄÅÒȟ ÕÓÉÎÇ ȰÃÄ %CommonProgramFiles%\ 

\LP360\MSPyΩήȱ ɉ-ÅÔÁÓÈÁÐÅ v1.7.x to v2.0.x). 

c) %ØÅÃÕÔÅ ÔÈÅ ÂÁÔÃÈ ÆÉÌÅ ÂÙ ÔÙÐÉÎÇ Ȱ)ÎÓÔÁÌÌ0Ù9!-,ȢÂÁÔȱȟ Ѕ%ÎÔÅÒІ 

d) You may see a notification about a newer pip version being available but can ignore this 

message (). 
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COMPANION CAMERA(S) EO FILE GENERATION 

1. If utilizing one or more companion cameras, the images must be added to the cycle folder prior 

to starting the import process. For each companion camera and dataset, retrieve the photos 

from the flight and place them into the raw TrueView Cycle folder under 

Cycle_\Flight_\Camera11\, Cycle_\Flight_\Camera12\, and Cycle_\Flight_\Camera13\ for 

companion camera one, two and three, respectively. 

2. Import the TrueView Cycle into LP360 using the normal workflow. 

3. After the Create TV Trajectories step is complete make a copy of the EO file from the LP360 

project path to a new location and open this file in a spreadsheet application for editing 

Project\Area_\Cycle_\Flight_\System\Companion_EO.csv 

Note: the Project\Area_\Cycle_\Flight_\System\Companion_Timing.csv contains information 

about the event in UTC that may be useful for helping to align the correct photo to the correct 

event. 

4. In the Companion_EO.csv note the first column for image name does not match the companion 

camera image names and will need to be updated. These events are tagged with the camera#_, 

i.e. 11_P, 12_N, and 13_S, when there is more than one companion camera. Also, note the 

sequential numbering of the photos does not start at one. Every image preceding the first 

image number will be disregarded as those images are not part of the trajectory solution and 

have no positional data. The first image number minus one will be the number of images from 

the image file list that need to be disregarded. Also, note the total number of rows in the file 

minus one (subtracting the column header) for your total EO file image count. 

5. To correct the image file names, locate the folder of the companion camera images. Open a 

command prompt in that location by right-clicking an empty area and selecting Open in 

Terminal. Type the command below to generate a file list.  

dir /B > companion_images.txt 

Another method is to create a batch file. Save the above command to a text file named 

companion_image_list.bat, this file can be placed in the image folder and executed by double-

clicking. 

6. Open the companion_images.txt file, select the image names by excluding the number of 

photos to be disregarded from step 2, and ending with the last image of the file list. The total 

count of images file names should also match the total number EO file image count determined 

in step 2. Copy this selection. 

7. Go back to the Companion_EO.csv file in Excel and paste the file list selection from the 

companion_images.txt into the %image column to replace with the proper image file names. 

8. The EO file is now ready to load into photogrammetry software much like an exported Photo 

Package would be for the built-in cameras. 
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BORESITE CALIBRATION 

For a TrueView 3DIS and microdrones payloads, boresite calibration may be improved by executing an 

addon license to LP360 Drone, called Strip Alignment . Calibration  can be used to estimate 

constant parameters, the boresite angles, but would not be suited to remove inconsistencies in the 

point cloud generated by dynamic sensor trajectory errors. Please refer to the method and context 

behind Strip Adjustment and the Strip Adjustment tool for correcting dynamic sensor trajectory errors. 

 

Figure 120 - Calibration on the Sensor tab 

#ÁÌÉÂÒÁÔÉÏÎ ÒÅÑÕÉÒÅÓ Á Ȱ3ÔÒÉÐ !ÄÊÕÓÔÍÅÎÔȱ ÁÄÄÏÎ ÌÉÃÅÎÓÅ ÂÅ ÃÈÅÃËÅÄ ÏÕÔ ÉÎ ÁÄÄÉÔÉÏÎ ÔÏ ÔÈÅ ,0ΩάΦ $ÒÏÎÅ 

license.  Note: LP360 Drone+Strip Adjustment may only be used with TrueView 3DIS® or microdrones 

data. 

1. The active Cycle/Flight combination on the Sensor tab is not used by this utility, so it does not 

matter what is selected. 

2. Select Calibration  on the Sensor tab (Figure 120) to open the Boresite Calibration dialog 

(Figure 121). Note: 4Ï ÅÎÁÂÌÅ ÔÈÉÓ ÔÏÏÌ ÒÅÑÕÉÒÅÓ Á Ȱ3ÔÒÉÐ !ÄÊÕÓÔÍÅÎÔȱ ÁÄÄÏÎ ÌÉÃÅÎÓÅ ÂÅ ÃÈÅÃËÅÄ 

ÏÕÔ ÉÎ ÁÄÄÉÔÉÏÎ ÔÏ ÔÈÅ Ȱ,0ΩάΦ $ÒÏÎÅȱ ÌÉÃÅÎÓÅȢ 

A good way to assess the need for using LP360 Calibration on your dataset is to inspect the data 

using profiles to review the interline fit and generate dz image(s) using the LP360 Export Wizard. 

https://support.geocue.com/strip-adjustment-method/
https://support.geocue.com/strip-adjustment-method/
https://support.geocue.com/display-elevation-difference-tool-dz-deltaz
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Figure 121 ɀ Boresite Calibration dialog 

a) Input Settings 

i. Available Cycles ɀ Lists all Cycles in the currently open project. 

ii. Use ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ5ÓÅȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ Á #ÙÃÌÅ ÔÏ ÄÅÔÅÒÍÉÎÅ 

corrections for that Cycle. The Cycle must have a processed sensor trajectory in 

the typical file structure when following the TrueView workflow. 

b) Filter Options 

i. The Geocode LiDAR options are listed here as the Boresite Calibration process 

will geocode a new point cloud from the raw data. Typically, use the same 

options you would for Geocode LiDAR. Note: The Boresite Calibration does not 

generate a point cloud as a result. 

c) Submit Calibration Job ɀ Submits the calibration processing to the Job Manager queue 

for processing.  

3. A successfully submitted job notification will appear confirming the job submission (Figure 

104). 

 

Figure 122 ɀ Boresite Calibration Job Submission Confirmation 

4. An empty e-mail will be sent when the processing begins to the e-mail configured in the LP360 

E-mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification 

Settings). 

5. The calibration job progress may be monitored using Job Manager .  
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6. Upon completion of the calibration job by the Job Manager : 

a) Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   

b) An empty completion e-mail notification will be sent to the e-mail configured in the 

LP360 E-mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail 

Notification Settings) 

c) The job will not need to be post-processed. 

7. In Job Manager , select the applicable calibration job, then select View Log to review the 

calibration processing log.  

a) Review the STDERR section for any reported errors. 

8. In Job Manager , select the applicable calibration job, then select File Explorer to open the 

applicable job folder to review the results. 

9. If the user wishes to implement these results and view how they would affect the point cloud, 

press Post-Process .  

a) The new System Configuration file created from this calibration process will then be 

moved from the job folder and will replace the System Configuration file in the 

Project\Area\Cycle\System folder. The original System Configuration file located in the 

Project\Area\Cycle\System folder will be renamed as 

SystemConfigurationBackUpBeforeStripCalibration.json.  

b) If the Geocode LiDAR step is rerun, the updated System Configuration file will be used 

when creating the new LAS files. 

10. If desired, provide GeoCue Support with the updated SystemConfiguration json file to have it 

posted to Reckon for availability when running Create TV Trajectories while processing 

subsequent Cycles from this payload. 

When desired, in Job Manager , select the applicable calibration job, then select Delete Job to clean 

up the temporary files generated while processing the job. 
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DJI ZENMUSE L1/L2 WORKFLOW 

This section provides a step-by-step guide to processing LiDAR and imagery from the DJI Zenmuse L1 

or L2 (M300 RTK), from the point of project creation to an orthomosaic and generated point cloud. 

Included are common steps for geotagging images, exporting a photo package for downstream 

processing, or generating the orthomosaic. 

CONFIGURE AND LICENSE DJI TERRA 

To configure the license for DJI Terra, please follow this quick guide. 

1. Download and install the latest version of DJI Terra 

from https://www.dji.com/downloads/softwares/dji-terra 

2. After installing DJI Terra, open DJI Terra and login to bind it with your devices. Note: Your login 

account should be the one you use to activate DJI Terra. 

1. If you do not yet have a DJI account, register for an account 

at https://account.dji.com/register?actionType=login&appId=dji_official_aws&backUrl=

https%3A%2F%2Fwww.dji.com%2F&psign=0ac960d27851d087ac3b3f6ef611025c&pno

nce=2938792794146867&locale=en_US 

3. In DJI Terra, select the user icon in the upper right corner, then select activated licenses. 

4. It will take you to https://license.dji.com/ where you can activate your license using your 

activation code and logging into your DJI account. 

DJI PPK UTILITY 

The DJI PPK Utility is designed to streamline the arduous process and multiple steps users might 

otherwise need to follow to prepare their raw mission folders for Post-Processing Kinematic (PPK) in 

DJI Terra. Automatic association of base station file(s) with each raw flight folder, conversion of T02 

files, concatenating multiple observations, when necessary, easy assignment of the survey 

nail/reference mark, etc., make for quick data preparation before performing PPK processing in DJI 

Terra. 

Note: Most users process their  L1/L2 data using RTK, where they maintained connection with the 

D-RTK2 base station or VRS to the DJI system for the duration of each flight. This utility is only 

necessary if there was an issue with RTK or a user desire to process with PPK specifically. 

1. Open the DJI PPK Utility located in the Utilities group on the Sensor tab of the LP360 

ribbon (Figure 123) to open the DJI PPK Utility dialog (Figure 124). 

https://www.dji.com/dji-terra
https://www.dji.com/downloads/softwares/dji-terra
https://account.dji.com/register?actionType=login&appId=dji_official_aws&backUrl=https%3A%2F%2Fwww.dji.com%2F&psign=0ac960d27851d087ac3b3f6ef611025c&pnonce=2938792794146867&locale=en_US
https://account.dji.com/register?actionType=login&appId=dji_official_aws&backUrl=https%3A%2F%2Fwww.dji.com%2F&psign=0ac960d27851d087ac3b3f6ef611025c&pnonce=2938792794146867&locale=en_US
https://account.dji.com/register?actionType=login&appId=dji_official_aws&backUrl=https%3A%2F%2Fwww.dji.com%2F&psign=0ac960d27851d087ac3b3f6ef611025c&pnonce=2938792794146867&locale=en_US
https://license.dji.com/
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Figure 123 - DJI PPK Utility Tool on the Sensor ribbon 

2. In the upper portion of the dialog, add your Raw Flight Folders by selecting the green Ȱ+ȱ and 

browsing for the folders as found on the USB after acquisition. 

3. In the lower portion of the dialogue, select your Base Station Observation files by selecting the 

green plus and browsing for the RINEX or T02 files. 

a) Base observation files overlapping in time with each flight in the upper section will be 

listed in their Ȱ"ÁÓÅ /ÂÓÅÒÖÁÔÉÏÎ &ÉÌÅÓȱ ÃÏÌÕÍÎȢ All observations must be from the same 

location. Edit to remove, if necessary. 

4. For each flight listed, select a reference mark. The dropdown menu will show available 

reference marks from your Survey Nail Manager , or to create a new one, or enter a manual 

position. 

5. 4ÈÅÎȟ ÓÅÌÅÃÔ Ȱ5ÐÄÁÔÅ 2Á× &ÌÉÇÈÔ &ÏÌÄÅÒɉÓɊȱ ÔÏ ÁÌÌÏ× ÔÈÅ $*) 00+ 5ÔÉÌÉÔÙ ÔÏ ÍÁËÅ ÔÈÅ ÎÅÃÅÓÓÁÒÙ 

modifications to prepare your raw flight datasets with the base station observation files for PPK 

processing by DJI Terra. 

6. Then, proceed to perform the applicable pre-processing in DJI Terra. 

 

Figure 124 - DJI PPK Utility Dialog 
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PRE-PROCESSING IN DJI TERRA 

For the DJI Zenmuse L1/L2, trajectory processing and initial point cloud generation from the raw data is 

performed in DJI Terra as a pre-processing step before beginning the workflow in LP360 Drone. If 

processing using PPK, then use the DJI PPK Utility  to easily prepare your data for processing in DJI 

Terra. LP360 Drone is used to reproject the data to various coordinate reference systems not supported 

by DJI Terra, clean up the LiDAR data and fully tag the images as True Pose® photos, plus utilize the 

extensive capabilities of LP360 Drone for classification, vectorization, and derivative product 

generation. 

For more information on pre-processing in DJI Terra, please refer to the DJI Terra User Manual. 

IMPORT DJI ZENMUSE L1/L2 FLIGHT 

To import DJI Zenmuse L1/L2 mission data into a new or current project, open the Raw Mission Import 

Wizard  and select DJI L1/L2.  

When importing DJI L1/L2 flights into a project, the coordinate reference system (CRS), both the 

horizontal and vertical components, of the project must match what was used to process the data in DJI 

Terra or be in ITRF2014 (EPSG:9000), ellipsoidal heights. On the Input DJI L1/L2 Flights page of the 

multi-Cycle import wizard, hover over the Terra LAS File to see the tooltip and confirm the CRS. 

 

Figure 125 - CRS Tooltip for DJI Terra LAS file in multi-Cycle Import wizard 

As of LP360 v2023.2.21.0, processing updates the RTK tagged image positions for the L1 /L2 

workflow using the project geoid, if applicable. As of LP360 v2024.1, if you do PPK processing 

in DJI Terra using a new coordinate not entered in the D-RTK2 base at the time of acquisition, 

or using a third party base, or used the DJI PPK Utility to prepare your dataset for PPK 

processing in this manner, then the photo positions will be updated during the L1/L2 PPK 

workflow. This removes the restriction that had previously existed forcing one to always 

process in DJI Terra to an ellipsoidal vertical coordinate system.  

https://www.dji.com/dji-terra
https://dl.djicdn.com/downloads/dji-terra/20210917/DJI_Terra_User_Manual_v3.1_EN.pdf
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A confirmation dialogue will appear after selecting the project CRS if LP360 Drone is not certain that 

the CRS of the data and the CRS of the project match, to give the user the opportunity to go back and 

modify the project CRS or confirm the differences are acceptable, before completing the import. It is 

very important to review the information in this message and confirm it is correct. This dialog is always 

displayed when the data is in ellipsoidal elevations because in this circumstance, DJI Terra does not 

write a vertical CRS in the LAS file header. 

 

Figure 126 - Incompatible CRS Import Confirmation 

After the data has been imported and the files have been examined, the next steps are: 

1. Create TV Trajectories  

2. Geocode LiDAR  to upconvert the DJI Terra generated LAS v1.2 files to the latest 

LAS v1.4 format and perform other useful operations on the pre-processed LAS files, 

such as splitting the data by flight line. 

3. Optionally, run Strip Align for LP360  

4. Optionally, run Ortho Mapping  or Agisoft Ortho Mapping , using the Update 

Calibration option. 

5. Utilize the extensive capabilities of LP360 for debias, QAQC, classification, 

vectorization, and derivative product generation. 
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CREATING FLIGHT LINES AND TRUEVIEW TRAJECTORIES 

The steps to this point have allowed us to create a single file with the corrected sensor trajectory for the 

entire Cycle. Sections of each flight in the Cycle are not useful to us, such as the IMU heading alignment 

maneuver and flight line transitions, so we clip these sections out by defining which portions of the 

flight to keep. Usually only the data collected along the flight lines are retained, so we will use the Auto 

Create Flight Lines tool   (Figure 63) and the Create Flight Lines from Selected Trajectory Points 

 (Figure 64) from the Sensor tab for the next step. Flight lines are created using the time in the 

ÔÒÁÊÅÃÔÏÒÙ ÐÏÉÎÔÓ ÌÁÙÅÒȟ ÔÈÅÎ Á ÎÅ× ÌÁÙÅÒ ÉÓ ÃÒÅÁÔÅÄ ÎÁÍÅÄ ȰArea_99--$$;((--33;&ÌÉÇÈÔ ÌÉÎÅÓȱȢ 

The steps below describe how to create flight lines automatically and manually. The best approach is to 

create flight lines automatically, then add or delete flight lines manually to get the exact flight lines we 

want. 

 

 

Figure 127 ɀ Auto Create Flight Lines 

 

Figure 128 - Create Flight Lines from Selected Trajectory Points 

 

AUTO CREATE FLIGHT LINES 

6. If not already done, make active the Cycle/Flight combination to be processed. 

For legacy microdrones payloads, the flight lines are automatically generated during import 

based on the mdCockPit flight plan. These flight lines are not editable. 

For mobile datasets, the Auto Create Flight Lines tool will likely be inadequate for creating 

usable flight lines. It is currently advised to create these manually to clip to the desired data. 
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7. Select the Auto-Create Flight Lines tool on the Sensor tab (Figure 63) to open the Auto Create 

Flight Lines dialog (Figure 65). 

a) Flight Line Layer - The name of the layer that will be created and requires no input 

from the user. 

b) Min. Length ɀ No linear set of points shorter than this value will be considered for the 

calculation of a flight line. This number should usually be set to the shortest flight line 

length. Use the Measure tool  on the main LP360 toolbar to measure the shortest 

desired flight line. 

c) Turn Radius ɀ The radius, in map units, to allow at turns. The smaller the number, the 

closer the flight lines will be cut to the turns. The greater the radius, the larger the gap. 

d) Max Deviation ɀ The deviation parameter that tells the software when to break a line 

segment into two. The smaller this number, the more linear the flight lines but the 

ÍÏÒÅ ÆÌÉÇÈÔ ÌÉÎÅÓ ÔÈÁÔ ×ÉÌÌ ÂÅ ÃÒÅÁÔÅÄȢ 4ÈÅ ÌÁÒÇÅÒ ÔÈÉÓ ÖÁÌÕÅȟ ÔÈÅ ÍÏÒÅ ȰÂÅÎÄȱ ×ÉÌÌ ÂÅ 

allowed in a relatively straight segment without splitting. Hence, increase this value 

significantly if you have curved flight lines. 

 

Figure 129 ɀ Auto Create Flight Lines 

8. Once you have entered the desired parameters, select Compute Flight Lines. 

9. The flight line layer should be created, and the flight lines displayed in blue in the map view. 

a) Results can be changed by changing the parameters and selecting Compute Flight Lines 

again. The existing lines will be replaced with the results from the new settings. 

10. Flight lines can be deleted if necessary, by selecting the layer with the Select/ Edit Features button 

on the left end of the Feature Edit tab (Figure 66Ɋ ÁÎÄ ÃÌÉÃËÉÎÇ ÔÈÅ ÒÅÄ Ȱ8ȱ ÏÎ ÔÈÅ ÒÉÇÈÔ ÅÎÄ ÏÆ ÔÈÅ 

Feature Edit tab (Figure 66).  

a) Select the Select/ Edit Features tool   on the LP360 Feature Edit tab (Figure 66). 

b) Select the flight line you wish to delete, and the line will be highlighted (Figure 67). 

i. If multiple feature layers are selected, you will be prompted to choose a layer. 

Choose the flight line layer. 

ii. Hold control while selecting to select multiple flight lines. Or drag to select 

multiple flight lines. 

c) Select the Delete Selected Features  button on the LP360 Feature Edit tab (Figure 

66) and the selected feature(s) will be deleted. 

d) Delete all unnecessary flight lines. Undo  and Redo  may be used if you 

accidentally remove the wrong flight line. 
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e) Select the Save Feature Edits  icon on the LP360 Feature Edit tab (Figure 66) to 

save the edits.  

 

 

 

Figure 131 ɀ Editing Flight Lines 

MANUALLY CREATE FLIGHT LINES 

2. Flight lines can be added manually by selecting trajectory points (red points) at the beginning 

and end of each line. 

a) Select the Select/ Edit Features tool   on the LP360 Feature Edit tab (Figure 66). 

b) Select a trajectory point at the beginning of the desired flight line. The point will be 

highlighted when selected.  

c) Hold control, then select a trajectory point at the end of the flight line. Both trajectory 

points should now be highlighted (Figure 68).  

Figure 130 - LP360 Feature Edit Tab 
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Figure 132 ɀ Manually Creating Flight Lines 

d) Select Create Flight Lines from Selected Trajectory Points  on the Sensor tab 

(Figure 64) and a new flight line should be created.  

e) Select the Save Feature Edits  icon on the LP360 Feature Edit tab (Figure 66)  to 

save the edits.  

Note: If you select Trajectory Point patterns that do not form the required base for creating a 

flight line, you will receive an error message that explains the issue (Figure 69).   

 

Figure 133 - A pattern of Trajectory Points not compatible with forming a flight line 
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CREATE TRUEVIEW TRAJECTORIES  

5. If not already done, make active the Cycle/Flight combination to be processed. 

6. Once flight lines have been created, and the edits saved, select Create TV Trajectories   

from the Sensor tab (Figure 70). The purpose of this step is to use the flight line layer to create a 

reduced trajectory file from the PostProcessedTraj.txt file for each flight line. Optionally and 

recommended, you may also update the image EXIF tags at the same time. 

 

Figure 134 - Create TrueView Trajectories 

 

 

Figure 135 - Create TrueView Trajectories dialog 

7. These fields of this dialog are usually auto populated if the post process trajectory solution was 

successful. 

a) Flight Line Layer - Select the flight line layer from which to generate TrueView 

trajectories if multiple Cycles are being processed.  

b) Post Processed Trajectory File ɀ The trajectory file generated by POSPac. A post 

processed trajectory file may also be imported here if have one from a previous 

processing session with the same data. 

c) Calibration file ɀ The TrueView sensor calibration is critical to get accurate LiDAR and 

imagery data for all supported system types. Select the option for the calibration file 

you wish to use: 
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i. Use Latest Available Calibration File on TrueView Reckon (Recommended) ɀ 

The latest calibration file for each sensor is stored on TrueView Reckon. When 

this option is selected, LP360 Drone will use the latest calibration file found on 

TrueView Reckon to process the data. This is the recommended option as some 

smarts exist on Reckon and in LP360 Drone to help ensure the correct 

calibration file for the system and Cycle. If your system does not have a 

calibration file on Reckon, please contact support@geocue.com for 

assistance. 

ii. Diagnostic Only: Users should never normally use either of these options, 

except for: DJI Zenmuse L1/L2 processing, where it should not be modified 

from the default; Imagery only guest sensors, such as the P4RTK or P1, where 

the user does not have a camera calibration on Reckon and is therefore 

following a more arduous workflow involving measuring control rather than a 

more automated Ortho Mapping processing with only check points for 

validation (Image Explorer will also not be usable without a camera calibration). 

/ÔÈÅÒ×ÉÓÅȟ ÉÆ ÔÈÅ Ȱ,ÁÔÅÓÔ #ÁÌÉÂÒÁÔÉÏÎȱ ÏÐÔÉÏÎ ÁÂÏÖÅ ÉÓ ÇÒÅÙÅÄ ÏÕÔȟ ÐÌÅÁÓÅ 

contact support@geocue.com for further assistance. for further assistance. 

1. Use Cycle-resident Calibration File ɀ If this option is selected, the 

calibration file in the system folder of Cycle being processed will be 

used to process the data. This may not be the latest calibration file if 

updates to your calibration have been made and those updates were 

not copied to the USB prior to acquisition. 

2. Manually Select Calibration File ɀ This choice will invoke a dialog that 

allows you to select a file from all available calibration files for this 

sensor from Reckon. If you select this choice, the Calibration File Picker 

dialog (Figure 72) will be displayed when you press the Create 

Trajectories button at the bottom of the Create TrueView Trajectories 

dialog. You can pick the calibration file you desire using the dropdown 

picker.   

 

Figure 136 - Calibration File Picker 

d) Retained Photos Layer Settings ɀ Allows the user to specify the photos to be kept for 

geotagging and export to photogrammetric software packages using Export Photo 

Package  or for processing in Agisoft Ortho Mapping , or for processing in Ortho 

mailto:support@geocue.com
mailto:support@airgon.com
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Mapping . TÈÅ ÎÏÔÉÏÎ ÏÆ Ȱ2ÅÔÁÉÎÅÄ 0ÈÏÔÏsȱ ÃÒÅÁÔÅÓ Á ÌÁÙÅÒ ÏÆ the retained photos on 

Á ÎÅ× ÌÁÙÅÒ ÃÁÌÌÅÄ Ȱ2ÅÔÁÉÎÅÄ0ÈÏÔÏÓȢȱ 

i. Retain Photos within Flight Lines ɀ This option retains only the photos that 

occur between the start and end of each flight line (flight lines were defined in 

the prior Create Flight Lines step). This option eliminates photos in turns. 

(Recommended). Selecting ÔÈÅ ÏÐÔÉÏÎ ÔÏ Ȱ2ÅÔÁÉÎ Photos ×ÉÔÈÉÎ &ÌÉÇÈÔ ,ÉÎÅÓȢȱ 

creates a new layer in the Table of Contents (TOC) called ȰRetained0ÈÏÔÏÓȱ. 

The resultant layer is shown in Figure 73. Note that only photos that are 

between the beginning and end of each flight line are retained. 

 

Figure 137 - Retain Photos only within Flight Lines 

ii. Retain Photos within Flights Lines and Interior Turns ɀ This option retains all 

photos from the start of the first flight line (start as defined by GPS time) and 

the end of the last flight line. Thus, all ferry line photos are retained.  

iii. Retain All Photos ɀ All project photos are retained. In Figure 74, all photos 

retained. 
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Figure 138 - All Project Camera Photos 

e) Target Epoch ɀ Select Cycle Date for coordinate reference systems using the WGS84 

datum, otherwise select Custom Date and enter the applicable epoch for the datum of 

your coordinate reference system. For example, NAD83(2011) has an epoch date of 

2010.0. Typically, the epoch date for your project datum should be selected by default. 

You will be prompted after selecting OK if the project epoch differs from the value 

entered on this dialog. The project epoch is set when the project CRS is selected but 

can be modified in File -> Project Settings -> Project -> Project Epoch. 

f) Processing Settings 

i. Update Photo EXIF Tags with True Pose® Information ɀ Performs the 

operations of the Update EXIF Tags for Photogrammetric Software tool. 

Recommended to have this checked to avoid needing to separately run the 

Update EXIF Tags for Photogrammetric Software tool. 

ii. Starting Flight Line Number (Point Source ID) ɀ When there are multiple 

Cycles or flights in a project it is important to assign unique point source ids, or 

flight line numbers to each line. Selecting a unique starting ID allows the user to 

determine the best values between 1 and 65535 to use for each line. For multi-

Cycle projects it is suggested to use a nomenclature, such as CCCFF, where CCC 

is the Cycles flown for the project, 1-645, and FF is the flight line per Cycle, 1-99, 

to keep the point source IDs unique within the project. 

8. Select Create TV Trajectories to create TrueView trajectories for the selected Flight Line layer. 

Once trajectories for a flight line are created the flight line will change from blue to magenta. 

Close the dialog when finished. 

You can delete additional photos on the RetainedPhotos layer using the Feature Edit delete tool. 

Only photos associated with this layer will be geocoded and exported as an export package, which 

greatly eases the setup of downstream tools.  
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Note also that the RetainedPhotos layer behaves as a normal Photos layer. This means that the 

image view panes appear if you open this layer in Feature Analyst. 

If you cannot remember if you have run the Create TV Trajectories step, there is no harm in running 

it multiple times. The FlightLines layer symbology turns magenta when this step has been run. If 

you want to confirm creation of the flight line trajectories, you can inspect the Flight Line attributes 

using the LP360 Feature Analyst tool. Right-click the Flight Line layer in the TOC and then left-click 

Ȱ&ÅÁÔÕÒÅ !ÎÁÌÙÓÔ ȣȱ ɉÓÅÅ Figure 75). 

  

Figure 139 - Opening Feature Analyst on the Flight Line layer 

/ÂÓÅÒÖÅ ÔÈÅ Ȱ464ÒÁÊ&)ÌÅȱ ÃÏÌÕÍÎ ÉÎ ÔÈÅ &ÅÁÔÕÒÅ ÔÁÂÌÅ ÏÆ &ÅÁÔÕÒÅ !ÎÁÌÙÓÔ (Figure 76). If this column 

is blank, flight line trajectories have not yet been created.   

 

Figure 140 - TrueView Flight Lines prior to assigning Trajectories 

Figure 77 shows the feature table after creation of the TrueView Flight Line trajectories. Note a file 

location is now populated in the TVTrajFile attribute column.   
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Figure 141 - TrueView Flight Lines after assigning Trajectories 

Note: The Flight Line Trajectory files created in LP360 Drone for 3D Imaging Sensors (3DIS®) are in 

the Terrasolid trajectory format. These trajectories can be directly used in products such as 

TerraScan, TerraMatch and TerraPhoto.   
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GEOCODE LIDAR FOR L1/L2 

The Geocode LiDAR step is where the pre-processed DJI Zenmuse L1/L2 LAS files produced by DJI 

Terra are used by LP360 Drone to: 

¶ Upgrade the LAS from the DJI Terra format of LAS v1.2 to the latest LAS v1.4 format. 

¶ Cut the LAS into the previously defined flight lines by file. 

¶ Add flight line numbers (Point Source ID) to the points in the LAS files to allow for display by 

flight line, swath-to-swath analysis, and processing by Strip Align for LP360. 

The steps below explain the functions of the Geocode LiDAR dialog. TrueView trajectories must have 

been generated before the Geocode LiDAR tool will be active. 

1. If not already done, make active the Cycle/Flight combination to be processed. 

2. Select the Geocode LiDAR button  on the Sensor tab (Figure 78) to open the Geocode 

LiDAR dialog (Figure 79). 

 

Figure 142 ɀ Geocode LiDAR 

3. The Geocode LiDAR dialog (Figure 79) is where the user will select the calibration file, and 

LiDAR clipping settings. A 3D point cloud, LAS files, will be generated after completing this 

step. 

a) Flight Line Layer ɀ The layer that will be used to geocode and set by the active 

Cycle/Flight. 

  

Figure 143 ɀ Geocode L1/L2 LiDAR dialog 

b) LiDAR Clipping: 

i. Clip Angle ɀ Enter the processing angle in degrees. This number represents the 

half angle off Nadir of the scanner. If 40 is entered, LiDAR data will be 

geocoded if it falls between +40° and -40° creating a total field of view (FOV) of 
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80°. Due to the narrow FOV of the L1/L2 we recommend keeping all data, so 

default this option as unchecked. 

ii. Clip Range ɀ Enter the minimum and maximum range to be geocoded. No 

points with a range less than and/or greater than these values, respectively, will 

be geocoded. Useful when no Clip Angle is used to pick up features beside the 

system. 

4. Promote LAS to Version 1.4 ɀ Recommended to update the LAS file format to the current 

version of the industry standard. 

5. Geocode LiDAR ɀ LiDAR data will be geocoded when this button is clicked, creating the LAS 

layer for the selected Cycle. 
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UPDATE EXIF TAGS FOR PHOTOGRAMMETRIC SOFTWARE 

Update EXIF Tags   on the Sensor tab (Figure 95) will geotag each photo with the corrected position 

and accuracy value. Photos that were taken outside of the corrected trajectory file, such as photos on 

the ground before takeoff, will be removed. This utility  must be run to use the images in Metashape, 

Pix4D and other photogrammetric packages with similar workflows.  This step may be skipped if 

already run by selecting the Update Photo EXIF Tags with True Pose® Information checkbox on the 

Create TrueView Trajectories dialog. When completed, the Export Photo Package tool will be enabled. 

 

Figure 95 ɀ Update EXIF Tags 

10. If not already done, make active the Cycle/Flight combination to be processed. 

11. Select Update EXIF Tags  on the Sensor tab (Figure 95) to open the Update EXIF tags dialog 

(Figure 96).  

 

Figure 96 - Update EXIF Tags dialog 

12. The photo layer that will be used to update the EXIF tags is selected based on the active 

Cycle/Flight combination on the Sensor tab. 

13. Select Update EXIF Tags to tag the images.  

14. A confirmation dialog (Figure 97) will appear showing the number of images that will be 

removed. This is a result of those images being outside of the corrected trajectory time frame 

and normal for the tagging process. Select yes to continue. 

 

Figure 97 - EXIF Tagging Confirmation 

15. When the process is complete, select OK on the confirmation dialog. 
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16. The images from both cameras are now tagged. Proceed to the Export Photo Package tool to 

export the photos on the Retained layer and associated camera calibration files for downstream 

processing in photogrammetric processing software. 

17. To review the updated EXIF information in LP360 Drone: 

A) Select and right-click on the Photo or Stations layer in the Table of Contents (TOC) and 

select Feature Analyst.  

B) Select a photo or station from the Features list in Feature Analyst. 

C) Right-click on the desired image displayed in the lower section of Feature Analyst and 

select EXIF Information from the menu. 

 

Figure 98 - Image EXIF Viewer 

18. For troubleshooting purposes, the following information is left in this user guide but is 

superfluous when using the Export Photo Package tool. 

a) Tagged images, suitable for Metashape, are in the project folder, in the Port and 

Starboard folders (Figure 99) (Project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ 

YYMMDD_HHMMSS\) 

 

Figure 99 ɀ Example Location of Tagged Images 
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b) Two CSV files with the image positions are created in the System folder in the same 

location (Project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ 

YYMMDD_HHMMSS\System) 

i. 4ÈÅ #36 ÆÉÌÅ ÎÁÍÅÄ Ȱ)ÍÁÇÅ;ÇÅÏ;ÅÏȢÃÓÖȱ (Figure 100) contains the image 

positions in geographic coordinates, height in meters. The orientation angles 

are yaw, pitch and roll in degrees. 

ii. 4ÈÅ #36 ÆÉÌÅ ÎÁÍÅÄ Ȱ)ÍÁÇÅ;ÐÒÏÊ;ÅÏȢÃÓÖȱ (Figure 100) contains the image 

positions in projected coordinates, height in project units. The orientation 

angles are yaw, pitch and roll in degrees. 

iii. 4ÈÅ #36 ÆÉÌÅ ÎÁÍÅÄ ȰÉÍÁÇÅ;ÇÅÏ;ÏÐËȢÃÓÖȱ ÃÏÎÔÁÉÎÓ ÔÈÅ ÉÍÁÇÅ ÐÏÓÉÔÉÏÎ ÆÉÌÅ ÉÎ 

geographic coordinates, height in meters, with the orientation angles 

represented as omega, phi, kappa in degrees. This file is configured to be used 

in Pix4D. 

 

Figure 100 ɀ Example Location of Image Position Files 

c) Camera calibration files are also created for each camera in 

Project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ YYMMDD_HHMMSS\System folder 

(Figure 101). 

i. The xml files named Port.xml and Starboard.xml can be directly imported into 

Metashape. 

ii. The text files named PortP4D.txt and StarboardP4D.txt can be used in Pix4D. 

 

Figure 101 ɀ Example Location of Camera Calibration Files 
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LP360 STRIP ALIGN (FKA STRIPALIGN FOR EVO(SAFE)) 

For a TrueView 3DIS, microdrones, and DJI Zenmuse L1/L2, strip alignment may be improved by 

executing an addon license to LP360 Drone, called Strip Align .  

 

Figure 102 - Strip Align on the Sensor tab 

LP360 Strip Align requires a Ȱ3ÔÒÉÐ !ÌÉÇÎȱ addon license be checked out in addition to the LP360 Drone 

license.  Note: LP360 Drone+Strip Align may only be used with TrueView 3DIS®, microdrones, or DJI 

Zenmuse L1/L2 data. 

12. The active Cycle on the Sensor tab is not used by this utility, so it does not matter what is 

selected. 

13. Select Strip Align  on the Sensor tab (Figure 102) to open the Strip Align dialog (Figure 103). 

Note: To enable this tool requires a Strip Align addon license to be checked out in addition to 

the LP360 Drone license. 

 

Figure 103 ɀ Strip Align dialog 

a) Input Settings 

i. Available LAS Layers ɀ Will list all LAS layers in the currently open project. 

ii. Use ɀ Select the checkbox in the Ȱ5ÓÅȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ Á ,!3 ÌÁÙÅÒ ÔÏ ÄÅÔÅÒÍÉÎÅ 

corrections for that layer. The layer must have trajectories located in the same 

folder as the LAS, or in a Trajectories folder at the same level as the LAS data as 

is the typical file structure when following the TrueView workflow. 

iii. Fixed ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ&ÉØÅÄȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ Á ,!3 ÌÁÙÅÒ ÔÏ ÈÏÌÄ 

that layer fixed and use as reference ÆÏÒ ÔÈÅ Ȱ5ÓÅȱ ÌÁÙÅÒÓȢ Trajectories are 

neither required, nor used for fixed layers. 
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iv. There are no Ȱtuningȱ parameters for Strip Align, it is fully automated. 

b) Output Settings 

i. LAS Layer Name ɀ Type in a unique name for the destination layer on which to 

generate the corrected LAS files ÆÒÏÍ ÔÈÅ Ȱ5ÓÅȱ ÌÁÙÅÒÓȢ This is the typical first or 

only run option. 

ii. Append to Existing LAS Layer ɀ Select from the Available LAS Layer the 

previously created layer name on which to append the additional Cycle(s). 

c) Submit StripAlign Job ɀ Submits the Strip Align processing to the Job Manager queue 

for processing.  

14. A successfully submitted job notification will appear confirming the job submission (Figure 

104).  

 

Figure 104 - Strip Align Job Submission Confirmation 

15. An empty e-mail will be sent when the processing begins to the e-mail configured in the LP360 

E-mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification 

Settings). 

16. The Strip Align job progress may be monitored using Job Manager .  

17. Upon completion of the Strip Align job by the Job Manager : 

a) Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   

b) An empty completion e-mail notification will be sent to the e-mail configured in the 

LP360 E-mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail 

Notification Settings) 

c) The job will need to be post-processed to add the resulting LAS layer and/or LAS files to 

the open project. 

18. In Job Manager , select the applicable Strip Align job, then select View Log to review the 

Strip Align processing log.  

a) Review the STDOUT section ÆÏÒ ȰXYZ-displacements RMSȱ statistics before the 

correction and ȰResidual RMSȱ after the correction. 

b) Review the STDERR section for any reported errors aside from the expected benign 

warnings. 

19. In Job Manager , select the applicable Strip Align job, then select Open Project to open the 

applicable project for the job, if not currently open. 
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20. Then, select Post-Process to add the new LAS Layer and/or LAS file(s) to the currently open 

project based on the settings at the time the job was submitted. 

21. Review the adjusted LAS data vs the original to determine suitability of the correction. Cut 

profiles and generate a dz image for comparison to those done before the adjustment. 

22. When desired, in Job Manager , select the applicable Strip Align job, then select Delete Job 

to clean up the temporary files generated while processing the job. 
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ORTHO MAPPING 

For TrueView, microdrones, and DJI image sensors, the orthomosaic can be generated and the image 

positions and orientations refined using Ortho Mapping , that is included in an addon license to 

LP360 Drone, called Photo. A Ȱ0ÈÏÔÏΩΦΦΦȱ ÏÒ ÌÅÇÁÃÙ Ȱ&ÕÌÌ 0ÈÏÔÏȱ ÁÄÄÏÎ ÌÉÃÅÎÓÅ may also enable this 

tool. 

 

Figure 105 ɀ Ortho Mapping on the Sensor tab 

4. The active Cycle/Flight combination on the Sensor tab is not used by this utility, so it does not 

matter what is selected. 

5. Select Ortho Mapping  on the Sensor tab (Figure 105) to open the Ortho Mapping dialog 

(Figure 106). Note: 4Ï ÅÎÁÂÌÅ ÔÈÉÓ ÔÏÏÌ ÒÅÑÕÉÒÅÓ Á Ȱ0ÈÏÔÏȱ, ÏÒ Ȱ0ÈÏÔÏΩΦΦΦȱ, or legacy Ȱ&ÕÌÌ 

0ÈÏÔÏȱ addon license be checked out in addition to the LP360 Drone license. 

 

Figure 106 ɀ Ortho Mapping dialog with Input Layer Type: Point Cloud (LAS Layers) 

a) Input Layer Type:  

The two modes available for the Ortho Mapping tool are predicated on the selection of the 

Input Layer Type. 

i. Point Cloud (LAS Layers) ɀ Recommended for with TrueView 3DIS and 

microdrones, since the heavy lifting has already been done by the point cloud 

colorization, the user may select to use the colorized point cloud LAS Layer 

from which to quickly generate an orthomosaic in a fraction of the time it would 
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take to use the photos. Select the desired colorized point cloud LAS layer(s) 

from which to generate the orthophoto.  

ii. Images (Photo Layers) ɀ For TrueView, microdrones, and DJI image sensors, 

the orthomosaic can be generated from the photos, and the image positions 

and orientations refined by selecting the images on the Photo layer(s) as the 

input. 

INPUT LAYER TYPE: POINT CLOUD (LAS LAYERS) 

6. With the input layer type selected to be Point Cloud the Ortho Mapping dialog looks like Figure 

106.  

a) Input Settings 

i. Available LAS Layers ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ5ÓÅȱ ÃÏÌÕÍÎ ÂÅÓÉÄÅ ÁÌÌ 

desired colorized LAS layers that you wish to use as source points for the 

orthomosaic generation. This would typically include LAS layers for every Cycle 

in the project that covers the desired area.  

b) Generate Orthophoto From 

i. Color (RGB) - This option will generate an RGB orthophoto using the RGB 

attributes from the selected Source Points. 

ii. Intensity  ɀ This option will generate a greyscale orthophoto using the intensity 

attributes from the selected Source Points. 

iii. Source Points ɀ Selecting will open Live View to allow filtering the points to be 

used from the input LAS Layers based on the available criteria. 

c) Output Orthophoto Cell Size ɀ Specify the ground sample distance (GSD) of the 

orthophoto to be generated in the project map units. 

i. Auto-Compute Cell Size ɀ Not Recommended ɀ will disable the other options 

in this group box and compute the cell size to use during processing. 

ii. Cell Size ɀ Key in your desired cell size. 

1. Estimate Cell Size ɀ when pressed, will sample the input LAS layers to 

populate the Point Density and Recommended Cell Size and populate 

the Cell Size with that same recommended value. It is recommended to 

manually modify the value in the Cell Size to increase it slightly and 

make it a round number. For example, if the Recommended Cell Size is 

0.082 meters, then modify the Cell Size field to be 0.1 meters. 

d) Triangulation Filter ɀ The selected attributes from the input LAS Layers will be 

triangulated and then sampled to produce the orthophoto. Use these settings to filter 

triangles based on their attributes to minimize the inclusion of long triangles that may 

span areas of void data to help clean up your orthophoto. 

i. Max Triangle Area 

ii. Max Triangle Length 

e) Output  Settings ɀ Specify the Output Layer Basename for the orthophoto(s) to be 

generated on.  

f) Area Selection ɀ Define the extents for the orthophoto. 

i. Use Basic Extent 
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1. Extent Method 

a. Extent of Selected LAS Layer(s) 

b. Custom Extent ɀ manually enter the Output Orthophoto 

Extents. 

c. Current Map Extent ɀ uses the current map view extents to 

define the Output Orthophoto Extents. 

d. Layer Extent ɀ Enables the layer selection dropdown to select 

which layers extents to use to define the Output Orthophoto 

Extent. 

e. Draw Window in Map ɀ Select Draw then draw a rectangle in 

the map view to define the Output Orthophoto Extent. 

2. Output Orthophoto Extent ɀ changes with the Extent Method 

selected to describe the rectangular bounding box in map coordinates. 

3. Apply Buffer ɀ enable and enter the buffer value to increase the size of 

the triangulated surface to some buffered distance around the Output 

Orthophoto Extent. 

ii. Cookie Cut by Polygons 

1. Polygon Layers ɀ select the layer from which to use the polygon 

features to generate one orthophoto for each polygon. 

a. Use Selected ɀ enable to only generate a single orthophoto for 

the polygon which has been selected from the selected polygon 

layer. 

2. Name Field ɀ choose which field to use to uniquely name the 

generated orthophoto files for each polygon. 

3. Apply Buffer ɀ enable and enter the buffer value to increase the size of 

the triangulated surface to some buffered distance around each 

polygon. 

g) Create Orthophoto ɀ Executes the Export Wizard to generate the orthophoto(s). s the 

process is relatively quick, a progress bar appears during processing and there is no job 

submitted to the Job Manager. 



LP360 Drone Users Guide 
 

148 LP360 Drone v2024.1.30.0   4/30/2024 

INPUT LAYER TYPE: IMAGES (PHOTO LAYERS) 

14. After selecting the input layer type to be Images the Ortho Mapping dialog will change to look 

like Figure 107. 

 

Figure 107 ɀ Ortho Mapping dialog with Input Layer Type: Images (Photo Layers) 

a. Input Settings 

i. Available True Pose® Photo Layers ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ5ÓÅȱ ÃÏÌÕÍÎ 

beside all desired True Pose® layers that you wish to use as source photos for 

the orthomosaic generation. This would typically include all RetainedPhotos 

layers for every Cycle in the project that covers the desired area. A True Pose® 

image means their full metadata, including camera calibration, is stored in 

ÓÐÅÃÉÁÌ 'ÅÏ#ÕÅ ÔÁÇÓ ×ÉÔÈÉÎ ÅÁÃÈ ÐÈÏÔÏȭÓ %8)& ÔÁÇÓȢ 

b. Output Settings 

i. Generate Point Cloud / Ortho from Images - This option will generate a Dense 

Image Matching (DIM) point cloud. 

1. Generate Point Cloud (LAS) - generate and retain the Dense Image 

Matching (DIM) point cloud to add to the project during the post-

process step. 

2. Generate Ortho - generate and retain the orthomosaic to add to the 

project during the post-process step. 

ii. Bundle Block Adjustment (BBA) Only ɀ Useful for troubleshooting, or to 

improve the True Pose® information for use with Image Explorer when not 

generating an orthomosaic. 

c. Output Point Cloud ɀ Only use this option for 2DIS (image only systems). 

i. Create New LAS Layer - LAS Layer Name ɀ Type in a unique name for the 

destination layer on which to generate the DIM LAS files from the Ortho 

Mapping run. 
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ii. Append to Existing LAS Layer ɀ Select from the Available LAS Layer the 

previously created layer name on which to append the additional DIM LAS files. 

d. Output Ortho  

i. Create New Ortho Layer ɀ Ortho Layer Name ɀ Type in a unique name for the 

destination layer on which to generate the orthomosaic raster resulting from 

this Ortho Mapping run. 

ii. Append to Existing Ortho Layer ɀ Select from the Available Ortho Layers a 

previously created layer name on which to add the orthomosaic raster resulting 

from this Ortho Mapping run. 

e. Advanced Settings ɀ Opens the Ortho Mapping Advanced Settings dialog (Figure 

109Figure 113) 

f. Process ɀ Submits the Ortho Mapping processing to the Job Manager queue for 

processing. 

15. A successfully submitted job notification will appear confirming the job submission (Figure 112). 

 

Figure 108 ɀ Ortho Mapping job submission confirmation 

16. An e-mail will be sent when the processing begins to the e-mail configured in the LP360 E-mail 

Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification Settings). 

17. The Ortho Mapping job progress may be monitored using Job Manager .  

18. Upon completion of the Ortho Mapping job by the Job Manager : 

a. Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   

b. A completion e-mail notification will be sent to the e-mail configured in the LP360 E-

mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification 

Settings) 

c. The job will need to be post-processed to add the resulting Orthomosaic layer and/or 

raster, as well as the optional LAS layer and/or LAS files to the open project. 

19. If desired, or for troubleshooting, in Job Manager , select the applicable Ortho Mapping job, 

then select View Log to review the Ortho Mapping processing log.  

20. In Job Manager , select the applicable Ortho Mapping job, then select Open Project to open 

the applicable project for the job, if not currently open. 

21. Then, select Post-Process to add the new Ortho Layer and/or raster file, and for 2DIS the new 

LAS Layer and/or LAS file(s) to the currently open project based on the settings at the time the 

job was submitted. 
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22. Review the generated Orthomosaic and for 2DIS, LAS data. 

23. When desired, in Job Manager , select the applicable Ortho Mapping job, then select Delete 

Job to clean up the temporary files generated while processing the job. 

24. Optional: Use the Reproject Raster PCT providing it your deliverable project boundary, or 

boundaries if you would like to tile the ortho, as input geometry, leave the reproject unchecked 

so as not to reproject the raster, and it will quickly create you a clipped orthomosaic. This PCT is 

also useful for converting the Ortho Mapping generated orthomosaic from the default BigTIFF 

ÆÏÒÍÁÔ ÔÏ Á ÒÅÇÕÌÁÒ 4)&& ÆÏÒ ÕÓÉÎÇ ÔÈÅ ÒÁÓÔÅÒ ÉÎ !ÕÔÏÄÅÓËȭÓ #ÉÖÉÌΩ$ȟ ×ÈÉÃÈ ÃÁÎÎÏÔ ÒÅÁÄ "ÉÇ4)&&ÓȢ 

Unless, of course, your orthomosaic is around 4GB or larger, thus requiring to be a BigTIFF, 

unless you use the Reproject Raster PCT to cut the orthomosaic into an index of your own or 

one created using the Grid Generator PCT.  

ORTHO MAPPING ADVANCED SETTINGS 

The most commonly configurable Ortho Mapping settings are configured on the Ortho Mapping 

Advanced Settings dialog (Figure 109). The defaults are the recommended settings, though users may 

wish to modify for their personal preferences. 

 

Figure 109 - Ortho Mapping Advanced Settings dialog 
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¶ Alignment Settings 

o Alignment Accuracy ɀ Selects the input photo resolution that will be used in the 

Bundle Block Adjustment (BBA) step. The higher the resolution, the more accurate the 

BBA, but at the expense of increased processing time. Select from: 

Highest  2:1  

High  1:1 High is recommended. 

Medium  1:2 

Low  1:4 

Lowest  1:8 

o Camera Calibration ɀ This radio button choice allows you to use a prior camera 

calibration or Update Calibration to calibrate the camera as part of the BBA process. 

For pre-calibrated sensors (usually the case with GeoCue workflows, but not the case 

for DJI L1/L2), select Use Sensor Fixed Calibration to use the camera calibrations for 

your system that are stored on Reckon. You should always use this option. Note: You 

ÃÁÎÎÏÔ ÐÅÒÆÏÒÍ Ȱ'#0-&ÒÅÅȱ ÇÅÏÐÏÓÉÔÉÏÎÉÎÇ ÉÆ ÙÏÕ ÄÏ ÎÏÔ ÈÁÖÅ Á ÐÒÅ-calibrated camera. 

¶ Point Cloud Settings 

o Dense Cloud Quality ɀ This sets the resolution of the input photos during the dense 

cloud formation part of the processing. As with BBA, a higher setting provides higher 

quality but at the expense of increased processing time. Each level is approximately 

four times the processing time of the level below it. Select from: 

Á Ultra High 1:1 

Á High  1:2 High is recommended for CUDA cores. 

Á Medium 1:4 Medium is recommended when no CUDA cores. 

Á Low  1:8 

Á Lowest  1:16 

Á Precise Value (1-16) 

¶ Ortho Settings 

o Ortho Compression Method ɀ Select from No compression, JPEG, or LZW. JPEG 

recommended.  

o JPG Quality ɀ If a JPEG compression method is used, specify the desired quality, with 1 

being the lowest and 100, the highest. Recommended to use 90 for a good quality to 

compression ratio. 

o Optimal GSD from Images ɀ Allow Ortho Mapping to determine the optimal ground 

sample distance for the orthomosaic from the input photos. i.e., Full resolution. Not 

Recommended! 

o Factor of Input Images GSD ɀ Allows the tool to automatically determine the Optimal 

GSD from Images, then multiply it by the factor to set the desired Precise GSD. For 

optimal results, recommended to generate the orthomosaic a factor of four times 

the optimal GSD from Images. 

o Precise GSD (Ground Units) ɀ The user may deselect the Optimal GSD from Images 

option and enter a desired GSD in the project units. 
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AGISOFT ORTHO MAPPING (FKA METASHAPE FOR EVO(MFE)) 

For TrueView and DJI image sensors, the orthomosaic can be generated and the image positions and 

orientations refined using Agisoft Ortho Mapping , that is included in an addon license to LP360 

Drone, called Photo with Agisoft . Images may also be processed in the Cloud version for Ortho 

Mapping using LP360 points purchased in the LP360 Store. 

The Agisoft Ortho Mapping license is a separate key from the LP360 Drone+Photo with Agisoft 

licenses. See Licensing LP360 Drone+Desktop Photo with Agisoft for more information on 

activating/deactivating your Agisoft Ortho Mapping license. It is not necessary to install Metashape 

Pro to use this tool, however, Agisoft Ortho Mapping may also drive the GUI version of Metashape Pro 

(v1.7.1 through 2.0.x) if you have such licenses or desire to purchase a node-locked or floating license.  

 

Figure 110 ɀ Agisoft Ortho Mapping on the Sensor tab 

 

14. The active Cycle/Flight combination on the Sensor tab is not used by this utility, so it does not 

matter what is selected. 

15. Select Agisoft Ortho Mapping  on the Sensor tab (Figure 110) to open the Agisoft Ortho 

Mapping dialog (Figure 111). Note: To enable this tool requires a ȰFull Photoȱ, Ȱ0ÈÏÔÏ ×ÉÔÈ 

!ÇÉÓÏÆÔȱ, or ȰPhoto3000ȱ addon license be checked out in addition to the LP360 Drone license. 

 

Figure 111 ɀ Agisoft Ortho Mapping dialog 
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a) Input Settings 

i. Available True Pose® Photo Layers ɀ 3ÅÌÅÃÔ ÔÈÅ ÃÈÅÃËÂÏØ ÉÎ ÔÈÅ Ȱ5ÓÅȱ ÃÏÌÕÍÎ 

beside all desired True Pose® layers that you wish to use as source photos for 

the orthomosaic generation. This would typically include all RetainedPhotos 

layers for every Cycle in the project that covers the desired area. A True Pose® 

image means their full metadata, including camera calibration, is stored in 

ÓÐÅÃÉÁÌ 'ÅÏ#ÕÅ ÔÁÇÓ ×ÉÔÈÉÎ ÅÁÃÈ ÐÈÏÔÏȭÓ %8)& ÔÁÇÓȢ 

b) Processing Location ɀ Select to process Local or Cloud by selecting the applicable 

radio button next to the option. 

c) Metered Ortho Mapping ɀ When Cloud is selected, this section will detail the number 

of photos, available LP360 Points, and the total cost for generating the orthomosaic 

using Ortho Mapping Cloud. 

d) Output Settings 

i. Apply a priori EO if BBA Fails (Only available if Orientation Quality >= INS) ɀ 

(Recommended for 3DIS®) Always defaulted on for True Pose® photo layers 

from a TrueView 3DIS®. This option is not available for DJI and other sensors. 

When selected, two Metashape projects are generated as LP360 Drone 

identifies those images for which Metashape failed to align, for instance, those 

in vegetation, and updates the alignments for those in the new project. This 

second project is then used to generate the orthomosaic so that the holes one 

would normally have from a standard Metashape processing are minimized, if 

not eliminated.  

i. Generate Ortho from DEM (Highly recommended for 3DIS®) 

1. Input DEM Layer 

a. Remove any high and low noise from the dataset. Often best 

accomplished using the Clip Range option in Geocode LiDAR, 

Low/Isolated PCT, and/or a Basic Filter PCT that uses elevation 

clipping. See Noise Removal Options for more details. 

b. Run a ground classification (Adaptive TIN Ground PCT) against 

the dataset using appropriate settings for a good, generalized 

ground surface. It is not important to have a perfect surface as 

there is some leeway in the orthomosaic process, however, if 

you have features such as retaining walls then you may need 

breaklines to properly hold those types of features. 

c. Optional - Manually cleanup the gross blunders in the ground 

surface (Class 2) using the manual classification tools found on 

the Classification tab and Profile toolbar, and/or the Ground 

Cleanup Filter PCT.  

d. Optional - Manually classify building roofs to class 6, and bridge 

decks to class 17 to create a better looking orthomosaic. 

e. Optional ɀ To create the cleanest edge lines along buildings and 

bridges, polygonate the building and bridge deck classes, then 

set those to the ground and upper surface elevations by 
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following these steps to create two polygon sets, one set being 

the buffered footprints and one set the headprints: 

i. Use the Point Group Tracing and Squaring PCT with 

appropriate parameters for your dataset to polygonate 

the desired non-ground features, normally roofs and 

bridge decks, but could be other features desired for a 

Ȱ4ÒÕÅ /ÒÔÈÏȱ. To run this PCT with high density 

TrueView data you will first need to thin the dataset to 

roughly 8 points/m2 using the Classify by Statistics PCT. 

ii. Use the Conflate PCT to pure drape a copy of each non-

ground feature to the ground class to create the 

footprints. This holds the edge clean to the existing 

ground surface. 

iii. Use the Conflate PCT to conflate to the closest 

elevation of the building or bridge deck points found 

therein, a copy of each footprint polygon to create the 

headprints.  

iv. We need to buffer the footprint polygons slightly, say 

2.5cm, using the Buffer Geometry tool found on the 

Feature Edit tab, since in a TIN you cannot have two 

points at the same planimetric location with differing 

elevations. 

v. Use the Classify by Feature PCT to mark any ground 

points found within the buffered footprint polygons so 

as not to use them in your resulting DEM. 

vi. If you perform these steps to generate a set of buffered 

footprint polygons (buffered and ground conflated 

polygons) and headprint (closest elevation conflated) 

polygons for your desired non-ground features, then 

skip the Classify by Statistics PCT in the next step since 

you will not have conflicting surfaces over the same 

cell. Furthermore, use Breakline Enforcement, using 

the polygons generated by the preceding steps to help 

hold the edge of your features, when in the export DEM 

step. 

f. Export a DEM using the Export Wizard to quickly create a DEM 

from the LiDAR data and generate the orthomosaic much 

faster than Metashape generating a DEM from the images. 

i. Run Classify by Statistics PCT ɀ For best results, it is 

recommended to perform some initial classification as 

described above before exporting a DEM. Run the 

Classify by Statistics PCT with the following 

recommended settings to help in areas where there are 
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two surfaces in the same location, such as when the 

roof overhangs and the LiDAR sees the ground 

beneath: 

1. Feature Geometry ɀ Tool Geometry 

2. Units ɀ Set to project units. 

3. Input LAS Layer ɀ Active LAS Layer 

4. Source Points - Classes 2, 6, and 17. Flags 

ignored. 

5. Cell Size ɀ 0.05m - 'ÅÎÔÌÙ ÒÏÌÌÉÎÇ ÔÅÒÒÁÉÎ ÄÏÅÓÎȭÔ 

need as high a resolution DEM as an area with 

sharper features. 

6. Samples ɀ Max 

7. Destination Class ɀ Flags Only ɀ Synthetic ɀ Set 

8. Quartile Classification ɀ Leave blank. 

9. Generate Cell Output Shape file ɀ Leave 

unchecked. 

10. Run by project. 

ii. Recommended Export LiDAR Data DEM settings: 

1. Source Points:  

a. If the Classify by Statistics in the 

previous section was performed, use 

Synthetic Flag Set 

b. If the optional non-ground polygons 

were created and the Classify by 

Statistics PCT skipped, then use classes 

2, 6, and 17 ignoring the synthetic flag. 

c. or use all points for a quick ortho. 

2. Export Type - Surface 

3. Surface Method - Triangulation 

4. Pixel size: 0.05m to 0.25m. Gently rolling 

terrain does not need as high a resolution DEM 

as an area with sharper features. 

5. Surface Attribute to export ɀ Elevation 

6. Export Format ɀ GeoTIFF 

7. Raster Information ɀ Pixel Size: 0.05 to 0.25m. 

'ÅÎÔÌÙ ÒÏÌÌÉÎÇ ÔÅÒÒÁÉÎ ÄÏÅÓÎȭÔ ÎÅÅÄ ÁÓ ÈÉÇÈ Á 

resolution DEM as an area with sharper 

features. 

ii. Generate Point Cloud / Ortho from Images - Typically only use this option for 

2DIS (image only systems). This option will take much longer and will generate 

a Dense Image Matching (DIM) point cloud. 
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1. Generate Point Cloud (LAS) - generate and retain the Dense Image 

Matching (DIM) point cloud to add to the project during the post-

process step. 

2. Generate Ortho - generate and retain the orthomosaic to add to the 

project during the post-process step. 

iii. Bundle Block Adjustment (BBA) Only ɀ Useful for troubleshooting, or to 

improve the True Pose® information for use with Image Explorer when not 

generating an orthomosaic. 

e) Output Point Cloud ɀ Only use this option for 2DIS (image only systems). 

i. Create New LAS Layer - LAS Layer Name ɀ Type in a unique name for the 

destination layer on which to generate the DIM LAS files from the Ortho 

Mapping run. 

ii. Append to Existing LAS Layer ɀ Select from the Available LAS Layer the 

previously created layer name on which to append the additional DIM LAS files. 

f) Output Ortho  

i. Create New Ortho Layer ɀ Ortho Layer Name ɀ Type in a unique name for the 

destination layer on which to generate the orthomosaic raster resulting from 

this Ortho Mapping run. 

ii. Append to Existing Ortho Layer ɀ Select from the Available Ortho Layers a 

previously created layer name on which to add the orthomosaic raster resulting 

from this Ortho Mapping run. 

g) Advanced Settings ɀ Opens the Agisoft Ortho Mapping Advanced Settings dialog 

(Figure 113) 

h) Submit Ortho Mapping Job ɀ Submits the Agisoft Ortho Mapping processing to the 

Job Manager queue for processing. 

16. A successfully submitted job notification will appear confirming the job submission (Figure 112). 

 

Figure 112 ɀ Agisoft Ortho Mapping job submission confirmation 

17. An e-mail will be sent when the processing begins to the e-mail configured in the LP360 E-mail 

Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification Settings). 

18. The Agisoft Ortho Mapping job progress may be monitored using Job Manager .  

19. Upon completion of the Agisoft Ortho Mapping job by the Job Manager : 

a) Job Manager will indicate completion by the green checkmark flashing on the Job 

Manager icon   
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b) A completion e-mail notification will be sent to the e-mail configured in the LP360 E-

mail Notification Settings (File -> Project Settings -> Global -> LP360 E-mail Notification 

Settings) 

c) The job will need to be post-processed to add the resulting Orthomosaic layer and/or 

raster, as well as the optional LAS layer and/or LAS files to the open project. Plus, 

update the EXIFs on each photo to the bundle block adjusted values. 

20. In Job Manager , select the applicable Agisoft Ortho Mapping job, then select View Report 

to review the Agisoft Ortho Mapping processing report. Review for position and orientation 

average corrections to be within tolerances for your ÓÙÓÔÅÍȭÓ 0/3Ȣ  

21. If desired, or for troubleshooting, in Job Manager , select the applicable Agisoft Ortho 

Mapping job, then select View Log to review the Agisoft Ortho Mapping processing log.  

22. In Job Manager , select the applicable Agisoft Ortho Mapping job, then select Open Project 

to open the applicable project for the job, if not currently open. 

23. Then, select Post-Process to add the new Ortho Layer and/or raster file, and for 2DIS the new 

LAS Layer and/or LAS file(s) to the currently open project based on the settings at the time the 

job was submitted. Plus, update the EXIFs on each photo to the bundle block adjusted values. 

a) If the run location selected was Cloud, you will be asked to browse for the 7z file you 

downloaded from the link in the job completion e-mail. 

24. Review the generated Orthomosaic and for 2DIS, LAS data. 

25. When desired, in Job Manager , select the applicable Agisoft Ortho Mapping job, then select 

Delete Job to clean up the temporary files generated while processing the job. 

26. Optional: Use the Reproject Raster PCT providing it your deliverable project boundary, or 

boundaries if you would like to tile the ortho, as input geometry, leave the reproject unchecked 

so as not to reproject the raster, and it will quickly create you a clipped orthomosaic. This PCT is 

also useful for converting the Ortho Mapping generated orthomosaic from the default BigTIFF 

format to a regular TIFF for using the raster in !ÕÔÏÄÅÓËȭÓ Civil3D, which cannot read BigTIFFs. 

Unless, of course, your orthomosaic is around 4GB or larger, thus requiring to be a BigTIFF, 

unless you use the Reproject Raster PCT to cut the orthomosaic into an index of your own or 

one created using the Grid Generator PCT.  
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AGISOFT ORTHO MAPPING ADVANCED SETTINGS 

The most commonly configurable Agisoft Ortho Mapping settings are configured on the Agisoft Ortho 

Mapping Advanced Settings dialog (Figure 113). The defaults are the recommended settings, though 

users may wish to modify for their personal preferences. 

 

Figure 113 - Agisoft Ortho Mapping Advanced Settings dialog 

¶ Alignment Settings 

o Alignment Accuracy ɀ Selects the input photo resolution that will be used in the 

Bundle Block Adjustment (BBA) step. The higher the resolution, the more accurate the 

BBA, but at the expense of increased processing time. Select from: 

Highest  2:1  

High  1:1 High is recommended. 

Medium  1:2 

Low  1:4 

Lowest  1:8 

o Camera Calibration ɀ This radio button choice allows you to use a prior camera 

calibration or Update Calibration to calibrate the camera as part of the BBA process. 

For pre-calibrated sensors (usually the case with GeoCue workflows, but not the case 

for DJI L1/L2), select Use Sensor Fixed Calibration to use the camera calibrations for 

your system that are stored on Reckon. You should always use this option. Note: You 

ÃÁÎÎÏÔ ÐÅÒÆÏÒÍ Ȱ'#0-&ÒÅÅȱ ÇÅÏÐÏÓÉÔÉÏÎÉÎÇ ÉÆ ÙÏÕ ÄÏ ÎÏÔ ÈÁÖÅ Á ÐÒÅ-calibrated camera. 

¶ Point Cloud Settings 

o Dense Cloud Quality ɀ This sets the resolution of the input photos during the dense 

cloud formation part of the processing. As with BBA, a higher setting provides higher 
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quality but at the expense of increased processing time. Each level is approximately 

four times the processing time of the level below it. Select from: 

Á Ultra High 1:1 

Á High  1:2 

Á Medium 1:4 Medium is recommended. 

Á Low  1:8 

Á Lowest  1:16. 

o Dense Cloud Filtering ɀ Adjusts the aggressiveness of the smoothing filter applied 

after the point cloud formation. Select from: 

Á Disabled 

Á Mild  Mild is recommended. 

Á Moderate 

Á Aggressive 

o Tile Point Cloud using Dense Cloud Tile Size ɀ This setting will form the resultant 

point cloud into a set of tiled LAS files. LP360 prefers smaller file sizes, so it is better to 

tile when generating a point cloud, such that each LAS is less than 256MB. 

o Add Point Confidence Extra Bytes to LAS File ɀ The Agisoft confidence, or reliability 

extra byte, can be an additional attribute useful when determining the suitability of a 

DIM point for ground classification. The value represents the number of depth maps 

used for the given point generation. The noisy areas of the dense cloud will have lower 

confidence and you can use the extra byte filter options in the Source Points/Live View 

dialog to exclude the noisy points from point cloud processing or views. 

¶ Ortho Settings 

o Ortho Compression Method ɀ Select from No compression, JPEG, LZW, Packbits, or 

Deflate. JPEG recommended.  

o JPG Quality ɀ If a JPEG compression method is used, specify the desired quality, with 1 

being the lowest and 100, the highest. Recommended to use 90 for a good quality to 

compression ratio. 

o Ortho Background Color ɀ Select a black or white background color for the void pixels 

in the image. 

o Optimal GSD from Images ɀ Allow Metashape to determine the optimal ground 

sample distance for the orthomosaic from the input photos. i.e., Full resolution. 

o Ortho Ground Sample Distance (GSD) ɀ The user may deselect the Optimal GSD from 

Images option and enter a desired GSD in the project units. 

o Include Alpha Channel ɀ The alpha channel is a special channel on the image that 

handles transparency. Typically included, but users of older CAD programs, such as 

MicroStation v8i, need to uncheck this option if the program cannot handle images 

with an alpha channel included. 
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EXECUTING AGISOFT ORTHO MAPPING ON ANOTHER MACHINE 

The recommended workflow should you wish to process your Cycles to a colorized point cloud on one 

machine, but generate your orthomosaic on a different machine, is to process all Cycles for your project 

on machine A. Then,  

8. Export an Explorer Package from machine A containing all the desired RetainedPhotos layers 

and a single DEM layer (for 3DIS®) to be used for generating the orthomosaic.  

9. Copy the Explorer Package to machine B. 

10. On machine B, open the Explorer Package to create a new project. 

11. Run Agisoft Ortho Mapping on machine B to generate your orthomosaic, and the optional 

point cloud (for 2DIS). 

12. Post Process the Agisoft Ortho Mapping run to add the orthomosaic, and optional point cloud 

(for 2DIS) to the project on machine B. 

13. On machine A, import the following from their folder locations on machine B into your existing 

project: 

1. Orthomosaic ɀ UNC path as specified in the Agisoft Ortho Mapping completion e-mail. 

2. The updated True Pose® photos from the RetainedPhotos layer(s) ɀ Right-click on the 

layer in the project on machine B, select Open Location in Explorer to determine the 

path to photos. They are in subfolders of the parent folder to the feature file. Recall 

only the retained photos were copied to machine B so you can import all photos found 

here. 

3. optional point cloud (for 2DIS) ɀ UNC path as specified in the Agisoft Ortho Mapping 

completion e-mail. 

14. Use the new True Pose® photos layer as the drive for Image Explorer by deselecting any other 

layers IE column in project manager and only enabling the new layer. 

CONFIGURING LP360 DRONE TO RUN METASHAPE PRO 

The recommended method of running Agisoft Ortho Mapping is to use the integrated version installed 

with LP360 Drone, however, LP360 Drone may also drive the GUI version of Metashape Pro if you have 

such licenses. To configure a user installed version of Metashape Pro (v1.7.1 to v2.0.x) to be run by the 

Agisoft Ortho Mapping:  

2. )ÎÓÔÁÌÌ ÔÈÅ ÎÅÃÅÓÓÁÒÙ ÃÏÍÐÏÎÅÎÔÓ ÂÙ ÒÕÎÎÉÎÇ ÔÈÅ Ȱ)ÎÓÔÁÌÌ0Ù9!-,ȢÂÁÔȱ ÂÁÔÃÈ ÆÉÌÅ ÆÏÕÎÄ ÉÎ 

Ȱ%CommonProgramFiles%\LP360\MSPyΩήȱ ɉ-ÅÔÁÓÈÁÐÅ ÖΧȢέȢØ to v2.0.x).  

a) Open an elevated command prompt by right-clicking on the Command Prompt in the 

3ÔÁÒÔ ÍÅÎÕ ÁÎÄ ÓÅÌÅÃÔÉÎÇ Ȱ2ÕÎ ÁÓ !ÄÍÉÎÉÓÔÒÁÔÏÒȱȢ 

b) Change directory to the appropriate MSPy ÆÏÌÄÅÒȟ ÕÓÉÎÇ ȰÃÄ %CommonProgramFiles%\ 

\LP360\MSPyΩήȱ ɉ-ÅÔÁÓÈÁÐÅ v1.7.x to v2.0.x). 

c) %ØÅÃÕÔÅ ÔÈÅ ÂÁÔÃÈ ÆÉÌÅ ÂÙ ÔÙÐÉÎÇ Ȱ)ÎÓÔÁÌÌ0Ù9!-,ȢÂÁÔȱȟ Ѕ%ÎÔÅÒІ 

d) You may see a notification about a newer pip version being available but can ignore this 

message (). 
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TRUEVIEW 2DIS AND DJI-RTK CAMERA ONLY SENSOR WORKFLOW 

This section provides a step-by-step guide to processing imagery only TrueView 2DIS, DJI Phantom 4 

RTK, M210 RTK, DJI Zenmuse P1 (M300 RTK), and Mavic 3 Enterprise (M3E) RTK from the point of 

project creation to an orthomosaic and generated point cloud, using either the post processing 

kinematic (PPK) engine or the real-time trajectory solution. Included are common steps for geotagging 

images, exporting a photo package for downstream processing, or generating the orthomosaic. 

To import TrueView 2DIS and supported DJI-RTK camera only sensor Cycle data from the USB 

mounted in the system during acquisition into a new or current project, open the Raw Mission Import 

Wizard  and select TrueView/Microdrones as the sensor or the applicable supported DJI camera 

payload.  

POST PROCESS TRAJECTORY WIZARD 

After the data has been imported and the files have been examined, the next step is to correct the 

GNSS data by running the tightly integrated post processing kinematic (PPK) engine. This step is 

named Post Process Trajectory Wizard and will create a single text file with the corrected position 

information for the entire flight, along with QC plots.  

1. On the Sensor tab (Figure 144), make active the Cycle/Flight combination to be processed. 

 

2. Open the Post Processing Trajectory Wizard dialog by selecting the sensor Trajectory 

Processing  button on the Sensor tab (Figure 144). 

 

Figure 144 ɀ Post Processing Trajectory Wizard 

PROCESSING SETTINGS SELECTION 

3. The Post Processing Trajectory Wizard dialog (Figure 145) should now be opened to the first 

page, which is where the user will select the file to be processed, and how it will be processed. 

The first time you open this page for a Cycle it may take a moment as LP360 Drone analyses the 

When following the real-time kinematic (RTK) workflow for a DJI-RTK image sensor, skip this step 

and go directly to Creating Flight Lines and TrueView Trajectories. 

Enabling Single Cycle Mode  (Figure 26) displays layers relevant to the Active 

Cycle making for efficient viewing of the layers for the Active Cycle. 
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raw observation file. The bullets below explain the settings for the Post Processing Trajectory 

Wizard dialog (Figure 145). Note: The title bar on this dialog will change to reflect the model of 

ÓÅÎÓÏÒ ÂÅÉÎÇ ÐÒÏÃÅÓÓÅÄȟ Ȱ0ÈÁÎÔÏÍ Ϊ 24+ 0ÏÓÔ 0ÒÏÃÅÓÓÉÎÇ 7ÉÚÁÒÄȱ ÏÒ ȰTrueView 250 Post 

0ÒÏÃÅÓÓÉÎÇ 7ÉÚÁÒÄȱȟ ÏÒ Ȱ0/30ÁÃ 0ÒÏÃÅÓÓÉÎÇ 7ÉÚÁÒÄȱ ÆÏÒ ÁÌÌ ÍÏÄÅÌÓ ×ÈÅÎ ÐÒÏÃÅÓÓÉÎÇ ÕÓÉÎÇ 

smartBase or PP-RTX using Applanix POSPacCloud.  

 

Figure 145 - Input Settings Page 

a) Cycle Name ɀ The Active Cycle for which to process the trajectory. 

b) Raw Observation File ɀ This shows the path to the obs file contained in the cycle that 

was selected in step A. Each cycle will have a different obs file. 

c) Override APX Mounting Parameters File ɀ Not applicable to the 2DIS workflow. 

d) Processing Mode ɀ Choose the processing method to be used to correct the GNSS 

data.  

i. QC-Only (Realtime) 

ii. Single Base ($) ɀ Uses the RINEX file recorded from a single base station and 

always sets the run location to local. 

iii. Smart Base ($$) ɀ Uses the SmartBase network from Applanix. 

iv. PP-RTX ($$$) ɀ Uses the PP-RTX solution from Applanix. This is the least 

accurate option and should be used only if single base and SmartBase cannot 

be used. 

e) Run Location ɀ Select to process Local or Cloud by selecting the applicable radio 

button next to the option. If the Processing Mode is set to Single Base, then Local is the 

only option that can be used. If the Processing Mode is set to SmartBase or PP-RTX, 

then Cloud is the only option that can be used, and a user must be logged into an online 

account. 

f) GNSS Settings ɀ Only applicable if the Run Location is set to Cloud. Normally set to 

process using all available constellations but can be toggled to process using GPS only if 

one of the other constellations is causing noise in the solution. It is always set to use 

GPS only when processing DJI-RTK sensors using PP-RTX. 

https://support.geocue.com/single-base-vs-smartbase-vs-pp-rtx/
https://support.geocue.com/applanix-smartbase/
https://support.geocue.com/applanix-pp-rtx/
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g) Cycle Summary ɀ Contains information about the sensor and the Cycle start/end time. 

The account balance will be displayed, if enabled, along with the estimated cost to 

process this CÙÃÌÅ ÕÓÉÎÇ ÔÈÅ ÓÅÌÅÃÔÅÄ ÍÅÔÈÏÄȢ Ȱ$ÕÐÌÉÃÁÔÅ 4ÁÓËȱ ×ÉÌÌ ÂÅ ÓÈÏ×Î ÉÆ ÔÈÅ 

process has already been run successfully on this data before using the same method, 

and indicates no additional points will be charged. 

4. Select Next to move to the next page of the dialog. If using single base as the processing mode, 

the next page will be the Base Station Settings page (Figure 146). If using Smart base or PP-

RTX, the next page will be the Processing Confirmation page. 

BASE STATION SETTINGS 

5. The Base Station Input page only appears when processing using the single base option. The 

bullets below correspond to Figure 146. 

 

Figure 146 ɀ Base Station Settings 

Base Station Observation File(s) ɀ This field should be populated automatically if the base station 

RINEX file(s) was imported during the Raw Mission Import wizard step. If not, it can be imported here 

by selecting  to the right of the grid. If the Antenna type was written to the RINEX header, it will 

automatically be recognized and displayed in this box. If not present, the RINEX file should be edited 

to include the information and added anew. 

An online account login is only applicable if the POSPac Run location is set to Cloud 

since LP360 Drone communicates with LP360 Online ÔÏ ÍÁÎÁÇÅ ÙÏÕÒ ÁÃÃÏÕÎÔȭÓ Point 

balance. During the POSPac Processing Wizard step, you must be logged into your 

online account to process using POSPac Cloud. 
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a) Base Antenna Calibration File - During GNSS processing, whether local in LP360 

Drone for 2DIS, in POSPac desktop, or using POSPacCloud, the antenna type must be 

known for the software to apply the proper antenna phase center (APC) to antenna 

reference point (ARP) offsets. LP360 Drone will automatically read the antenna model, 

if present, from the base RINEX file and display it black in the dialog if the antenna is a 

known type for which it has the antennae calibration. If the antenna model is unknown 

or not stipulated in the RINEX file, or no antenna calibration exists for the specified 

model then the antenna model will display in red (Figure 147). Hovering over the 

ÁÎÔÅÎÎÁ ÍÏÄÅÌ ×ÉÌÌ ÐÒÏÖÉÄÅ Á ÔÏÏÌÔÉÐ ×ÉÔÈ ÔÈÅ ÅØÐÌÁÎÁÔÉÏÎȟ Ȱ7ÁÒÎÉÎÇȡ .'3 ÃÁÌÉÂÒÁÔÉÏÎ 

for antenna model (Unknown) not found. Verify the correct antenna model is listed in 

the base observation file. If you have a newer model antenna it may need to be added 

ÔÏ ÏÕÒ ÄÁÔÁÂÁÓÅȟ ÃÏÎÔÁÃÔ ȬÓÕÐÐÏÒÔΆÇÅÏÃÕÅȢÃÏÍȭȢ 0ÒÏÃÅÅÄÉÎÇ ×ÉÔÈ ÐÒÏÃÅÓÓÉÎÇ ÁÓ ÉÓ ×ÉÌÌ 

result in no APC to ARP offsets applied, which is not normally desired, however, is 

ÁÃÃÅÐÔÁÂÌÅ ÉÎ ÓÏÍÅ ÃÉÒÃÕÍÓÔÁÎÃÅÓȢȱ 

Proceeding without a recognized antenna model will prompt for a confirmation when 

processing the trajectory solution. An example of when it may be okay to proceed with 

an unknown antenna model or missing antenna calibration would be if the reference 

mark was processed to the antenna phase center (APC) instead of the antenna 

reference point (ARP). 

 

Figure 147 - NGS Antenna Calibration Not Found 

b) Base Station Location  

i. Location from ɀ The base station location may be preset if the base station was 

set up over a known survey nail / reference mark or can be computed during 

POSPac processing using Trimble CenterPoint RTX. 

1. Trimble CenterPoint RTX ɀ Selecting this option will disable the 

location and frame portions of the dialog as those will be determined 

using the Trimble CenterPoint RTX post-processing service. Trimble 

RTX© is a global GNSS technology that provides centimeter-level 

positioning, worldwide, at any time. The CenterPoint RTX post-

processing service supports dual frequency GNSS receivers. Antennas 

must be on the Supported Antennas list. The post-processing service 

will not process unsupported antennas. See also: Supported Antennas 

https://trimblertx.com/Home.aspx
https://trimblertx.com/SupportedDevices.aspx
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Base Station Observation files must meet the following requirements: 

¶ Data formats accepted include Trimble proprietary data 

formats (e.g., DAT, T01, T02, T04, Quark) and the standard 

RINEX 2 and RINEX 3 data formats. 

¶ For optimal processing results, it is recommended to provide at 

least 60 minutes of observations. 

¶ Data files cannot exceed 24 hours in length. 

¶ Data files must be static only. 

¶ Data files must contain dual frequency pseudorange and carrier 

phase observations (L1 and L2). 

¶ Data must have been collected after 14 May 2011. 

2. Survey Nail / Reference Mark ɀ If properly selected during the Cycle 

Import Wizard this information will already be set. Otherwise, select 

the name of an existing survey nail from the list or select the nail icon 

 to open the Survey Nail Manager, and add a new Survey Nail. Note: 

The dropdown list is sorted by distance from the average position 

found in the base station RINEX file. 

 

Figure 148 - Base Station Location Warning 

 

b) Settings: Antenna Height - Enter the base antenna height from the measured mark to 

the Antenna Reference Point (ARP). Phase center offsets should not be added to the 

antenna height unless the base antenna model was not written to the header and 

recognized in Base Station Observation section (item A). 

c) Location ɀ Once selected from the list or from the Survey Nail Manager, the Base 

Station Location information will appear in the dialog.  

A message appears on the page to indicate the distance from the Survey Nail to the 

approximate location found in the base observation file. If this distance is greater than 10 

meters, the message shows in red, and you should verify the information as displayed in the 

Location is correct. 
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d) Frame ɀ Once selected from the list or from the Survey Nail Manager, the Base Station 

Frame, epoch and ellipsoid will appear in the dialog.  

i. Settings: Use Plate Model Velocity ɀ Not used in 2DIS trajectory processing. 

The frame of your base station coordinate dictates the frame of your resulting 

trajectory solution. Meaning if your base coordinate is NAD83(2011) epoch 

2010.0, or if your base coordinate GDA2020 epoch 2020.0, or if your base 

coordinate is GDA94 epoch 1994.0, then your resulting trajectory solution 

matches that base datum frame as the data will be pulled from IGS(WGS84) to 

your base frame during processing. 

e) Select Next to move to the Ephemeris Settings.  

EPHEMERIS SETTINGS 

6. The Ephemeris Settings page is used to configure the download of ephemeris or alternative 

navigation files, as well as configure the GNSS processing settings. LP360 Drone will attempt to 

download the necessary ephemeris files when transitioning to this page of the wizard, or when 

the GNSS Settings are changed. The bullets below correspond to Figure 149. 

a) Ephemeris Mode: 

i. Post-Processed (Downloaded from Internet) ɀ Downloads the available mixed 

or GPS only ephemeris, and daily broadcast navigation file from the internet. 

ii. Broadcast (Use Alternate Navigation File (i.e., *.24N), downloaded from the 

Base Station (No internet connection required) ɀ Uses the base station 

broadcast navigation file. No internet connection required. 

 

Figure 149 - Ephemeris Settings 

Note: It may take a moment while the ephemeris files are downloaded before the 

Ephemeris Settings page of the Wizard displays. Press ESC to cancel the auto-download 

if you wish to process in broadcast mode or have issues downloading the ephemeris files. 
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b) Ephemeris Files 

i. Select to process using All Constellations (default) or to process using GPS 

only. You may elect to use GPS only if you are having issues processing a 

successful solution as one of the other constellations may be causing issues. 

Toggling this selection will trigger Auto-Download to download the 

corresponding ephemeris files.  

ii. Displays and allows for browsing to the ephemeris (.sp3) and/or the alternative 

navigation file (*.23N, *_GN.rnx for GPS Only, or *.23P, *_MN.rnx for All 

constellations). 

iii. Alternatively, manually download ephemeris files from the listed FTP links: 

1. Ephemeris FTP Server 

2. Ephemeris FTP Server (Mixed) 

3. Broadcast FTP Server (Daily) 

iv. A less accurate alternative, but possibly suitable for your needs, process using 

the Broadcast Mode and provide the *.23N or *_GN.rnx (GPS Only) or *.23P or 

*_MN.rnx (All constellations) file from your base station. 

c) GNSS Processing Settings 

i. Elevation Mask (deg) and SNR Mask (dB) - The elevation mask and/or SNR 

mask can be changed by selecting the drop-down menu. The elevation mask is 

used to filter satellites low on the horizon, which can cause interference and 

reduced accuracy. Usually, it is best to start with the elevation mask set at 15, 

and then raise or lower it, as necessary. Getting all Q1 is the correct result. This 

means that there is fixed (2cm or less) accuracy. If there are Q2 or Q5 sections 

of the trajectory solution, then it may be necessary to check for 

missing/incorrect files or adjust the elevation mask and reprocess. For more 

information regarding GNSS quality levels, see GNSS Quality Levels Explained. 

d) Convert Base Observation File to RINEX 3.0 ɀ This option can be used to convert your 

base station to the preferred RINEX 3.0 format. We do not have a good handle on when 

that is necessary. We have found it to be a viable solution in one instance if you cannot 

The auto-download of the ephemerides is done via a connection to gdc.cddis.eosdis.nasa.gov 

(198.118.242.43) on port 21 using FTP-SSL. Your organization may only have a limited port range open and 

available for use by the auto-download function causing the auto-download to fail. You can use the 

TrueView settings tab in File->Project Settings to limit the port range used by the FTP-SSL secondary data 

channel to auto-download ephemeris using only TCP ports within the specified range instead of the default, 

which is to use any port in the 1023-65535 range. 

 

Figure 150 - Project Settings - TrueView - Auto-Download Ephemeris Port Settings 

 

https://cddis.nasa.gov/archive/gnss/products/
https://cddis.nasa.gov/archive/glonass/products/
https://cddis.nasa.gov/archive/gnss/data/daily/
https://support.geocue.com/aspsuite-gnss-quality-levels-explained/
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get a fixed solution (Q1) and are only achieving a float solution (Q2), yet everything 

looks like it should be achieving a fixed solution. However, we have also seen the 

opposite, where it was necessary to process without doing this conversion of the base 

station to get a fixed solution. We do not have a definitive answer yet as to when one or 

the other should be used. 

PROCESSING CONFIRMATION 

7. The Processing Confirmation page contains information about the sensor and processing 

times. The bullets below correspond to Figure 151. 

a) Review Current Settings ɀ Contains information about the hardware, software, and 

cost estimates. 

b) Results ɀ After trajectory processing is completed successfully, contains information 

about the results of the processing, including the actual cost, if applicable.  

 

Figure 151 ɀ Processing Confirmation 

8. Select Submit when ready to submit the data for processing.  

9. If during the validation for submittal check, the antenna model is unknown or was not stipulated in 

the RINEX file, or no antenna calibration exists for the specified model, the user will be prompted to 

acknowledge the missing antenna calibration before continuing with the task submission to ensure 

she desires to proceed with this information missing. 










































































































































